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Welcome to This Guide

This guide provides detailed instructions on how to deploy and administer

the HP Business Process Monitor data collector.

This chapter includes:

» How This Guide Is Organized on page 11

» Who Should Read This Guide on page 14

» How Do I Find the Information That [ Need? on page 14
» Additional Online Resources on page 15

» Documentation Updates on page 16

How This Guide Is Organized

Chapter 1

Chapter 2

The guide contains the following chapters:

Introducing Business Process Monitor

Introduces Business Process Monitor and the Business Process Monitor
Admin tool.

Deploying Business Process Monitor

Describes how to install Business Process Monitor on a Windows
platform.

11
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Chapter 3

Chapter 4

Chapter 5

Chapter 6

Chapter 7

Chapter 8

Chapter 9

Chapter 10

12

Working with Business Process Monitor

Provides information on Business Process Monitor functioning, and
describes how to access and navigate in Business Process Monitor Admin.

Business Process Monitor Tree Pane

Describes how to work with the Business Process Monitor tree and view
the various Business Process Monitor entities.

Business Process Monitor Host Page

Describes the functionality available from the Business Process Monitor
Host page in Business Process Monitor Admin.

Instance Page

Describes how to administer and monitor the Business Process Monitor
instance from the Instance page.

Application Page

Describes how to monitor the applications for each Business Process
Monitor instance from the Application page.

Business Transaction Flow Page

Describes how to monitor the business transaction flow for each Business
Process Monitor instance from the Business Transaction Flow page.

Business Transaction Page

Describes how to view details of the transactions included in a business
transaction flow from the Business Transaction page.

Top Bar

Describes how to administer Business Process Monitor using the
additional tools and actions available from the Top Bar’s drop-down
menus. Also describes the Help options for Business Process Monitor
Admin.



Chapter 11

Chapter 12

Chapter 13

Chapter 14

Chapter 15

Chapter 16

Welcome to This Guide

Task Reports

Describes the task reports you can generate from Business Process Monitor
Admin.

Run Schedules and Orders

Describes how to work with the schedules and running orders for
Business Process Monitor run units.

Business Process Monitor Configuration Files

Describes configurable file parameters for Business Process Monitor and
Business Process Monitor Admin.

Advanced Configuration Options

Describes configurable options for Business Process Monitor and Business
Process Monitor Admin.

Workspace Directory and Log Files

Describes the logs and files that relate to running Business Process
Monitor.

Planning Business Process Monitor Capacity

Describes factors that influence a Business Process Monitor’s load and
capacity.

13
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Who Should Read This Guide

This guide is intended for the following users of HP Business Service
Management:

» HP Business Service Management administrators
» HP Business Service Management data collector administrators

Readers of this guide should be knowledgeable about enterprise system
administration, scripting, and HP Business Service Management data
collectors.

How Do | Find the Information That | Need?

14

This guide is part of the HP Business Service Management Documentation
Library. This Documentation Library provides a single-point of access for all
Business Service Management documentation.

You can access the Documentation Library by doing the following:

» In Business Service Management, select Help > Documentation Library.

» From a Business Service Management Gateway Server machine, select
Start > Programs > HP Business Service Management > Documentation.
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Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on
the HP Software Support Web site where you can search the Self-solve
knowledge base. Choose Help > Troubleshooting & Knowledge Base. The
URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site
enables you to browse the Self-solve knowledge base. You can also post to
and search user discussion forums, submit support requests, download
patches and updated documentation, and more. Choose Help > HP Software
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user
and sign in. Many also require a support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:

http://h20229.www2.hp.com/passport-registration.html

HP Software Web site accesses the HP Software Web site. This site provides
you with the most up-to-date information on HP Software products. This
includes new software releases, seminars and trade shows, customer support,
and more. Choose Help > HP Software Web site. The URL for this Web site
is www.hp.com/go/software.

15
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Documentation Updates

HP Software is continually updating its product documentation with new
information.

To check for recent updates, or to verify that you are using the most recent
edition of a document, go to the HP Software Product Manuals Web site
(http://h20230.www?2.hp.com/selfsolve/manuals).

16
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Introducing Business Process Monitor

This chapter includes:
» Business Process Monitor on page 18

» Business Process Monitor Admin on page 20

17
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Business Process Monitor

18

Business Process Monitor is one of the HP Business Service Management
data collectors. Business Process Monitor proactively monitors enterprise
applications in real time, identifying performance and availability problems
before users experience them. It enables you to monitor sites from various
locations, emulating the end-user experience, and so assess site performance
from different client perspectives.

You install Business Process Monitor on host machines on your local
network or on the Internet. Once installed, Business Process Monitor runs
independently as a service on the host machine. You generally deploy
Business Process Monitors on multiple host machines, but you can also use
each Business Process Monitor installed on a host machine as the basis for
many logical Business Process Monitor instances. For example, you may
want to use each instance on the host machine to run tests for a different
division of your organization, or use duplicate instances during the staging
period for HP Business Service Management upgrade to communicate with
the different HP Business Service Management versions.

Each instance can be connected to a different HP Business Service
Management platform, or there may be several instances connected to a
single HP Business Service Management platform (using a unique logical
host name for each).

After installing Business Process Monitor on a machine, the machine is
added to the list of data collectors in HP Business Service Management End
User Management Administration. Each additional Business Process
Monitor instance that you define is also added to the list of available data
collectors. Each Business Process Monitor can then be designated as a host
for your applications and business transaction flows, which are defined in
End User Management Administration. For details on creating and
managing applications and business transaction flows, see "Business Process
Monitor Administration User Interface" in Using End User Management.
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Business Process Monitor monitors applications by executing the tasks
specified in the applications and business transaction flows. This includes
running scripts (transaction monitors) and collecting transaction
performance data (application response time and availability), and running
WebTrace and collecting server/network performance data. Performance
data is collected from various points throughout the infrastructure, as well
as from external locations. Business Process Monitor also reports error
information during the execution of the tasks.

Business Process Monitor sends the collected data to HP Business Service
Management, where you can use the applications to view and analyze the
data, in order to monitor the performance of your business applications and
infrastructure.

In general, Business Process Monitors do not require configuration and
administration. Where configuration or troubleshooting is required, you
generally access the Web-based Business Process Monitor Admin tool,
described in "Business Process Monitor Admin" on page 20. In addition,
certain configuration changes can be made directly in the Business Process
Monitor files, as described in Chapter 13, "Business Process Monitor
Configuration Files."

Business Process Monitor can be installed on the Windows operating
system. For details on system requirements, see "System Requirements" on
page 22.

19
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Business Process Monitor Admin

20

You use the Web-based Business Process Monitor Admin for managing and
monitoring all Business Process Monitor instances on the machine, and for
customizing Business Process Monitor settings. Business Process Monitor
Admin is installed on the host machine during Business Process Monitor
installation.

Business Process Monitor Admin manages the run of Business Process
Monitor on the host machine. You can configure new instances, and then
modify settings and view activity for each Business Process Monitor
instance. You can also use Business Process Monitor Admin to view
transaction and page component breakdown for Web based scripts,
transaction and component breakdown for non-Web based (TCP) scripts,
and to view reports for WebTrace requests.

All Business Process Monitor Admin events are reported to a log file.

For details on accessing and working with Business Process Monitor Admin,
see "Working with Business Process Monitor" on page 77.
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Deploying Business Process Monitor

This chapter includes:

» About Business Process Monitor Deployment on page 22

» System Requirements on page 22

» Requirements for Installation on page 25

» Installing Business Process Monitor on a Windows Platform on page 30
» Business Process Monitor Configuration Wizard on page 42

» Running a Silent Installation on page 57

» Uninstalling Business Process Monitor on page 70

» Deployment Troubleshooting on page 72

Note: If you are installing a service pack, before beginning the installation,
review the information in the HP Business Service Management Readme file
for any last minute notes and limitations for the service pack. Failure to
follow procedures listed in the Readme could result in unexpected data loss
or failure of the installation process.

21
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About Business Process Monitor Deployment

You install Business Process Monitor on designated host machines running
on Windows platforms. The machines can be located on your local network
or on the Internet, and must have http or https access to the HP Business
Service Management Gateway Server. Business Process Monitor includes
Business Process Monitor Admin, which is the Business Process Monitor
management component.

The number and locations of host machines you use should reflect factors
such as the number of transactions you plan to run, the geographic
dispersion of typical end-users who access your application, the location of
remote servers, the locations of ISPs that provide connectivity to your Web
site, and so forth. You can always install Business Process Monitor on
additional host machines at a later time.

If you are using secure communication (over SSL) between Business Process
Monitor and the Gateway Server, you must configure Business Process
Monitor to support https communication. For details, see "Communication
Using SSL" on page 271.

Note: Business Process Monitor 9.02 works with Business Service
Management versions 7.x and later.

System Requirements

22

This section describes the hardware and system requirements for running
Business Process Monitor.

This section includes the following topics:

> "Windows Hardware and Operating System" on page 23
» "Other System Requirements" on page 24

» "Business Process Monitor on Virtual Platforms" on page 24
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Windows Hardware and Operating System

o High Volume
Component Minimum Recommended Loaded Systems
Processor 3.00 GHz 3.00 GHz or At least Intel(R)
higher Core(TM)2 DUO

CPU 2.40 GHz

Memory 1 GB 2GB 4GB

Cache Size N/A N/A At least 4 MB L2
cache

Operating System | » Windows Server 2008 64 bit standard/enterprise/R2
editions (Service Pack 2)

» Windows 7 32 bit

» Windows Vista 32/64 bit (Service Pack 2)

» Windows 2003 32 bit Server standard/enterprise editions
(Service Pack 2, Service Pack 2-Release 2)

» Windows XP Professional 32 bit (Service Pack 3)

Note: For notes and limitations on installing and running

Business Process Monitor on specific Windows platforms,
see:

» "Notes and Limitations for Business Process Monitor on
Windows Vista" on page 91.

» "Notes and Limitations for Business Process Monitor on
Windows 7" on page 92.

» "Notes and Limitations for Business Process Monitor on
Windows 2008" on page 92.

Note: For additional details on sizing for high volume loaded systems, see
"Planning Business Process Monitor Capacity" on page 287.

23
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Other System Requirements

Component Minimum

Free Hard Disk Space Minimum 2.0 GB

(If the application files and workspace directory are
stored on different drives, the application files
require a minimum of 500 MB and the workspace
directory requires a minimum of 1 GB. The required
amount of free disk space for the workspace
directory varies according to the scale of the
implementation. In addition, an extra 500 MB in
the temp folder is required for the extraction of the
installation files.)

Web Browser Internet Explorer (IE) 7.0 and later
Support for WebTrace over | All supported platforms

Modem

Java JDK (including the Version 6u20 and later

Java Plug-in)

Note: The online documentation is best viewed from a browser with Java
support. If you do not have Java support on your browser, then you should
download the Sun Java plug-in from the Sun Java Web site:
http://java.com/en/index.jsp.

Business Process Monitor on Virtual Platforms

The key to effective performance benchmarking and service level
management is having a consistent and reliable monitoring foundation.
Consistency provides a basis for long term trending of metrics, comparison
of metrics from one period to another, and the eventual support of
contractual obligations associated with Service Level Management. It is
acceptable to have the metrics vary from the actual performance as long as
they are consistent. If the metrics are not consistent in their variation or
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relation to the actual business service, then they cannot be used for
production monitoring or performance analysis because no appropriate
baseline will compensate for the variations. For this reason support response
time metrics are not supported on VMware environments and it is
recommend against using shared dynamic environments where resource
contention issues can occur.

Note: HP will not address or resolve any support issues arising from Business
Process Monitors running in a VMware environment.

If you are deploying HP Business Process Monitor on a virtual platform, the
sizing guidelines for a regular installation are not applicable. The following
general limitations and recommendations are applicable to an installation
on a virtual machine:

» ESX 3.5 over Windows 2003 SP2 32 bit is the only tested configuration.
> A Gigabit network card should be used.
» VMotion and DRS are not supported.

» The total amount of configured resources for all the virtualized
environments within the same ESX server (for example, memory or CPU)
must not exceed the ESX server’s physical resources.

Requirements for Installation

The following topics discuss the requirements and limitations for
installation:

» "General Installation Information" on page 26
» "Details Required During Installation" on page 28

> "Notes and Limitations" on page 29

25
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General Installation Information

» The Business Process Monitor installation program can be accessed from

one of the following locations:

» The Downloads page in HP Business Service Management Platform
Administration.

» For versions delivered on DVD, in the Data Collectors and
Components directory on the HP Business Service Management DVD.
Run the required setup program directly from the DVD.

For details on the contents of the Data Collectors and Components
directory on the HP Business Service Management DVD, see the
HP Business Service Management Deployment Guide PDF, part of the
HP Business Service Management Documentation Library.

Note: For the Business Process Monitor (or any other data collector) setup
files to be available on the Downloads page, they must first be installed in
HP Business Service Management.

For details on installing the data collector setup files, see the HP Business
Service Management Deployment Guide PDF, part of the HP Business Service
Management Documentation Library.

You can upgrade to Business Process Monitor 9.02 from Business Process
Monitor 6.5 or later. To upgrade to Business Process Monitor 9.02 from a
version of Business Process Monitor earlier than 6.5, first upgrade to
Business Process Monitor 6.5 or later, and then to Business Process
Monitor 9.02.

Upgrading to Business Process Monitor 9.02 requires you to uninstall the
previous version of Business Process Monitor, but provides the option of
retaining the existing configuration settings.
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» If you change the HP Business Service Management machine to which a
Business Process Monitor connects (for example, if you use staging during
a Business Service Management upgrade) you must redirect the Business
Process Monitor to the new machine. For details, see "Component and
Data Upgrade and Limitations" in the HP Business Service Management
Deployment Guide PDF.

» During a new installation (with no saved configuration settings), you
specity if you want the data collection mechanism used by Business
Process Monitor to run as the system (root) user or as a specific user.
Running it as a specific user limits access to resources, settings, and
applications located on the local machine. (This may not be true for
resources located on remote machines, where a specific user may have
different privileges than the local system user.) Note that after
installation, you can configure this setting from within Business Process
Monitor Admin. For details, see "Set User Credentials" on page 112.

» Users with advanced knowledge of HP Business Service Management can
install Business Process Monitor using a silent installation procedure. For
details, see "Running a Silent Installation" on page 57.

» For last-minute technical and troubleshooting information for Business
Process Monitor, refer to the readme file available in:

> the release download area, for Web delivery versions.

» the HP Software Product Manuals site on the HP Software Support Web
site (h20230.www2.hp.com/selfsolve/manuals). To enter the site, you
must log in with your HP Passport ID.

» the root directory on the HP Business Service Management DVD, for
versions delivered on DVD.

27
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Details Required During Installation

You should have the following information ready when installing Business
Process Monitor:

Note: If during installation you select to use configuration settings from an
earlier Business Process Monitor version, then you are generally not required
to supply the following information.

» If you want to run Business Process Monitor data collection as a specific
user, you need the login parameters (user name, password, domain) for
the user.

» Logical names to use for the host name and location (for example,
Atlanta). These logical names are used by the first Business Process
Monitor instance (defined as part of the installation process) to register
with HP Business Service Management. They do not have to match the
actual machine’s host name and location. (Note that Setup provides the
actual machine host name as the default value for the Host name
parameter.)

Note: You can choose to skip the default instance configuration during
installation and can configure an instance in Business Process Monitor
Admin at a later stage.

» The protocol to be used to access HP Business Service Management (http
or https).

» The name or IP address of the machine on which you installed the
HP Business Service Management Gateway server, and the port number to
be used by Business Process Monitor to access HP Business Service
Management.



Chapter 2 » Deploying Business Process Monitor

For a distributed deployment, you need the name of the Gateway Server
machine, or the load balancer machine behind which servers are
installed.

Notes and Limitations

» Business Process Monitor cannot run on the same machine as HP Business
Service Management due to a port conflict.

» If Business Process Monitor is installed on the same machine as any other
HP Business Service Management component, it is highly recommended
that you define a host name for Business Process Monitor that is not the
actual name of the machine.

» The logical host name for each Business Process Monitor instance must be
unique within an HP Business Service Management platform. When two
Business Process Monitor instances are each connected to a different
HP Business Service Management platform, they can use the same logical
host name.

» Business Process Monitor should not be installed on a network drive.

» [t is recommended that you run Business Process Monitor on Windows
platforms as a specific user. You select this option during setup. Note that
if you set Business Process Monitor to run as a specific user on Windows
platforms, the user must have Administrator privileges on the local
machine. (You can also set Business Process Monitor to run as a specific
user after installation, from Business Process Monitor Admin. For details,
see "Set User Credentials" on page 112.)

» Business Process Monitor can be run on a machine with a different
language locale to the HP Business Service Management system, but all
relevant entity names (applications, business transaction flows, and
transactions) in Business Service Management must be entered in the
same language as the Business Process Monitor operating system.

> You cannot install Business Process Monitor to an installation path that
contains special characters (for example, # () %).
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» When installing Business Process Monitor from a network drive at a
remote location, if the Business Process Monitor user does not have
network permissions to all the network, you may not be able to run the
installation remotely. To install, copy the installation file to the local
machine and install from there (this greatly reduces the download time
and enables you to control when Business Process Monitor is down
during installation).

» Business Process Monitor does not support installation via terminal
service. Installation must be performed at the destination machine.

» Business Process Monitor supports basic (http) and NTLM authentication,
as well as SSL with client side certification and/or server side certification.

When connecting via proxy, Business Process Monitor supports basic and
NTLM proxy authentication.

For required parameter settings when configuring NTLM authentication,
see "Parameters in sconn.cfg" on page 247.

Installing Business Process Monitor on a Windows Platform

This procedure describes how to install/upgrade directly on the Business
Process Monitor machine.

You must have administrative privileges on the machine on which you are
installing Business Process Monitor.

The installation process comprises two main parts—the MSI installation of
the application and the Business Process Monitor configuration wizard.
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Note: Setup gives you the option of selecting the locations of the
installation folder for Business Process Monitor and the workspace directory,
although it is recommended that you accept the default options. You require
a minimum of 500 MB free disk space for the application files and 1 GB of
free disk space for the workspace directory. (The required amount of free
disk space for the workspace directory varies according to the scale of the
implementation.) In addition, you need an additional 500 MB free disk
space in a temporary folder for extracting and temporarily storing the
installation files.

For notes and limitations on running Business Process Monitor 9.02 on
specific Windows platforms, see:

» "Notes and Limitations for Business Process Monitor on Windows Vista"
on page 91

» "Notes and Limitations for Business Process Monitor on Windows 7" on
page 92

» "Notes and Limitations for Business Process Monitor on Windows 2008"
on page 92
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To install Business Process Monitor on a Windows platform:

1 Download the Business Process Monitor setup file for Windows from the

Business Service Management Downloads page (Applications > Platform >
Setup and Maintenance > Downloads) and save it on the machine on
which you are installing Business Process Monitor. Alternatively, copy the
setup file from the Business Service Management DVD containing data
collector installation programs, for versions delivered on DVD. For more
details on the location of the Business Process Monitor setup file, see
"General Installation Information" on page 26.

Run the Business Process Monitor setup program. A screen opens
requesting a location to which to extract and temporarily store the
installation files.

X

Location to Save Files m

Where would you like to save your files? i
&A™

Please enter the folder where you want these files saved. If the folder does not
exist, it will be created for you. To continue, didk Mext.,

Save files in folder:
CDOCUME ~ 1 yevnin\LOCALS ~1TempHP Business Process Monitor

Change... |

T
il

[l

L
-

= Baol | Mext = | Cancel |

Accept the default, temporary directory to which to extract the required
installation files, or click Change to select another directory.

Click Next to continue.
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3 The file extraction process starts and an extraction progress screen opens.

EHP Business Process Monitor - Install Shield Wizard

Extracting Files
The contents of this package are being extracted.

i
Please wait while the InstallShield Wizard extracts the files needed to install HP
Business Process Monitor on your computer, This may take a few moments.,

Reading contents of package. ..

B

Installsteld

= Bk I (et = I Cancel |

When all the files have been extracted, click Next to continue.

4 The setup program checks if the following prerequisite programs for
running scripts correctly are installed on the machine and if not, prompts
you to install them. (If all the prerequisite programs are installed, setup
continues with the next step.)

» .NET Framework 3.5 SP1

» Microsoft Data Access Components (MDAC) 2.8 SP1 (or later)
Microsoft Windows Installer 3.1

Microsoft Core XML Services (MSXML) 6.0

Microsoft Visual C++ 2005 SP1 Redistributable Package (x86)
Microsoft Visual C++ 2008 Redistributable Package (x86)

Y Y Y Y Y

Web Services Enhancements (WSE) 2.0 SP3 for Microsoft .NET
Redistributable Runtime MSI

» Web Services Enhancements (WSE) 3.0 for Microsoft .NET
Redistributable Runtime MSI
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» Strawberry Perl 5.10.1

MET Framework v3.5

Microsoft WSE 2.0 SP3 Runtime

Microsoft WSE 3.0 Runtime

Microsoft Visual C++ Run-time Compaonents
Microsoft Visual C++ 2008 Run-time Components

Click OK to install the missing programs listed. During the installation,
you may be required to restart the computer. In such cases, after restarting
the computer, run the Business Process Monitor setup program again
until all the prerequisite programs are installed and the setup program
continues with the next step.

Note: The installations of the prerequisite programs are self-contained
and are embedded in the Business Process Monitor installation.
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5 If the setup program detects a previous version of Business Process
Monitor on the machine, you are prompted to uninstall the previous
version and the setup program ends. Uninstall the previous version and
then restart the new installation. For details on uninstalling Business
Process Monitor, refer to the Business Process Monitor Administration PDF
relevant for the version of Business Process Monitor you are uninstalling.

6 The HP Business Process Monitor Setup Wizard opens.

=10

I

Welcome to the HP Business Process Monitor
Installer

The ingtaller will guide you through the steps required to install;

Business HPF Buginess Process Monitor on pour computer.
Process

Monitor

Installer

® Setup Type

WwiSRMING: This computer program is pratected by copyright law and international treaties.
o Confirmation Idnauthorized duplication or distribution of thiz program, or ang portion of it, may result in
zevere civil ar criminal penalties, and will Be prozecuted ta the maximum extent pozsible

; der the law.
® |nstollation I

® Finish and launch
the Configuration

wizard < Back I Heut > I Cancel

Click Next to begin the installation.
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7 The license agreement screen opens.

15-1- HP Business Process Monitor = EE
License Agreement

Flzaze take a moment to read the license agreement now. [f you
accept the termz below, click ' Agree”, then "Mext". Othemnwize

click "Cancel'.

EMD USER LICENSE AGREEMENT 3
Business PLEASE READ CAREFULLY: THE USE OF THE SOFTWARE IS SUBJECT
Process TO THE TERMS AND COMDITIOMNS THAT FOLLOW ("AGREEMENT™),
Monitor UNWLESS THE SOFTWARE 1S SUEJECT TO A SEPARATE LICENSE

AGREEMENT BETWEEN YOU AND HF OR ITS SUPPLIERS. BY
DOWNLOADING, INSTALLING, COPYING, ACCESSING, OR USING THE
SOFTWARE, OR BY CHOOSING THE "l ACCEFT” OPTION LOCATED ON
OR ADJACEMNT TO THE SCREEMN WHERE THIS AGREEMENT MAY BE
DISPLAYED, YOU AGREE TO THE TERMS OF THIS AGREEMENT, ANY

Installer

@ Setup Type APPLICABLE WARRANTY STATEMENT AND THE TERMS &ND

g CONDITIONS CONTAINED IN THE "ANCILLARY SOFTWARE™ (a= defined
® Confirmation below). IF YOU ARE ACCEPTING THESE TERMS ON BEHALF OF hd
® |nstallation o

® Finish ond lounch
the Configuration

wizard < Back I Mest > I Cancel |

Read the Business Process Monitor License Agreement.

To install Business Process Monitor, you must accept the terms of the
license agreement by clicking | agree and then click Next to continue.
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8 The Customer Information screen opens.

itor e

Customer Information

Enter your name and company ar arganization in the box below. The installer will uze this
information for subsequent installations.

MHane:

ok Smith

Business Drganization;
Process
Monitor
Installer

|Hew|ett-F’ackard Compary

® Setup Type

® (Confirmotion
® [nstollation

® Finish and lounch
the Configuration

wizard < Back I Heut > I Cancel

Enter your name and organization (or accept the defaults) and click Next
to continue.
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9 The Select Installation Folder screen opens.

i& HP Business Process Monitor [

D |
Business
Process
Monitor
Installer

® Welcome

# (onfirmation

# [nstallation

# Finish ond lounch
the Configuration
wizard

Select Installation Folder

The inztaller will inztall HR Buziness Proceszs Monitor in the following folder.

To install in this falder, click "Mest”. To install in a different folder, enter it below ar click
"Browse''.

You can click the "Disk Cost'' button ta view the available dizk space on each disk drive.

Folder:
C:AProgram FilegtHPYBPRMY Browsze...
Dizk Coat...
< Back Cancel

Accept the default directory location for the installation, or click Browse
to select another directory.

Click Next to continue.

Note:

» If you select a directory other than the default directory, you must
have administrator privileges for the selected directory.

» Click Disk Cost to display the required and available space on the
machine’s disk drives in a popup window.
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10 The Confirm Installation screen opens.

Installer

#® Welcome

® Sefup Type

# (onfirmation

# Installation

# Finish and launch

the Configuration
wizard

Click Next to continue.
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11 The Business Process Monitor installation process starts and an
installation progress screen opens.

& HP Business Process Monitor

I ] S
Installing HP Business Process Monitor

[&lﬂ] HF Buziness Process Monitor iz being installed.

Business
Process Copying new files

Monitor I

Installer

& Welcome

® Setup Type

# (onfirmation

# Finish ond lounch
the Configuration
wizard

< Bacl HErs
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12 When the installation process is complete, a message about the successful
installation opens.

o=

Installation Complete

HF Buziness Process Monitor has been successfully inztalled,

Click "Finigh to exit.

Business
Process
Monitor
Installer

& Welcome

® Setup Type

# (onfirmation

® [nstallation

¢ Baclt I Finizh I [Fariee]

Click Finish to end the installation and continue with the HP Business
Process Monitor Configuration wizard. For details on the user interface,
see "Business Process Monitor Configuration Wizard" on page 42.
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@ Business Process Monitor Configuration Wizard

42

Description

Enables you to configure the settings for a Business
Process Monitor, including the work directory, user
mode, and default instance settings.

To access: The Business Process Monitor Configuration
wizard is automatically launched during a Business
Process Monitor installation, after the setup program has
installed the Business Process Monitor application.

Wizard Map

The Business Process Monitor Configuration wizard
contains:

Current Settings Page > Work Directory Page > Run as
User Page > Instance Definition Page > Preview Page >
Finish Page

Useful Links

"Installing Business Process Monitor on a Windows
Platform" on page 30
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¥ current Settings Page
The following is an example of the Current Settings page.

£ HP Business Process Monitor Configuration Wizard

¥ Current Settings
Work Directory
Run as User

Instance Definition

Current Settings

Configuration Wizard has detected existing configuration settings on this computer.
Do you want to keep all current configuration settings?

@] Yes, | want to keep all current settings

Preview N
. (®) Mo, | want to reconfigure agent settings
Description Enables you to select whether you want to apply existing

configuration settings from a previous Business Process
Monitor installation, or configure new settings.
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Important
Information

» General information about the wizard is available in
"Business Process Monitor Configuration Wizard" on
page 42.

» If no existing configuration settings are detected on
the machine on which you are installing Business
Process Monitor, this page is not displayed and the
wizard continues with the "Work Directory Page" on
page 45.

Wizard Map

The Business Process Monitor Configuration Wizard
contains:

Current Settings Page > Work Directory Page > Run as
User Page > Instance Definition Page > Preview Page >
Finish Page

The following elements are included:

GUI Element

Description

Yes, | want to keep all
current settings

Select this option to apply existing settings to the current
installation.

Note:

» If you select this option, the wizard continues with the
"Preview Page" on page 55.

» If you choose to use configuration settings from a
previous installation of Business Process Monitor, the
configured instances are registered to the same
Business Service Management Gateway Servers as the
previous installation. This means that the same jobs
are retrieved, although previous persistency queues are
not saved.

No, | want to
reconfigure agent
settings

Select this option to configure new settings.
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. work Directory Page

The following is an example of the Work Directory page in a Windows
installation.

£ . HP Business Process Monitor Configuration Wizand

Current Settings wO rk Dire cto ry
» Work Directory

Specify a location for the workspace directory

Run as User S
Instance Definition Directory: | C:\Documents and Settings\A&ll Uzers\Application Data'HPBPM M
Preview
Finish

Description Enables you to select the location of the Business Process

Monitor work directory. Accept the default location, or
click Browse to select a different location.
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Important
Information

» General information about the wizard is available in
"Business Process Monitor Configuration Wizard" on
page 42.

» If you select a different directory, make sure that:

» You have administrative privileges for the folder in
Windows.

» You have at least 1 GB of free disk space for the
folder. (The required amount of free disk space
varies according to the scale of the
implementation.)

Wizard Map

The Business Process Monitor Configuration Wizard
contains:

Current Settings Page > Work Directory Page > Run as
User Page > Instance Definition Page > Preview Page >
Finish Page
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¥ Run as User Page
The following is an example of the Run as User page for a Windows
installation.

HP Business Process Monitor Configuration Wizand

Current Settings Run as User

Work Directory “fou can run HP Business Process Monitor data collection as a roct user, or as a specific user. Running it as a sp
data collection process to access resources, settings, and applications not available to the root user.

¥ Run as User

Instance Definition ® Runas system user

Preview . B
() Run as specific user
Finish
User Mame:
Password:
Domain:
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Description

Enables you to configure Business Process Monitor data
collection to run as a system user, or as a specific user.
Running it as a specific user limits access to resources,
settings, and applications located on the local machine.
(This may not be true for resources located on remote
machines, where a specific user may have different
privileges than the local system user.)

Important
Information

» General information about the wizard is available in
"Business Process Monitor Configuration Wizard" on
page 42.

» You can also set Business Process Monitor to run as a
specific user after installation, from Business Process
Monitor Admin. For details, see "Set User Credentials"
on page 112.

Wizard Map

The Business Process Monitor Configuration Wizard
contains:

Current Settings Page > Work Directory Page > Run as
User Page > Instance Definition Page > Preview Page >
Finish Page
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The following elements are included:

GUI Element

Description

Run as system user

Select this option to set Business Process Monitor data
collection to run as a system user.

Run as specific user

Select this option to set Business Process Monitor data
collection to run as a specific user and configure the
following parameters:

» User name. The specific user name. This is a
mandatory field of up to 24 characters. The name
cannot include spaces, nor any of the following
characters: (;:"<>*+=\17,).

» Password. (For Windows only.) The user’s password.

» Domain. (For Windows only.) The domain for the user.
The domain name can be up to 67 characters long and
can include the following characters: 0-9, a-z, A-Z,
hyphen (-). The domain name cannot start or end
with a hyphen (-), nor can it include spaces.
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. Instance Definition Page

The following is an example of the Instance Definition page.

& HP Business Process Monitor Configuration Wizard

Current Settings
‘Work Directory
Run as User

P Instance Definition
Preview

Finish

Instance Definition

Define a default instance for the Business Frocess Monitor

O

Skip Instance Definition

@ Define Instance

Display name: | My_Default_Instance |
Gateway Server URL: | hittp: ivmamrnd34 deviab adtopaz |
Location name: | Iy _Cube |
Host name: [ HosT |

Job poll interval (minutes): | 2 |

Time poll interval (minutes): | B0 |

Description

Enables you to define a default instance for the Business
Process Monitor.

Important
Information

» General information about the wizard is available in
"Business Process Monitor Configuration Wizard" on
page 42.

» You can also define an instance after installation, from
Business Process Monitor Admin. For details, see
"Create New Instance" on page 106.

Wizard Map

The Business Process Monitor Configuration Wizard
contains:

Current Settings Page > Work Directory Page > Run as
User Page > Instance Definition Page > Preview Page >
Finish Page
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The following elements are included:

GUI Element

Description

Skip Instance
Definition

Select this option to skip the instance definition.

Define Instance

Select this option to define an instance and configure the

following, mandatory parameters:

» Display name. The display name for the instance in

Business Process Monitor Admin. The display name
can be up to 50 characters and can include the
following characters: 0-9, a-z, A-Z, hyphen (-),
underscore (_). The display name cannot start or end
with a hyphen (-) or an underscore (_).

Gateway Server URL. The URL of the HP Business
Service Management Gateway Server to which this
instance sends collected data. The URL must be in the
following format: http (or https)://<Gateway Server
name or IP address>:<port number>/topaz. If you do not
specify a port number, the default port is used (80 for
http and 443 for https).

Location name. The location defined for the instance.
The location name can be up to 50 characters and can
include the following characters: 0-9, a-z, A-Z,” ~ 1 @ #
$%r&*()_-+=[1{}]|/7.,:; (space).

Host name. The host name defined for the instance.
The host name can be up to 50 characters and can
include the following characters: 0-9, a-z, A-Z,” ~ 1 @ #
$%W N&*()_-+=[1{}|/7.,"":; <> (space).

Job poll interval. The defined frequency (in minutes)
with which Business Process Monitor polls the
database for assigned task, application, and business
transaction flow changes. This is an integer positive
number of up to 4 digits.

Time poll interval. The defined frequency (in minutes)
with which Business Process Monitor polls

HP Business Service Management for time
synchronization. This is an integer positive number of
up to 4 digits.
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GUI Element Description

Additional Instance Click Additional Instance Settings to open the Additional
Settings Instance Settings dialog box, where you configure user,
authentication, proxy, and SSL settings for the instance.
For detail on the user interface, see "Additional Instance
Settings Dialog Box" on page 52.

Additional Instance Settings Dialog Box

The following is an example of the Additional Instance Settings dialog box
for a Windows installation.

i . Additional Instance Settings

Run Instance As User

User name: | |

Password: | |

Domain: | |

Authertication

User name: | |

Password: | |

Damair: | |

Proxy Settings

PI'OXY User name:

Proxy domain:

| |
Proxy password: | |
| |
| |

Proxy URL:

SSL Settings

SSL client certificate file:
SEL private key file:
SEL private key password: |

SSL authority certificate file:
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Description Enables you to define additional settings for a default
instance, such as user, authentication, proxy, and SSL
settings.

To access: Click Additional Instance Settings on the
Instance Definition page.

Important The following rules apply when you configure additional
Information instance settings:

» User names can be up to 24 characters long. Names
cannot include spaces, nor any of the following
characters: (;:"<>*+=|\7)).

» All domain names can be up to 67 characters long and
can include the following characters: 0-9, a-z, A-Z,
hyphen (-). Domain names cannot start or end with a
hyphen (-), nor can they contain spaces.

» For more information on supporting SSL
communication, see "Communication Using SSL" on
page 271.

The following elements are included:

GUI Element Description

Run Instance as User | If you want to configure the instance to run as a specific
user, type the user name, password, and domain.

Authentication The authentication parameters for the Business Process
Monitor instance to support the authentication scheme
in use by the server (basic or NTLM authentication). Type
the user name, password, and domain name of a user
recognized by the HP Business Service Management
Gateway Server.

53



Chapter 2 » Deploying Business Process Monitor

54

GUI Element

Description

Proxy Settings

If the Business Process Monitor instance is accessing the
HP Business Service Management Gateway Server
through a proxy server, define authentication parameters
for proxy requests (basic or NTLM proxy authentication).
Type the user name, password, domain name, and URL
for the proxy server.

Note:

» To configure a user name, you must also configure the
proxy server URL.

» The proxy URL must be in the following format: http
(or https)://<host name or IP address>:<port
number>/URI path.

» To configure reverse proxy, do not use these proxy
settings, but configure the reverse proxy server URL
instead of the Gateway Server URL in the "Instance
Definition Page" on page 50.

SSL Settings

If the Business Process Monitor instance is
communicating with the HP Business Service
Management Gateway Server using SSL, type the required
information in the relevant boxes.

Note: Click Browse to search for required locations.

Syntax exceptions: You cannot use a UNC (Uniform
Naming Convention) path when configuring the path
for SSL files.
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® Preview Page

The following is an example of the Preview page in a Windows installation.

HP Business Process Monitor Configuration Wizard

Current Settings Preview
Work Directory T e e 4]

To save the following configuration, click Finish. To modify any of the figlds, click Back

Run as User .
: Workspace Directory
Instance Definition

» Preview C:'\Documents and Settings\All Users\Application DataiHPIEPM
Finish Set BPM as User
System User

Instance Definition

Dizplay name: My _Default_Instance
Gateway Server URL: http:/ivmamrnd34 devlab adtopaz
Host name: MY HOST
Location name: My_Cube
Job poll interval (minutes): 2
Time poll interval (minutes): B0
Set instance as user: Undefined
Authentication: Undefined
Proxy: Undefined
Description Enables you to view a summary of the configured settings

before they are saved. Click Finish to save the
configuration and continue, or click Back to modify any
of the settings.

Wizard Map The Business Process Monitor Configuration Wizard
contains:

Current Settings Page > Work Directory Page > Run as
User Page > Instance Definition Page > Preview Page >
Finish Page
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¥ Finish Page

The following is an example of the Finish page.

Current Settings
‘Work Directory

Run as User

Instance Definition

Preview

¥ Finish

& HP Business Process Monitor Configuration Wizard

Configuration Wizard Status

The Configuration wizard settings were successfully set

Description

Displays a message about the success of the installation.
Click Close to exit from the configuration wizard.

Wizard Map

The Business Process Monitor Configuration Wizard
contains:

Current Settings Page > Work Directory Page > Run as
User Page > Instance Definition Page > Preview Page >
Finish Page

Important
Information

After Setup successfully completes the installation
process, HP Business Process Monitor is added as a service
and launched on the machine. For details on stopping
and starting Business Process Monitor manually, see
"Running Business Process Monitor" on page 85.
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Running a Silent Installation

You can use a silent installation procedure to run the Business Process
Monitor Setup. A silent installation is an installation that is performed
automatically, without the need for user interaction. Instead, all
configuration parameters are allocated predetermined values that are stored
in a configuration xml file.

Note: Read "Notes and Limitations" on page 70 before using any of the
silent installation methods.

This section includes:

"Silent Installation Overview" on page 57

"How a Silent Installation Assigns Values" on page 58
"Prerequisites" on page 59

"Silent Installation for Windows" on page 61

"Configuring the bpm_install_config.xml File" on page 63

Y Y Y Y Y Y

"Notes and Limitations" on page 70

Silent Installation Overview

There are three different types of silent installation:

» Using the silent installation default settings (when there is no
configuration file or previous settings).

» Using previous settings.
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» Using an xml configuration file. For this type on silent installation, do the
following:

» Create a silent installation configuration file with predefined
settings for all the hosts you are installing.

» Copy the Business Process Monitor setup program and the silent
installation xml configuration file to each of the target host
machines.

> Run the silent installation on each of the target host machines.

Note: From Business Process Monitor version 8.02, the silent installation
xml configuration file is different from previous versions.

How a Silent Installation Assigns Values

You can configure predetermined values to be used by a silent installation
for a specific Business Process Monitor machine in the <Business Process
Monitor application directory>\bpm_install_config.xml file located on the
machine on which you run the silent installation. The default Business
Process Monitor application directory is:

» Windows 2003 and Windows XP-C:\Documents and Settings\All
Users\ Application Data\HP\BPM

» Windows Vista, Windows 2008, and
Windows 7-C:\ProgramData\HP\BPM

If the silent installation locates the bpm_install_config.xml file and the file
contains values to be used for the specific machine, the silent installation
uses these values.

If the silent installation cannot locate the bpm_install_config.xml file, or
the file does not contain values to be used for the specific machine, the
silent installation looks for configuration settings from a previous
installation of Business Process Monitor. If such settings are detected, the
silent installation uses these settings.



Chapter 2 » Deploying Business Process Monitor

If a silent installation cannot locate the bpm_install_config.xml file, or the
file does not contain values to be used for the specific machine, and does
not detect configuration settings from the previous installation of Business
Process Monitor on the machine, it uses default settings. The default settings
configure Business Process Monitor to run as a system user and locate the
workspace directory in the default Business Process Monitor application
directory. When default settings are used, a default instance is not defined
during the installation and you must define the instance manually later. For
details on defining an instance, see "Create New Instance" on page 112.

For details on configuring the bpm_install_config.xml file, see "Configuring
the bpm_install_config.xml File" on page 63.

Prerequisites

Before you begin a silent installation of Business Process Monitor, make sure
of the following:

Install Prerequisite Programs

Each machine on which you want to install Business Process Monitor must
have the following programs, which are required for running scripts
correctly, installed:

» .NET Framework 3.5 SP1

» Microsoft Data Access Components (MDAC) 2.8 SP1 (or later)
» Microsoft Windows Installer 3.1 or later

» Microsoft Core XML Services (MSXML) 6.0

» Microsoft Visual C++ 2005 SP1 Redistributable Package (x86)
» Microsoft Visual C++ 2008 Redistributable Package (x86)

» Web Services Enhancements (WSE) 2.0 SP3 for Microsoft .NET
Redistributable Runtime MSI

» Web Services Enhancements (WSE) 3.0 for Microsoft .NET Redistributable
Runtime MSI

» Strawberry Perl 5.10.1
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To download and install the prerequisite programs:

1 Download the Business Process Monitor setup file for Windows from the

Business Service Management Downloads page (Applications > Platform >
Setup and Maintenance > Downloads) and save it on the machine on
which you are installing Business Process Monitor. Alternatively, copy the
setup file from the Business Service Management DVD containing data
collector installation programs, for versions delivered on DVD. For more
details on the location of the Business Process Monitor setup file, see
"General Installation Information" on page 26.

Extract the files from the downloaded file to a location of your choice on
the machine on which you are installing Business Process Monitor. To
extract the installation files, run the Business Process Monitor setup
program and once the files are extracted, terminate the installation
process.

From the extracted files (or from the files copied from the DVD), run the
prerequisite installation programs located in the language directory
relevant for your system, or in the common directory. For example:

» Windows\BPM\En\prerequisites or
» Windows\BPM\Common

Note: You can also obtain the prerequisite programs from the Internet.
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Uninstall Previous Versions of Business Process Monitor

You must uninstall any previous versions of Business Process Monitor from
each machine on which you are installing Business Process Monitor. For
details on uninstalling Business Process Monitor, see "Uninstalling Business
Process Monitor" on page 70.

Assign Administration Privileges

You must have administration privileges for each machine on which you are
installing Business Process Monitor.

Configure the bpm_install_config.xml File

If you want to use a silent installation to install Business Process Monitor on
multiple machines, or if you want to configure specific settings to be used
by a silent installation, edit the bpm_install_config.xml file accordingly.
Make sure that the file is located in the <Business Process Monitor
application directory> directory on each machine on which you run the
silent installation. For details on configuring the bpm_install_config.xml
tile, see "Configuring the bpm_install_config.xml File" on page 63.

Silent Installation for Windows

You can run a silent installation on Windows using either the regular setup
program, or using MSI.

Note: If you run a silent installation using MSI, the installation will not use
configuration settings from a previous installation of Business Process
Monitor on the machine, even if they are valid according to the order in
which a silent installation assigns values. For details, see "How a Silent
Installation Assigns Values" on page 58.
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To run a silent installation:

1 Download the Business Process Monitor setup file for Windows from the

Business Service Management Downloads page (Applications > Platform >
Setup and Maintenance > Downloads) and save it on the machine on
which you are installing Business Process Monitor. Alternatively, copy the
setup file from the Business Service Management DVD containing data
collector installation programs, for versions delivered on DVD. For more
details on the location of the Business Process Monitor setup file, see
"General Installation Information" on page 26.

Extract the files from the downloaded file to a location of your choice on
the machine on which you are installing Business Process Monitor. To
extract the installation files, run the Business Process Monitor setup
program and once the files are extracted, terminate the installation
process.

Run the program as follows:

> Using the regular setup program: From the extracted files, run the
setup program located in the language directory relevant for your
system. For example, to run the setup.exe program from the English
language directory, use:

en\setup.exe ""TARGETDIR=c:\Temp\a\"" /quiet /norestart

» Using MSI: From the extracted files, run the HP_BPM.msi program
located in the MSI directory using the following command:

\MSI\HP_BPM.msi /quiet /norestart
where:

> "\"TARGETDIR=<installation folder name>""-enables you to specify an
installation folder instead of the default folder. For example,
""TARGETDIR=c:\Temp\a\".

Note: This option must be the first option used in the command line.

> /quiet—quiet mode (there is no user interaction).
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Note: This option is mandatory for silent installations.

» /norestart-the machine will not be restarted after the installation is
complete.

4 Ensure that the silent installation has finished successfully by looking for
the following processes in the Windows Task Manager:
> tp_bpm_data_server.exe*32
> tp_bpm_ctrl.exe*32
> tp_bpm_agent.exe*32

> tp_bpm_admin.exe*32

Configuring the bpm_install_config.xml File

The bpm_install_config.xml file is used by a silent installation to obtain the
parameter values required during the installation of a specific Business
Process Monitor machine. For details on how the silent installation assigns
values, see "How a Silent Installation Assigns Values" on page S58.

The bpm_install_config.xml file can contain parameter values for multiple
machines, enabling you to create one file which you can copy to all the
machines on which you want to run a silent installation. Only the values for
the specific machine on which the installation runs are used.

This section includes the following topics:

> "Example of the xml Schema File (.xsd) Structure" on page 64
> "Description of the xml Schema File (.xsd) Structure" on page 65

» "Sample Files" on page 69
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Example of the xml Schema File (.xsd) Structure

<7l version="1.0" encoding="UTF-E*1>
¢l-- pdited with XMI rel. 3 U (ho

. 30
1 S w300/ 2001 WML Schama ™
steribureFombefasle="ungualified" ">
<xed:elenent name="hoata"s
<xad:complexTypes
<x=d:sequence>

"qualified”

<xad:element name="host™ minOccurs="1" max0ccurs="unbounded™>

<xed:complexlyper
<xsd: sequences
<xsd:elenent name="workapa

" pype="xsd:string™ minlocur

1" maxOdccurs="1"/»

<xad:element name="runBpmRaUser® minfccurs="0" maxOccura="i1"»

<xad:complexType>
<x2d:zequence>
<isd:elensnt
<xad:element

<xad:elenent name="domain® type="xad:estring® minbccurs
<¥ed:element name="geoup”

</xad:sequencer
</xad:conplexTypes
</x¥ad:element>

<xed:elenent name="insgance™ minDccurss

ex=d:complexTypes
<xzd:aeguencer

type="xsd: string” minlocura="1" maxlecurs="1%/%
type="xad:atring” minQccura="0" maxOccuras="1%/>
0° maxOccura="1%/>
ype="yad: sering” mimdccurs="0" maxlesura="1%/3>

= maxOecura="1"3>

<xsd:element name="displayMame® type="xad:string”/>

<xed:element
<x=d:elenent

<xad:element

asrverlel” wyp
locationfame™ type="xsd:atring"/>
<xad:element name="hostiame® type="xs

Red:aTring™/ >

tring” >
Ead:integer=/:

Typ

<usd:elenent name="jobInterval™ type="xzad:integer"/>
<xusd:element nams="suthentication” minODccurs="0" maxOccurs="1">

<xzd: complesTyper
<xsd: sequence’>
<xpd:element
<xadielement
<xad:element
</xad: sequences>
</usd: conplexTypes
</xad:elementy

name="username" type="xad:atring” minOccura="1" maxOecurs="lT/»
neme="password® type="xsd:atring® minOccurs="0" maxlccurs="1%/>
name="domain” type="xad:string" minOccurs="0" maxbccurs="1"/>

<xad:element name="ssl" minlccurs="0" maxdccurs="1%»

<xad:complexTypes
<xad: sequence>
<ksdielensnt
<xad:element
<xsd:element
cuedielensnt
</xad:sequencer
</zad: conplexType>
</xad:element>

<usd:elenment name="proxy"

exad: complaxTypes
<xadisequencer
<xed:element
<ysdielament
<xmdielemsnt
<xad:element
</xad; sequence’r
</xad:conplexTypas
</xmd:ielemanty

nams="clientCert" type="xad:string"/>
name<"privateley” type="xad:string"/>
nane="authoricyCert® type="xad:scring®/>
name="privateyeyPassvord” Cype="yad:sTring”/ >

mindccurs="0" maxOccura="1"3

nane="username® type="xsd:atring” minlccura="1" maxOccure="1%/>
me="pasaword” type=Txsd:atring” minOccura="0" maxlccur 1=/
me="domain” type="xsd:string” minOccurs="0" maxOccurs="1"/>
mame="url® type="xad:string" minlccurs="0" maxOccurs="1"/»

<xzd:element nome="runhalzer” mindocura="0" masfcoura="1"»

<xad:complexType
<¥Bd: sEqUencel
<xadielement
<xad:element
<xzdielement
</u8d: saquenses
</%xad:conplexTypes
</xad:element>
</xad:sequence>
</2ad: conplexType>
</xsdialemants
</x3d: sequence>
<xad:attribute name=-"hostName® type="xad
</uad:conplexTypas
</xad:element>
</x3d; sequence’>
</xad:complexTypes
</asdielement>
</%sd:schema>

inQcoure="

name="domain” type-"zadisizing” maxfocura="1"/>

1atring® use="regquired*/>
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Description of the xml Schema File (.xsd) Structure

Parent Element

Element Sub Element

valid.

host. The name or IP address of the machine for which the parameter values are

Note: The host name cannot be in Fully Qualified Domain (FQDN) format.

itor installation.

workspacePath. The path of the workspace directory of the Business Process Mon-

runBpmAsUser.
For running the
Business Process
Monitor as a spe-
cific user instead
of as a system
user:

username. The specific user name. The name can contain up
to 24 characters and cannot include spaces, nor any of the
following characters: (;:"<>*+=\[?,).

password. The specific user’s password (for Windows).

domain. The domain for the user (for Windows). The
domain name can be up to 67 characters long and can
include the following characters: 0-9, a-z, A-Z, hyphen (-).
The domain name cannot start or end with a hyphen (-), nor
can it include spaces.
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Parent Element

Element Sub Element

instance. Default
instance settings.
For details on
Business Process
Monitor
instances, see
"Instance Page"
on page 123.

displayName. The display name for the instance in Business
Process Monitor Admin. The display name can be up to 50
characters and can include the following characters: 0-9, a-z,
A-Z, hyphen (-), underscore (_). The display name cannot
start or end with a hyphen (-) or an underscore (_).

serverUrl. The URL of the HP Business Service Management
Gateway Server to which this instance sends collected data.
The URL must be in the following format: http (or
https)://<Gateway Server name or IP address>:<port num-
ber>/topaz. If you do not specify a port number, the default
port is used (80 for http and 443 for https).

locationName. The location defined for the instance. The
location name can be up to 50 characters and can include
the following characters: 0-9, a-z, A-Z, " ~ 1@ #$ % " & * ()
_-+=[1{}|/7.,:; (space).

hostName. The host name defined for the instance. The host
name can be up to 50 characters and can include the follow-
ing characters: 0-9, a-z, A-Z,”" ~1@#$% " &* () _-+=[]{
Y/ ?7.," ;<> (space).

timelnterval. The defined frequency (in minutes) with which
Business Process Monitor polls HP Business Service Manage-
ment for time synchronization. This is an integer positive
number.

jobinterval. The defined frequency (in minutes) with which
Business Process Monitor polls the database for assigned task,
application, and business transaction flow changes. This is
an integer positive number of up to 4 digits.
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Parent Element

Element

Sub Element

instance

authentication.
Set to yes if
authentication
is required for
the instance
and configure
the authentica-
tion parame-
ters for the
Business Pro-
cess Monitor
instance to sup-
port the
authentication
scheme in use
by the server
(basic or NTLM
authentication)

username. The name of the user (recog-
nized by the HP Business Service Manage-
ment Gateway Server) for authentication.

password. The password for the user.

domain. The domain of the user.

instance

ssl. Set to yes if
the Business
Process Moni-
tor instance is
communicat-
ing with the
HP Business
Service Man-
agement Gate-
way Server
using SSL.

For more infor-
mation on sup-
porting SSL
communica-
tion, see "Com-
munication
Using SSL" on
page 278.

ClientCert. The path and name of the cli-
ent certificate file.

privateKey. The path and name of the pri-
vate key file.

authorityCert. The path and name of the
authority certificate file.

privatekyePassword. The password for the
private key file.
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Parent Element

Element

Sub Element

instance

proxy. Set to
yes if the Busi-
ness Process
Monitor
instance is
accessing the
HP Business
Service Man-
agement Gate-
way Server
through a
PIOXY server.

Note: To con-
figure reverse
proxy, do not
use these proxy
settings, but
configure the
reverse proxy
server URL
instead of the
Gateway Server
URL in the
serverUrl ele-
ment of the
instance.

username. The user name for the proxy
server.

Note: To configure a user name, you must
also configure the proxy server URL.

password. The password for the user.

domain. The domain of the user.

url. The URL for the proxy server.

Note: The proxy URL must be in the fol-
lowing format: http (or https)://<host
name or IP address>:<port number>/URI
path.

instance

runAsUser. Set
to yes to run

the instance as
a specific user.

username. The specific user name.

password. The password for the specific
user (for Windows).

domain. The domain of the specific user
(for Windows).

Note: To configure parameter values for multiple Business Process Monitor
machines, create a new <host></host> section for each machine.
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Sample Files

The following files are located in the \\<%TEMP%>\HP Business Process
Monitor <BPM VERSION>\MSI\ServletContainer\webapps\
ROOT\help\BPMWeb directory when you download and extract the
Business Process Monitor setup file:

> silent_installation.xsd. A sample .xsd file.

» Example_1.xml. A sample .xml file that contains a simple configuration
for two hosts.

> Example_2.xml. A sample .xml file that contains a more complicated
configuration for one host.

» Example_3.xml. A sample .xml file that contains all parameters (remove
unwanted sections).

For details on downloading and extracting the Business Process Monitor
setup file, see "Silent Installation for Windows" on page 61.
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Notes and Limitations

Note the following when using a silent installation method for Business
Process Monitor:

» When running an installation in silent mode, no messages are displayed.
Instead, you can view installation information in the log files, including
information on whether the installation was successful. For details on the
log files, see "Log Files" on page 74.

» To troubleshoot installation issues on Windows platforms, you can add
logging options at the end of the command. For example, to run an MSI
silent installation with full logging:

HP_BPM.msi /quiet /norestart /qn /log <LogFile>

Note that this is the only way to view certain errors.
Use Standard MSI command line options to define logging options.

» When you specify the URL to the HP Business Service Management
Gateway Server in the bpm_install_config.xml file, it must end with
/topaz.

Uninstalling Business Process Monitor

70

The uninstall process saves configuration settings on the machine for future
installation.

The following procedures relate to uninstalling Business Process Monitor
version 9.02 on a Windows platform. For details on uninstalling earlier
versions on Windows platforms, refer to the relevant version
documentation.

To run a regular uninstall for Business Process Monitor on a Windows
platform:

1 On the host machine, shut down Business Process Monitor Admin and
Business Process Monitors (select:
Start > Programs > HP Business Process Monitor > Stop HP Business
Process Monitor Service
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Wait two minutes.

3 Run the Business Process Monitor uninstall program from the

Add/Remove Programs option in the Control Panel (select Start >
Settings > Control Panel > Add/Remove Programs > HP Business Process
Monitor, and click Change/Remove>).

4 Restart the machine if prompted to do so.

5 (Important: This step should only be performed if you do not want to

save the configuration settings for use by a future Business Process
Monitor installation.)

Delete the Business Process Monitor config folder from the machine.

Delete the Business Process Monitor root installation folder from the
machine and also, if it was not deleted automatically by the uninstall
procedure, the workspace directory.

To run a silent uninstall for Business Process Monitor on a Windows
platform using MSI:

1

Locate the HP_BPM.misi file, which is included in the Business Process
Monitor setup files for Windows. For details on downloading and
extracting files from the Business Process Monitor setup file for Windows,
see "Silent Installation for Windows" on page 61.

Open the command prompt window (Start > Run > cmd) and enter one of
the following commands:

» From the directory in which the HP_BPM.msi file is located:
msiexec.exe /uninstall HP_BPM.msi /quiet /norestart
» From any directory:

msiexec.exe /uninstall [path to HP_BPM.msi]\HP_BPM.msi /quiet
/norestart

For example:

msiexec.exe /uninstall C:\Backup\DVD\Windows\BPM\
MSI\Win32\HP_BPM.msi /quiet /norestart
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All standard MSI command line options are supported. For example:
> quiet—quiet mode (there is no user interaction).

» norestart-the machine will not be restarted after the installation is
complete.

3 (Important: This step should only be performed if you do not want to
save the configuration settings for use by a future Business Process
Monitor installation.)

After the silent uninstall has finished, delete the Business Process Monitor
config folder from the machine.

4 Delete the Business Process Monitor root installation folder from the
machine and also, if it was not deleted automatically by the uninstall
procedure, the workspace directory.

5 Ensure that the uninstall has finished successfully by checking that
HP Business Process Monitor is not included in the list of installed
programs in the Windows Control Panel.

Deployment Troubleshooting

This section describes common problems that you may encounter when
deploying Business Process Monitor, and their solutions, as well as the log
files created during the deployment.

This section includes the following topics:

> "Windows Platforms" on page 73

» "Log Files" on page 74
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Windows Platforms

This section describes troubleshooting problems when installing Business
Process Monitor on a Windows platform.

Cannot Set Business Process Monitor to Run as a Different User

If you (mistakenly) set the whole Business Process Monitor to run as a
specific user for a user that does not have write permissions to the <Business
Process Monitor root directory>\config directory, Business Process Monitor
fails to run, and you are unable to switch to a different user using the Set
BPM as User option in Business Process Monitor Admin. To set a different
user, use the following procedure:

To set a different user:
1 Stop Business Process Monitor.

2 Open the <Business Process Monitor application
directory>\config\topaz_agent_ctrl.cfg file in a text editor.

The default Business Process Monitor application directory is:
» Windows 2003 and Windows XP
C:\Documents and Settings\All Users\Application Data\HP\BPM
» Windows Vista, Windows 2008, and Windows 7
C:\ProgramData\HP\BPM

3 Under the [general] section, remove any existing values for the following
parameters:

nn

» UserDomain=

nn

» UserPasswd=
n

» UserName=

4 Save the file and restart Business Process Monitor. Business Process
Monitor now runs as a system user.

5 From Business Process Monitor Admin, set Business Process Monitor to
run as a new specific user (with Administrator permissions).
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Error Message when Installing Prerequisites on Windows 7

When installing Business Process Monitor on Windows 7, you may receive
an error message during the installation of the prerequisites. In such cases,
carry out the following procedure and then restart the installation:

1 Select Start > Control Panel > Administrative Tools > Local Security Policy
> Software Restriction Policies.

2 If no software restriction policies are defined, right-click the Software
Restriction Policies node and select New Software Restriction Policy.

Double-click Enforcement.
Select All users except local administrators.

Click OK.

QA U AW

Reboot the machine.

Log Files

The log files that are created when you deploy Business Process Monitor can
help you troubleshoot installation related problems. Log files are created for
both the installation and configuration parts of the deployment.

Windows Installation Log Files

The following Windows installation log files are located in the %temp%
directory:

File Name Description

ihp_custom_batches.log The log file for custom batch files, invoked by MSI
install/uninstall.

This is a common log for all HP based MSI
installations, such as HP Virtual User Generator
(VuGen) and QuickTest Professional.

This log is useful for ensuring that the custom
batches were running and it can provide
information to help track errors in the execution of
these batches.

bpm_setup.log The main log file for the MSI installation.
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File Name

Description

bpm_inst_bat.log

The log file that reflects the command line that
launched MSI.

Prereq_Mgr.Business_
Process_Monitor.log

The log file that contains the output from
setup.exe.

BpmlInstall.log

The log file that contains all log messages from the
configuration tool.

BpmlInstallStdOut.log

The log file that contains the standard output for
the configuration tool.

Configuration Wizard Log Files

The following log files are created by the Configuration wizard and are
located in the %temp% directory:

File Name Description

Bpmlnstall.log The log file that contains all log messages from the
Configuration wizard.

BpmlInstallStdOut.log The log file that contains the standard output from

the Configuration wizard.
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Working with Business Process Monitor

This chapter includes:

» Business Process Monitor Operation on page 78

» Supported Recording Tools on page 79

» Requirements and Limitations for Running Tasks on page 79
» Running Business Process Monitor on page 85

» Accessing Business Process Monitor Admin on page 86

» Changing the Language of the Business Process Monitor User Interface
on page 87

» Moving Around the Business Process Monitor Admin Window on page 88

» Notes and Limitations for Business Process Monitor on Windows Vista
on page 91

» Notes and Limitations for Business Process Monitor on Windows 7
on page 92

» Notes and Limitations for Business Process Monitor on Windows 2008
on page 92
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Business Process Monitor Operation

78

The Business Process Monitor service performs the following operations:

» retrieves business process configuration information (including
applications, business transaction flows, transactions, and recorded
scripts) from the profile databases via the HP Business Service
Management Gateway Server

» performs the work defined in the applications and business transaction
flows (including running scripts and running WebTrace)

» monitors the task and aggregates relevant data, performing all necessary
calculations

» sends samples to the HP Business Service Management Gateway Server

Note that the scripts are sent over the network (from HP Business Service
Management End User Management Administration to the Business Process
Monitor machine) in zipped format. This improves performance and
reduces network load.

Business Process Monitor saves detailed log entries for every executed task,
and for general Business Process Monitor operation. For more information
on the logs, see Chapter 15, "Workspace Directory and Log Files."

Business Process Monitor synchronizes time with the HP Business Service
Management Gateway Server once an hour (default Time Poll Interval
setting). If you change the time on the Business Process Monitor machine,
the Business Process Monitor reports may contain incorrect times until

HP Business Service Management is next polled for time synchronization.
To avoid this, you should restart Business Process Monitor/the relevant
Business Process Monitor instance, or change the Time Poll Interval setting
for an instance to a value smaller than 60 minutes. (See "Restart" on

page 116, or "Business Service Management Registration Properties Area" on
page 124.)
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Note: Business Process Monitor saves persistency information after
registration with HP Business Service Management, and after each job
update, enabling work to continue even if the Gateway Server is temporarily

unavailable.

Supported Recording Tools

Business Process Monitor 9.02 supports scripts recorded using the following
HP tools. Each tool (with the exception of HP Virtual User Generator) must
be installed on the Business Process Monitor machine before Business
Process Monitor can run scripts recorded with that tool.

> QuickTest Professional 11.0 (run on Windows platforms only).
> HP Virtual User Generator 11 with patch 1, and earlier.

Business Process Monitor supports the same client protocol versions as
those supported by its compatible version of VuGen.

Note: You cannot use WinRunner scripts with Business Process Monitor. All
WinRunner scripts should be converted to QuickTest Professional scripts.

Requirements and Limitations for Running Tasks

Business Process Monitor has the following requirements and limitations
when running scripts and WebTrace.

This section includes the following topics:

> "General" on page 80
» "HP Virtual User Generator Scripts" on page 81
» "QuickTest Professional Scripts" on page 82

> "WinRunner Scripts" on page 84
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General

Note: Refer to the LoadRunner/VuGen documentation to determine the
proper configuration for running a specific script.

» [t is recommended that you run scripts for all protocols (with the
exception of Web protocols) with the Business Process Monitor instance
/whole Business Process Monitor set to run as a specific user.

» If there is a problem with a script (for example, due to a missing client
installation, a download failure, corruption in the script, and so forth),
then the script may fail to initialize. In this case, the application or
business transaction flow containing the script also fails to initialize, with
the result that none of the application or business transaction flow scripts
or WebTraces are run on Business Process Monitor.

» When a script in an application or business transaction flow is run, but
for some reason does not finish successfully (that is, it does not end with
a status of Finished properly or Finished (errors occurred)), samples for
transactions that were part of the script, but were not run, are sent to
Business Service Management for inclusion in the Triage report. For
details on the Triage report, see Using End User Management, part of the
HP Business Service Management Documentation Library.

» Scripts that include an HTML replay mode cannot download Active-X
components.

» Business Process Monitor is not case sensitive to transaction names, so
you should ensure that each transaction within the same business
transaction flow has a unique name. Two transactions that have the same
name, but with case-sensitive differences, are handled as a single
transaction by Business Process Monitor. Business Process Monitor reports
both transactions to HP Business Service Management using a single
transaction ID, and the reports show results for only one transaction.

» Page component breakdown is supported only for certain HP Virtual User
Generator protocols.
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» WebTrace does not support the use of domain names that begin with a
digit, for example, www.1800hp.com. An error message is displayed.
Instead, use the IP address for the destination.

» Scripts of inactive applications or business transaction flows are still
downloaded to Business Process Monitor, so that if the application or
business transaction flow is made active, the Business Process Monitor
does not need to download the scripts. To avoid overload problem,
Business Process Monitor should be removed from the relevant
application or business transaction flow configurations.

HP Virtual User Generator Scripts

» If you are running scripts recorded with HP Virtual User Generator that
include protocols which require a client to run (for example, Oracle
Client or RealPlayer), you must have the protocol’s client installed on the
Business Process Monitor machine.

» Citrix recording and playback is supported only on Windows platforms.

» LoadRunner requires the installation of a Citrix registry patch to record
and replay scripts on Citrix client version 10.0 and later. The first time a
Citrix script runs on a BPM machine, LoadRunner prompts you to install
the Citrix registry patch on that machine. When prompted, click OK to
accept the installation.

» Business Process Monitor supports HP Virtual User Generator scripts for
all Oracle NCA protocols. If you run an Oracle NCA protocol task, you can
view transaction breakdown data for tasks that use http or Servlet
connection methods (breakdown data for Socket communication is not
supported).
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» If you have added jars or classes to the classpath in VuGen and are
running a java based protocol in Business Process Monitor, you must
perform one of the following actions to ensure that the script can locate
the jars:

» Remove the jar names from the run-time-settings > classpath list and
place the jar files in the script folder (where the .usr file is). The script
searches for all jars in the script folder and automatically adds them to
the classpath.

» Specity a full path to the jar in the run-time-settings > classpath list.
For example:

<workspace folder>\agent1\Site1\
BPM_SANITY_1bdf936f0f747829f519ff44808577b4\13\
JPetStore_ TABLE_Param\wlclient.jar

QuickTest Professional Scripts

Note: For tips and recommendations on recording scripts in QuickTest
Professional to run on Business Process Monitor, see Using End User
Management in the HP Business Service Management Documentation
Library.

» If BPM is installed on Windows Vista, Windows 2008, or Windows 7, you
must carry out the following configuration steps before running
QuickTest Professional scripts:

» Stop BPM from the Start menu.
» Disable Vista User Access Control (UAC).
» Disable Data Execution Prevention (DEP).

» Disable Interactive Services Detectione.
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Note: For details on the above steps, refer to the Microsoft Web site, or
other reference sources.

» Start BPM as a process. Run <BPM Install
dir>launch_service\bin\magentproc.exe.

Note:

» BPM must run as a process for executing QTP scripts.

» To stop BPM running as a process you must kill magentproc.exe in the
Task Manager.

Ensure that QuickTest Professional is closed on the computer before
running a QuickTest Professional script in Business Process Monitor.

QuickTest Professional cannot run tests on a computer that is logged off,
locked, or running QuickTest Professional as a non-interactive service.

The last step (may also be multiple last steps) in a QuickTest Professional
script should close the application being tested, as well as any child
processes that are running. This cleanup step enables the next run of the
script to open the application again.

However, if a script fails before it finishes running, it does not run the last
step. From version 6.1, Business Process Monitor supports a special close
application mechanism that automatically closes the application being
tested, when a QuickTest Professional script fails. This mechanism is
intended for fallback purposes only. Although the mechanism closes the
application being tested, it does not necessarily release all of the tested
application’s resources. Also, any unsaved data is lost.

This mechanism is enabled by default. If required, you can disable it for a
specific test, as described in "Disabling the Close Application Mechanism"
on page 268S.
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» Business Process Monitor does not support QuickTest Professional scripts
that require access to external resources (such as shared object repository,
function library, external Data Table, external actions, and so forth).
Scripts that require external resources may fail to run on Business Process
Monitor. (However, if the resource can be found on the network,
QuickTest Professional uses it.)

» Set every Business Process Monitor that is used to run QuickTest
Professional scripts, to run as a specific user before assigning the scripts,
and log in as that user.

» Business Process Monitor can run only one QuickTest Professional script
at a time. Make sure there are not multiple applications or business
transaction flows with QuickTest Professional scripts set to run
concurrently, or an application or business transaction flow with more
than one QuickTest Professional script set to run in Concurrent run mode.
(For information on run modes, see "Run Modes" on page 207.)

» Transaction breakdown is not supported for transaction files recorded
with QuickTest Professional.

» You cannot use the ResultDir QuickTest Professional environment
variable when running a script in Business Process Monitor.

» If BPM is installed on Windows 2008 or Windows 7, ensure the following
when you record the script:

> In the Record And Run Setting (in the the Automation section), select
the Record and run on any open browser option.

» The first line of the script opens a browser and the last line of the script
closes the browser. For example:

SystemUtil.Run "URL to open
Script content
Browser("script browser name").Close

WinRunner Scripts

You cannot use WinRunner scripts with Business Process Monitor. All
WinRunner scripts should be converted to QuickTest Professional scripts.
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Running Business Process Monitor

Once Business Process Monitor is active on a host machine, it can continue
running indefinitely. When Business Process Monitor starts, it automatically
starts each Business Process Monitor instance.

Running Business Process Monitor on a Windows
Platform

When you install Business Process Monitor on a host machine running on a
Windows platform, HP Business Process Monitor Service is added as a
service on the host. HP Business Process Monitor Service automatically starts
Business Process Monitor whenever the host machine is started.

To start Business Process Monitor on a Windows platform:
Select Start > Programs > HP Business Process Monitor > Start Business
Process Monitor Service.

To shut down Business Process Monitor on a Windows platform:

Select Start > Programs > HP Business Process Monitor > Stop Business
Process Monitor Service.

Note: When you start or stop Business Process Monitor on a machine
running on Windows Vista with User Account Control (UAC) activated,
when prompted, confirm that you trust the program responsible for starting
and stopping Business Process Monitor to continue with the start or stop
action.
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Accessing Business Process Monitor Admin
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You access Business Process Monitor Admin via a Web browser, from any
computer connected to your intranet or to the Internet. The Business
Process Monitor Admin console uses Java applet technology for which you
must install JRE on each client machine.

Note: For details on accessing Business Process Monitor Admin securely, see
"Configuring SSL Support for Business Process Monitor Admin" on page 272.

To access Business Process Monitor Admin:

You can access Business Process Monitor Admin in one of the following
ways:

> In a browser window, enter the URL http://<host machine>:2696, for
example, http://cats:2696.

» On the Business Process Monitor host machine, you can select Start >
Programs > HP Business Process Monitor > Business Process Monitor
Admin. Business Process Monitor Admin opens in a browser window.

» In HP Business Service Management, you can access the Admin > End
User Management > Settings > BPM Agents page and click the Open a
Business Process Monitor Agent’s Console icon for a Business Process
Monitor host to open the Business Process Monitor Admin for that host
in a new browser window.

Note: 2696 is the default port for Business Process Monitor Admin. You
can configure a new port if required. For details, see "Changing the
Default Port" on page 257.
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Changing the Language of the Business Process Monitor
User Interface

In Business Process Monitor 7.00 and later, the Business Process Monitor
user interface can be viewed in the following languages in your Web

browser:
Language Language Preference in Web Browser
Chinese Chinese (China) [zh-cn]
English English (United States) [en-us]
French French (France) [fr]
Japanese Japanese [ja]
Korean Korean [ko]

Use the language preference option in your browser to select how to view
Business Process Monitor Admin. The language preference chosen affects
only the user’s local machine and not the Business Process Monitor machine
or any other user accessing the same Business Process Monitor. The
language is determined when you first open Business Process Monitor
Admin; changing the language preference in your browser once you are
working in Business Process Monitor Admin has no affect until you close
and reopen Business Process Monitor Admin.

To view Business Process Monitor Administration in a specific language
using Internet Explorer:

1 Select Tools > Internet Options and click Languages. The Language
Preference dialog box opens.

2 Highlight the language in which you want to view Business Process
Monitor Administration.

If the language you want is not listed in the dialog box, click Add to
display the list of languages. Select the language you want to add and
click OK.

3 Click Move Up to move the selected language to the first row.

4 Click OK to save the settings.
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5 Refresh the page: the Business Process Monitor Administration user
interface is displayed in the selected language.

Notes and Limitations

» Starting from Business Process Monitor version 7.0, there is no language
pack installation. All translated languages are integrated into Business
Process Monitor Multi-lingual User interface (MLU).

» Data stays in the language it was entered in, even if the language of the
Web browser changes. Changing the language of the Web browser on
your local machine does not change the language of Business Process
Monitor definitions and configurations.

> If a user selects a language which is not supported by the Business Process
Monitor Multi-lingual User interface, the Business Process Monitor
Administration user interface appears in English.

Moving Around the Business Process Monitor Admin

Window
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The Business Process Monitor Admin browser window is divided into three
areas:

Business Process Monitor Tree

The left pane of the Business Process Monitor Admin window displays a
hierarchical tree of the Business Process Monitor instances, applications,
business transaction flows, and transactions included on the host machine.
Each entity included in the tree provides a link to a page displayed in the
right pane of the Business Process Monitor Admin window, in which you
can view and configure relevant settings for the entity. You can search the
tree for entities whose names contain a specific string. An icon is displayed
for each entity in the tree, enabling you to identify the entity type. For user
interface details on the Business Process Monitor tree, see "Business Process
Monitor Tree Pane" on page 95.
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The following is an example of the Business Process Monitor Admin
hierarchical tree:

=B
[lJ—CE, BEPM_Instance2
[l]—@ test_app
2% tu_fail
': T2t 1 _failed
02 tx_2_failed
% param
I'% jeptstore
— % welcome
— (02 search fish
— 92 login
— (02 update cart
— % add to cart
— (02 submit
— 2 logout
— @2 checkout
#-[8] Doc_BPM_gpp2
E—{% BPM_Instance_1
B8] Doc_BPM_App

Top Bar

The top bar includes the following drop-down menus, with additional
options for working with, and getting help in, Business Process Monitor
Admin:

» Tools. Includes an option for adding other Business Process Monitor
agents to the tree so that you can manage them in Business Process
Monitor Admin on one machine.

> Help. Includes help options for Business Process Monitor Admin.
For user interface details on the top bar, see "Top Bar" on page 163.

The following is an example of the top bar, with the Tools drop-down menu
displayed:

E# ) Business Service Management - Business Process Monitor Admin

ools Help ~
Agert Manager | Browse || Search || | Business Proces
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Info Area

When you select an entity in the Business Process Monitor tree in the left
pane of the Business Process Monitor Admin window, the relevant page for
that entity is displayed in the right pane of the window. The page enables
you to view and, where applicable, configure settings for the selected
entity.The following chapters describe the pages in Business Process Monitor
Admin:

» "Business Process Monitor Host Page" on page 101

> "Instance Page" on page 117

\

"Application Page" on page 137

\

"Business Transaction Flow Page" on page 145

\

"Business Transaction Page" on page 159

Note: When a Business Process Monitor instance connects to an HP Business
Availability Center system earlier than version 9.00, profiles are included in
the Business Process Monitor tree displayed in the left pane of the Business
Process Monitor Admin console, instead of applications and business
transaction flows. To access the Business Process Monitor Profile page, select
a profile in the Business Process Monitor tree. The Profile page user interface
is similar to the business transaction flow page user interface. For details, see
"Business Transaction Flow Page User Interface" on page 147.
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Notes and Limitations for Business Process Monitor on
Windows Vista

This section includes notes and limitations for Business Process Monitor
when it is installed on Windows Vista.

Business Process Monitor User Permissions

Users logged in to the Business Process Monitor machine, as well as any
users that Business Process Monitor is set to run as (either as a whole, or for
a specific instance), must have full control permissions to the ..\<Business
Process Monitor application directory>\config folder.

To set full control permissions to the ..\<Business Process Monitor
application directory>\config folder:

1 Browse to the ..\<Business Process Monitor application directory>. The
usual path is C:\ProgramData\HP\BPM.

2 Right-click the config folder and select Properties from the displayed
menu.

3 In the displayed Properties dialog box, select the Security tab.

4 In the Security tab, select the user in the Name area, then in the
Permissions area select the Allow check box for Full Control.

5 Click OK to save your changes and close the dialog box.

Editing Business Process Monitor Log and Configuration
Files

Edit Business Process Monitor log and configuration files using Notepad
only.

Enabling User Account Control

To run Business Process Monitor on Windows Vista, User Account Control
(UAC) must be enabled for users with User privileges. For users with
Administrator privileges, UAC can be enabled or disabled.
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Notes and Limitations for Business Process Monitor on
Windows 7

This section includes notes and limitations for Business Process Monitor
when it is installed on Windows 7.

User Type

Business Process Monitor on Windows 2008 or Windows 7 must run under a
user that has Administrator privileges.

Disabling User Account Control

To run Business Process Monitor on Windows 2008 or Windows 7, User
Account Control (UAC) must be disabled for users with Administrator
privileges.

Notes and Limitations for Business Process Monitor on
Windows 2008
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This section includes notes and limitations for Business Process Monitor
when it is installed on Windows 2008.

User Type

Business Process Monitor on Windows 2008 or Windows 7 must run under a
user that has Administrator privileges.

Disabling User Account Control

To run Business Process Monitor on Windows 2008 or Windows 7, User
Account Control (UAC) must be disabled for users with Administrator
privileges.
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Manual Procedure Before Installing Business Process
Monitor on Windows Server 2008 R2 64 Bit Platforms

You must carry out the following procedure before installing Business
Process Monitor on a Windows Server 2008 R2 64 bit platform:
1 Open Server Manager (Start > Administrative Tools > Server Manager).

2 Click Features in the left tree and then click Add Features in the right
panel.

3 Select the .NET Framework 3.5.1 Features check box and follow the
online instructions.

4 Once .NET Framework 3.5.1 in installed, restart the computer and start
the BPM installation.

93



Chapter 3 » Working with Business Process Monitor

94



4

Business Process Monitor Tree Pane

This chapter includes:
» Browse Tab on page 95

» Search Tab on page 98

Browse Tab

The Browse tab of the Business Process Monitor Tree pane displays a
hierarchical tree of the Business Process Monitor and its configured
instances, and the various entities assigned to them. Each entity included in
the tree provides a link to a page displayed in the right pane of the Business
Process Monitor Admin window, in which you can view and configure
relevant settings for the entity. Action buttons enable you to refresh the tree,
add additional instances to the Business Process Monitor, and delete
existing instances.

This section includes the following topics:

> "Business Process Monitor Tree" on page 96
> "Entity Icons" on page 97

> "Action Buttons" on page 98

95



Chapter 4 © Business Process Monitor Tree Pane

96

Business Process Monitor Tree

The Business Process Monitor tree is a hierarchical tree of the Business
Process Monitor instances configured on the host machine and the
applications, business transaction flows, and transactions assigned to each
instance. Instances that connect to HP Business Service Management
systems earlier than version 9.00 also include profiles. Hold the cursor over
an entity to display its type and full name. Click an entity to select it and
display its settings in the right-hand pane of the Business Process Monitor
Admin console. An icon is displayed next to each entity. For details, see
"Entity Icons" on page 97.

The following is an example of the Business Process Monitor Admin
hierarchical tree:

=B
[l]—[?_. BEPM_Instance2
[l]—@ test_app
2% tu_fail
4 t_1_failed
4 ta_2_failed
% param
I'% jeptstore
— _.' welcome
— _.' search fish
— % login
(04 update cart
— (04 add to cart
04 =ubmit
— 0% logout
L7 checkout
-[@] Doc_BPM_App2
EI—CE. BPM_Instance_1
B-[@] Doc_BPM_2pp
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Entity Icons

An icon is displayed for each entity in the tree, enabling you to identify the
entity type. The following icons are used:

Icon Represents:

2 Business Process Monitor Host
Ll

e Instance — registration data received
(from HP Business Service
Management or from persistency
files), and no fatal errors occurred for
this instance.

Note: The displayed instance status
is the status received in the last
communication from HP Business
Service Management.

e Instance — problem occurred (for

example, connectivity to

HP Business Service Management
failed, or failed to create a specific
user for that instance).

Note: The displayed instance status
is the status received in the last
communication from HP Business
Service Management.

=] Application

Business Transaction Flow

Business Transaction

-

Profile

Note: Profiles are shown only for
instances that connect to

HP Business Service Management
systems earlier than version 9.00.
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Action Buttons

The tool bar of action buttons for Business Process Monitor hosts and
instances is located at the top of the Browse pane. Only the actions that are
applicable to the entity selected in the tree are enabled.

For details on host actions, see "Host Actions" on page 104.

For details on instance actions, see "Instance Actions" on page 134.

7 The Refresh button, which you click to refresh the Business Process Monitor
tree, is enabled for all entities.
Note: You can also access actions for a selected entity in the tree by
right-clicking the entity to display a Shortcut menu of applicable actions.
Search Tab
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In the Search tab, you can search for entities whose name contains a
specified string. The search tab includes the following areas:

Search Definition Area

This area enables you to specify the string to search for in the entity names.

User interface elements are described below:

Ul Elements Description

Entity name Enter the string for which to search.

Search Click Search to run the search.

Clear Click Clear to clear the string in the Entity name
element.
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Search Results Area

This area enables you to view the search results (that is, the entities whose
name include the specified string).

User interface elements are described below:

Ul Elements Description

a Display in Business Process Monitor Tree. Click to
display the selected entity in the hierarchical tree in
the Browse tab. For details, see "Browse Tab" on
page 95.

Entity Name The entity name.

Note: You can filter the list of search results by
entering a string in the filter at the top of this
column.

Entity Type The type of entity.

Note: You can filter the list of search results by
selecting a specific entity type to display from the
drop-down list in the filter at the top of this
column.
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Business Process Monitor Host Page

This chapter includes:
» Host Page User Interface on page 101

» Host Actions on page 104

Host Page User Interface

This section describes the Business Process Monitor Host page in Business
Process Monitor Admin. The Business Process Monitor Host page displays
basic information about the Business Process Monitor installation and the
host machine on which it is installed.

To access the Business Process Monitor Host page, select the host entity in
the Business Process Monitor tree displayed in the left pane of the Business
Process Monitor Admin console. The host entity is the highest entity in the
tree (that is, the entity at the top of the tree).
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User interface elements are described below:

Ul Elements Description

Business Process Monitor The name of the Business Process Monitor. The

name name is automatically assigned during installation
and is derived from the name of the host machine
on which the Business Process Monitor is installed.

Health The health of the Business Process Monitor. The
valid health statuses are:

> OK

» Agent Launch Failed

» The agent was killed, failed to set a timer for
restarting it

» Run as specific user - failed to switch to user
» Run as specific user — invalid password

Business Process Monitor The operating system of the host machine on which

operating system the Business Process Monitor is installed.
Configuration directory The Business Process Monitor configuration
directory.

Default value: <Business Process Monitor
application directory>\config

Note: The default Business Process Monitor
application directory is:

» Windows 2003 and Windows XP-C:\Documents
and Settings\All Users\Application
Data\HP\BPM

» Windows Vista, Windows 2008, and
Windows 7-C:\ProgramData\HP\BPM
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Ul Elements

Description

Workspace directory

The Business Process Monitor workspace directory,
which you configure during the installation of
Business Process Monitor.

Default value: <Business Process Monitor
application directory>\workspace

Note: The default Business Process Monitor
application directory is:

» Windows 2003 and Windows XP-C:\Documents
and Settings\ All Users\Application
Data\HP\BPM

» Windows Vista, Windows 2008, and
Windows 7-C:\ProgramData\HP\BPM

Number of scripts

The total number of scripts configured in all of the
host’s instances, and the number of those whose
configuration status in End User Management
Administration is set to Active.

Number of WebTraces

The total number of WebTraces configured in all of
the host’s instances, and the number of those whose
configuration status in End User Management
Administration is set to Active.

Number of transactions

The total number of transactions configured in all
of the host’s instances, and the number of those
whose configuration status in End User
Management Administration is set to Active.
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Host Actions
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When a Business Process Monitor host is selected, the following action
buttons are enabled in the Browse tab of the Business Process Monitor Tree

pane:

Button

Description

For details, see...

&5

Create New Instance. Click to
open the Create New Instance
wizard, which you use to create a
new instance on a Business
Process Monitor host.

Note: You can create a maximum
of 16 instances on a Business
Process Monitor host.

"Create New Instance" on
page 106

Browse. Click to open a menu with the following browse options:

63 =
Browse Workspace "Browse Workspace" on
page 107
Browse Configuration Folder "Browse Configuration Folder"
on page 108
B Run. Click to open a menu with the following run options:
Run Page Component "Run Page Component
Breakdown Breakdown" on page 109
Run WebTrace "Run WebTrace" on page 110
|E| Create Troubleshooting File. "Create Troubleshooting File"

on page 111
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Button

Description

For details, see...

K

Set User Credentials. Click to set
the user used to run the Business
Process Monitor.

"Set User Credentials" on
page 112

)

Restart BPM. Click to restart the
Business Process Monitor.

Note: Restarting Business Process
Monitor causes the loss of any
data that has not yet been
reported by Business Process
Monitor to HP Business Service
Management.

"Restart" on page 116

Note: You can also right-click a selected host in the tree to display a Shortcut
menu of the applicable actions.
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Create New Instance

The Create New Instance option enables you to create a new instance on a
Business Process Monitor host machine, using the Create New Instance
wizard. After creating a new Business Process Monitor instance, the host
name for the instance is added to the list of available data collectors for
running applications and business transaction flows in End User
Management Administration. For details on specifying hosts for
applications and business transaction flows, see Using End User Management,
part of the HP Business Service Management Documentation Library.

Note:

» You add a default instance when you install Business Process Monitor.
For details, see "Deploying Business Process Monitor" on page 21.

» You can create a maximum of 16 instances on a Business Process Monitor
host.

Create New Instance Wizard

The elements included in the wizard pages are the same as the
corresponding elements in the Instance page, where you can view and edit
an existing instance’s settings. For details, see "Instance Page" on page 117.

The wizard contains the following pages:

» Define Identification Parameters page. For user interface details, see
"Business Service Management Registration Properties Area" on page 124.

» Run Instance as User page. For user interface details, see "Run as a Specific
User Area" on page 128.

» Proxy Connection Settings page. For user interface details, see "Proxy
Settings Area" on page 131.

» Security Settings page. For user interface details, see "Security Settings
Area" on page 132.
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Browse Workspace

The Browse Workspace option enables you to view the files stored in the
Workspace directory. The Workspace directory comprises log files and other
files that relate to Business Process Monitor operation. The log files
document event information and errors for Business Process Monitor and its
instances. For information on the contents of the log files, see "Workspace
Directory and Log Files" on page 277.

When you select the Browse Workspace option, the Browse Workspace
dialog box opens in a new window, comprising the following areas:

> Left pane. Displays a hierarchical tree of the folders, subfolder, and files
included in the Workspace directory (the root entry in the tree).

> Right pane. Displays the contents of the file you select in the tree in the
left pane. If the selected file is empty, the right pane also remains empty.

Note:

» You cannot edit the files from Business Process Monitor Admin, only
view the file contents.

» Use CTRL+F to find a specific string in a file.

» If your log files contains non-English data, you must open them in a
viewer that supports UTF-8 format parsing, for example, Notepad.
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Browse Configuration Folder

The Browse Configuration Folder option enables you to view the files stored
in the config directory. The config directory comprises configuration files
that contain the options defined for Business Process Monitor. For
information on the contents of the configuration files, see "Business Process
Monitor Configuration Files" on page 215.

When you select the Browse Configuration Folder option, the Browse
Configuration Folder dialog box opens in a new window, comprising the
following areas:

> Left pane. Displays a tree of the files included in the config directory (the
root entry in the tree).

> Right pane. Displays the contents of the file you select in the tree in the
left pane. If the selected file is empty, the right pane also remains empty.

Note:

» You cannot edit the files from Business Process Monitor Admin, only
view the file contents.

» Use CTRL+F to find a specific string in a file.
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Run Page Component Breakdown

The Run Page Component Breakdown option enables you to run an
on-demand page component breakdown (PCBD) request for any Web page.
Business Process Monitor measures response time while running the request,
and collects breakdown data for each component of the accessed Web page.
This information enables you to assess whether the response time was
affected by page content. The data collected is reported only to Business
Process Monitor Admin (not to HP Business Service Management).

When you select this option, the Run Page Component Breakdown dialog
box opens. User interface elements are described below:

Ul Element

Description

Address

The address for the target Web page. This may be:

» the name of a server on the local network

» a Web address

» the full URL for the page, for example:
http://www.hp.com/

Authentication user name

If the destination requires authentication, type the
name of a recognized user.

Authentication password

The password for the authentication user name (or
leave empty if the URL requires a blank password).

Timeout

A timeout value, in minutes. This value determines
how long Business Process Monitor attempts to
retrieve the page component data before timing
out.

Default value: 15 minutes

Run

Click to run the page component breakdown. The
Invoke PCBD window opens, displaying the page
component breakdown report. For details, see "Page
Component Breakdown Report Overview" on

page 168.
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Run WebTrace

The Run WebTrace option enables you to run a WebTrace to a destination
Web site and view the resulting report. The WebTrace report provides
information on network performance, which helps you analyze application
performance issues.

The data collected is reported only to Business Process Monitor Admin (not
to HP Business Service Management).

Note: Business Process Monitor cannot run WebTrace concurrently for more
than 40 addresses, including both configured and on demand WebTraces.

When you select this option, the Run WebTrace dialog box opens. User
interface elements are described below:

Ul Element Description

WebTrace address The destination Web address. Do not include the
string http:// or https:// when typing the server
address. For example:

www.hp.com

Port The port to access the Web address. If Business
Process Monitor is accessing the Internet through a
proxy servet, or if the destination address requires
access via https, specify port 443.

Default value: 80

Timeout A timeout value, in minutes. This value determines
how long Business Process Monitor attempts to
access the Web address before timing out.

Default value: 15 minutes

Run Click to run the WebTrace. The Run WebTrace
window opens, displaying the WebTrace report. For
details, see "WebTrace Report" on page 195.
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Create Troubleshooting File

The Create Troubleshooting File option enables you to create a zip file of
various Business Process Monitor directories and files for analysis or support
purposes. When you select this option, the Create Troubleshooting File
dialog box opens in a new window where you can select the following
options:

> Zip BPM Config and Workspace directories. Select this to zip the entire
contents of the Workspace and Config directories.

> Include script directories. The zip file is created by default without the
script directories, minimizing the file size and enabling you to keep the
script contents confidential. If the script directories are required, select
this option to include them in the file, but note that this may
considerable increase the size of the zip file.

Note: This option is enabled only when you select the Zip BPM Config
and Workspace directories option.

> Zip BPM client log files. These are files generated by the Business Process
Monitor Admin GUI on the client machine and give information to assist
in troubleshooting the application GUIL.

By default, a file called BPM-<host name>-<date>-<time>.zip is created, but

you can specify a different file name and also select the location in which to
save the file.
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Set User Credentials

The Set User Credentials option enables you to set the user as which the
data collection mechanism used by Business Process Monitor runs—the
system user or a specific user.

This section includes the following topics:

> "Set User Credentials Overview" on page 112
> "Set User Credentials User Interface" on page 114

> "Set Full Control Permissions" on page 114

Set User Credentials Overview

By default, Business Process Monitor is set to run as a system user. You can
set Business Process Monitor to run as a specific user (recommended), so
that all Business Process Monitor-related processes, as well as all tasks
defined for all Business Process Monitor instances, run as that user. Running
it as a specific user limits access to resources, settings, and applications
located on the local machine. (This may not be true for resources located on
remote machines, where a specific user may have different privileges than
the local system user.)

You can also set Business Process Monitor to run as a specific user during
Business Process Monitor installation, or set an individual Business Process
Monitor instance to run as a specific user (as described in "Run as a Specific
User Area" on page 128).

It is recommended that you run scripts for all protocols (with the exception
of Web protocols) with the Business Process Monitor instance/whole
Business Process Monitor set to run as a specific user.
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Notes and Limitations

When you set Business Process Monitor to run as a specific user, note the
following:

» You cannot set the whole Business Process Monitor to run as a specific
user if you have any individual Business Process Monitor instances set as
specific user. You must first revert all instances to run as system user.

» If you set Business Process Monitor to run as a specific user, then you
must set full control permissions for the user under the default Workspace
directory and (for Windows platforms only) under the user Temp folder
and the Windows installation folder. For details, see "Set Full Control
Permissions" on page 114.

» If you set the whole Business Process Monitor to run as a specific user on a
Windows platform, whether during installation or from the Actions
menu, the user must have administrator permissions on the local
machine.

» If you want to run QuickTest Professional scripts, it is recommended that
you set Business Process Monitor to run as a specific user before assigning
the QuickTest Professional scripts.

After running QuickTest Professional scripts as the system user, if you
then set Business Process Monitor to run as a specific user, the script may
fail. In this case, restart the Business Process Monitor machine.

For troubleshooting problems when setting Business Process Monitor as a
specific user, see "Deployment Troubleshooting" on page 72.
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Set User Credentials User Interface

When you select the Set User Credentials option in the Actions menu, the
Set User Credentials dialog box opens. User interface elements are described
below:

Ul Element Description

System user Select this radio button to configure Business
Process Monitor to run as the system user.

Other user Select this radio button to configure Business
Process Monitor to run as a specific user and enter
the following information:

» Name. The specific user name.

» Password. The password for the specific user.

» Domain. The domain of the specific user.

Set and Restart BPM Click to save the new user details and to restart
Business Process Monitor running as the new user.

Note: This button is enabled only if you change the
user credentials.

Set Full Control Permissions

If you set Business Process Monitor to run as a specific user, then you must set
full control permissions for the user under the default Workspace directory
and (for Windows platforms only) under the user Temp folder and the
Windows installation folder.

To set full control permissions on the Temp and Workspace directories:

1 Browse to the user Temp folder of the default user or the user that runs
the Business Process Monitor. The usual path of the Temp folder is:

» Windows 2003 or Windows XP
C:\Documents and Settings\<User name>\Local Settings\Temp
» Windows Vista, Windows 2008, and Windows 7
C:\Users\<User name>\AppData\Local\Temp)
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In the Temp directory, perform the following actions:
» Select Properties from the right-click menu for the folder.
> In the displayed Temp Properties dialog box, select the Security tab.

» Select the user in the Name area, then in the Permissions area select
the Allow check box for Full Control.

» Click OK to save your changes and close the dialog box.

Browse to the Temp directory in the Windows installation folder (usual
path C:\<Windows installation folder>\Temp) and repeat the actions
described in step 1 of this procedure.

Browse to the default workspace directory for Business Process Monitor
and repeat the actions described in step 1 of this procedure.

Browse to the default application directory for Business Process Monitor
and repeat the actions described in step 1 of this procedure.

Note: For details on the default application directory, see "How a Silent
Installation Assigns Values" on page 58.

Browse to the default configuration directory (usual path <Business
Process Monitor application directory>\config) and repeat the actions
described in step 1 of this procedure.

(Windows 2003 and 2008 platforms) Assign the user the logon right Allow
log on locally. (For details see, http://technet.microsoft.com/en-
us/library/cc756809(WS.10).aspx.)
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Restart

The Restart option enables you to restart Business Process Monitor. When
you select this option, Business Process Monitor Admin restarts all Business
Process Monitor instances on the host machine. Note that it may take a
minute or longer for Business Process Monitor Admin to reconnect to
Business Process Monitor.

Note: When multiple run units (applications and business transaction
flows) are running on a host, Business Process Monitor generates start offset
values to distribute script runs optimally over time. Restarting Business
Process Monitor prompts the recalculation of the start offset values.

If you create or delete applications and business transaction flows in End
User Management Administration, you can restart Business Process Monitor
to reset the automatic distribution of script runs. For more information on
the automatic distribution feature, see "Start Offset" on page 204.
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Instance Page

This chapter includes:
» Business Process Monitor Instances Overview on page 117
» Instance Page User Interface on page 119

» Instance Actions on page 134

Business Process Monitor Instances Overview

A single Business Process Monitor installation can communicate with
multiple Business Service Management installations, each with its own
tasks. Each such connection is called an instance.

Your Business Process Monitor installation can be used as the basis for
multiple Business Process Monitor instances on the host machine. For
example, you may require additional instances on the host machine to work
with different HP Business Service Management Gateway Servers. Each
instance runs its own tasks and reports independently to the relevant server.
Multiple instances can also serve the same Business Service Management
installation with different logical host names.

The initial installation of Business Process Monitor on the host machine
automatically creates the first Business Process Monitor instance in Business
Process Monitor Admin. During installation, you specify the Gateway Server
details for this instance. If you create additional instances, you can specify
the same Gateway Server, or, if you are using multiple Gateway Servers, you
can specify a different Gateway Server for each Business Process Monitor
instance.
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Each instance is assigned a unique host alias, referred to as the host name.
This host alias is used when designating hosts to run transactions for your
applications in HP Business Service Management End User Management
Administration. (Note that the host name does not imply the host machine
name.) You also define a location name for each instance, used to help
identify the instance in End User Management Administration and in End
User Management reports. The same location name can be used for multiple
instances, and does not need to be the location of the Business Process
Monitor host machine. Changing a location name in the Location Manager
in Business Service Management overrides the location configured for the
instance in Business Process Monitor Admin.

For each instance, you specify server authentication, SSL, and proxy server
information, as necessary. Business Process Monitor supports basic and
NTLM authentication schemes. (If you receive an error message when the
server tries to communicate with the instance, check which authentication
scheme is in use, and that the correct authentication and proxy information
is defined for the instance). For required parameter settings when
configuring NTML authentication, see "Parameters in sconn.cfg" on

page 247.

Note: You are required to specify the authentication user name and
password parameters when creating or editing the instance.

In addition, you can configure the Business Process Monitor instance to run
as a specific user, so that all tasks defined for the instance run as a specific
user. Running the Business Process Monitor instance as a specific user may
be necessary to solve access permission problems on your network.

Note: You can also set all Business Process Monitor instances on the
machine to run as a specific user, as described in "Set User Credentials" on
page 112.
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For details on creating and deleting instances, see "Action Buttons" on
page 98.

Instance Page User Interface

This section describes the Business Process Monitor Instance page in
Business Process Monitor Admin. The Business Process Monitor Instance
page displays status and configuration data for the selected instance.

To access the Business Process Monitor Instance page, select an instance
entity in the Business Process Monitor tree displayed in the left pane of the
Business Process Monitor Admin console.

The Business Process Monitor Instance page comprises the following tabs:

» "Status" on page 119

» "Configuration" on page 124

Status

The status tab displays general information about the instance, its
monitoring status, and the run units included in the instance. The status tab
comprises the following areas:

» "General Information Area" on page 120
> "Monitoring Status Area" on page 121

> "Run Units Area" on page 122
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General Information Area

This area enables you to view general information about the instance.

User interface elements are described below:

Ul Elements

Description

Display name

The display name defined for the instance in
Business Process Monitor Admin. This name is only
used within Business Process Monitor Admin to
identify the instance in the Business Process
Monitor tree displayed in the left pane of the
Business Process Monitor Admin console.

Health The communication status for the instance with
HP Business Service Management. If an error is
displayed, click the details link to display the
original error message in its raw format.

Instance ID Business Process Monitor internal ID for the

instance.

Tip: The ID may help you identify relevant folders
in the Business Process Monitor workspace.

Last update configuration
request

The last time that Business Process Monitor polled
for changes made in Business Service Management
End User Management Administration to Business
Process Monitor.

Note: Business Process Monitor also automatically
polls for updates, according to the defined job poll
interval (default = 2 minutes).

Last configuration update

The time of the last change made to the instance
configuration.
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Monitoring Status Area

This area displays information on the tasks for the instance.

User interface elements are described below:

Ul Elements Description

Number of applications The total number of applications associated with
the instance, and the number of those whose status
in End User Management Administration is Active.

Number of scripts The total number of scripts associated with the
instance, and the number of those whose status in
End User Management Administration is Active.

Number of WebTraces The total number of WebTraces associated with the
instance, and the number of those whose status in
End User Management Administration is Active.

Number of transactions The total number of transactions associated with
the instance, and the number of those whose status
in End User Management Administration is Active.

Pending samples The number of task reports (for completed runs of
script transactions, WebTraces, and so forth) waiting
to be relayed to the Business Service Management
Gateway Server.

Note: There are no limitations to the size of the
queue except for the amount of free disk space
available.
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Run Units Area

This area displays details of the run units included in the instance. Run units
are applications, or business transaction flows with their own schedule. For
details on run units, see "Run Units" on page 200.

Note: An inactive business transaction flow that is part of an active
application is considered to have its own schedule and is therefore
considered as a separate run unit.

User interface elements are described below:

Ul Elements Description

I Change visible columns. Click to open a list of the
k

available table columns, in a new window. Select a
check box to display a column, or clear a check box
to hide a column.

Default value: All columns are displayed.

Type The run unit type—application or business
transaction flow.

Run Unit Name The run unit name (that is, the application or
business transaction flow name).

Tooltip: The run unit’s schedule.
Note:

» Click the name to select the application or
business transaction flow in the Business Process
Monitor tree and display the relevant page for it.
For details on the Application page, see
"Application Page" on page 137 and for details on
the business transaction flow page, see "Business
Transaction Flow Page" on page 145.

» This column is not visible when working in
Business Process Monitor versions earlier than
9.00.
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Ul Elements

Description

Last Run Start Time

The start time of the last run of the run unit on this
instance, according to the local time on the
Business Process Monitor machine.

Last Run Duration

The time, in seconds, it took to execute the last run
of the run unit.

Status

The current status of the run unit. Valid options are:

» Currently running. The run unit is currently
running tasks.

» Idle. The run unit is running, but has no tasks
running at this time.

» Stopped. The run unit is stopped.

» Not initialized. The run unit has not yet started
its initial run.

Note: If the status is Not initialized, the run unit is
in the process of getting ready to run—creating the
schedules, downloading the required scripts. If
there is a problem (for example, if the script does
not download or if there is an incorrect schedule
definition) the run unit remains at this status and
an error "failed to initialize profile X ..." is written in
the agent log and in the agent_SiteX log.

Application

The application name. If the run unit is an
application, the run unit name and application are
the same. If the run unit is a business transaction
flow, this is the name of the application that
includes the business transaction flow.
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Configuration

The configuration tab enables you to view and change the instance settings
The configuration tab comprises the following areas:

"Business Service Management Registration Properties Area" on page 124
"Run as a Specific User Area" on page 128

"Proxy Settings Area" on page 131

Y VY VYV Y

"Security Settings Area" on page 132

Business Service Management Registration Properties Area

This area displays, and enables you to edit, the connection settings to the
Business Service Management Gateway server.

Important information The display, host, and location names must be
entered in English. If you use non-English strings in
any of the names, Business Process Monitor must be
installed on an operating system that supports these
characters.
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User interface elements are described below:

Ul Elements Description

Display name The display name defined for the instance in
Business Process Monitor Admin. This name is only
used within Business Process Monitor Admin to
identify the instance in the Business Process
Monitor tree displayed in the left pane of the
Business Process Monitor Admin console.

Syntax exceptions:

» Can be up to 50 characters.

» Can include the following characters: 0-9, a-z,
A-Z, hyphen (-), underscore (_).

» Cannot start or end with a hyphen (-) or an
underscore (_).

Gateway Server URL The full URL of the Gateway Server to which this
instance sends collected data. The URL must be in
the following format:

http (or https)://<Gateway Server name or IP
address>:<port number>/topaz.

If you do not specify a port number, the default port
is used (80 for http and 443 for https).

Note: The URL is case sensitive.
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Ul Elements

Description

Host name

The host name defined for the instance. The host
name is used to identify the instance in End User
Management Administration and reports in
Business Service Management.

Note:

» The host name must be unique within the
Business Service Management environment.

» If you change the host name for an instance,
HP Business Service Management assigns a new
HostID value to the Business Process Monitor
instance. As a result, the Business Process
Monitor instance does not run applications or
business transaction flows (or profiles for systems
earlier than Business Service Management
version 9.00) that use the original host name. To
enable applications and business transaction
flows (or profiles) to run correctly after changing
the host name, you must update your
applications and business transaction flows (or
profiles) in End User Management
Administration to use the new instance host
name.

Syntax exceptions:
» Do not use special characters if these characters
are not supported in Business Service

Management. Unsupported characters are
blocked by Business Process Monitor Admin.

» Can be up to 50 characters.

» Can include the following characters: 0-9, a-z,
AZ " ~1@#S% " "&*()_-+=[1{}|/?.,"":
; <> (space).
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Ul Elements

Description

Location name

The location defined for the instance.
Note:

» This field is displayed only for instances that
include profiles. That is, instances that are
configured for HP Business Availability Center
(installations earlier than Business Service
Management 9.00).

» Do not change the location for a Business Process
Monitor instance that is designated as the host
for a profile, when the database for the profile is
down. Doing so removes the mapping from the
profile to the instance, with no recovery.

Syntax exceptions:

» Can be up to 50 characters.

» Can include the following characters: 0-9, a-z,
AZ ~1@#S% " "&*()_-+=[1{}|/7?.,:;
(space).

127



Chapter 6 ¢ Instance Page

128

Ul Elements Description

Job poll interval (minutes) | The defined frequency (in minutes) with which
Business Process Monitor polls for assigned tasks
(for example, running scripts or Webtrace) and
changes to application configurations. This is an
integer positive number of up to 4 digits.

Default value: 2

Time poll interval The defined frequency (in minutes) with which
(minutes) Business Process Monitor polls HP Business Service
Management for time synchronization. This is an
integer positive number of up to 4 digits.

Default value: 60

Note: If a time change is made on the Business
Service ManagementGateway Server, for example,
for daylight saving time, then the time poll interval
value should be changed to a value smaller than the
default of 60 minutes, for each Business Process
Monitor instance.

If this is not done, it may take up to an hour for
Business Process Monitor to be synchronized with
the time change in Business Service Management,
and during this period the Business Process Monitor
samples are reported with the wrong time stamp.

Run as a Specific User Area

By default, each Business Process Monitor instance runs on the host
machine as the system user, unless you configured the whole Business
Process Monitor to run as a specific user (as described in "Set User
Credentials" on page 112).

This area enables you to configure an individual instance (and not the
whole Business Process Monitor) to run as a specific user. Running an
instance as a specific user limits access to resources, settings, and
applications located on the local machine. (This may not be true for
resources located on remote machines, where a specific user may have
different privileges than the local system user.)
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Note:

If you want to run QuickTest Professional scripts as a specific user, it is
recommended that you set each relevant Business Process Monitor instance
to run as a specific user before assigning the QuickTest Professional scripts.

After running QuickTest Professional scripts as the system user, if you then
set the Business Process Monitor instance to run as a specific user, the script
may fail. In this case, restart the Business Process Monitor machine.

User interface elements are described below:

Ul Elements Description
User name The specific user name.
Syntax exceptions:
» Can be up to 24 characters.
» Cannot include spaces, nor any of the following
characters: (;:"<>*+=\17,).
Password The password for the user.
Domain The domain of the user.

Syntax exceptions:

» Can be up to 67 characters long.

» Can include the following characters: 0-9, a-z,
A-Z, hyphen (-).

» Cannot start or end with a hyphen (-), nor can it
include spaces.

If you are running a Business Process Monitor instance as a specific user
without administrator permissions on the local machine, you need to set
additional permissions for the user.
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To set additional permissions for a specific user without administrator
permissions:

1 Assign Read & Execute permissions to the Business Process Monitor
installation directory.

2 Assign Full Control permissions to the relevant directory for the instance.
For example, the first instance must have access rights to the
..\Workspace\agent1\site1 directory.

3 Assign Write permissions to the ..\Workspace\agent1\data\snapshots
directory.

4 Assign Write permissions to the default user temp directory. All MDRV
based programs in the system use this directory for certain processes, for
example when using a script with parameters. The directory is usually
located under:

» Windows XP

C:\Documents and Settings\LocalService\Local Settings\Temp
> Windows 2003

C:\Documents and Settings\Default User\Local Settings\Temp
» Windows Vista, Windows 2008, and Windows 7

C:\Users\<User name>\AppData\Local\Temp
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Proxy Settings Area

This area enables you to configure proxy settings, if the Business Process
Monitor instance accesses the Business Service Management Gateway Server
through a proxy server.

Important information » To configure reverse proxy, do not use these
proxy settings, but configure the reverse proxy
server URL instead of the Gateway Server URL in
the "Business Service Management Registration
Properties Area" on page 124.

» If you create an instance with proxy settings and
the instance gives errors and does not function
properly, delete the instance, recreate it without
proxy settings, and then add the required proxy
settings to the recreated instance.

User interface elements are described below:

Ul Elements Description

Proxy user name The user name for the proxy server.

Note: To configure a user name, you must also
configure the proxy server URL.

Proxy password The password for the user.
Proxy domain The domain of the user.
Proxy URL The URL for the proxy server.

Note: The proxy URL must be in the following
format: http (or https)://<host name or IP
address>:<port number>/URI path.

Proxy authentication type | The type of authentication—Basic or NTLM.

Default value: Basic
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Security Settings Area

This area enables you to configure authentication parameters for the
Business Process Monitor instance to support the authentication scheme in
use by the HP Business Service Management Gateway Server (basic or NTLM
authentication). It also enables you to define SSL settings if the Business
Process Monitor instance is communicating with the HP Business Service
Management Gateway Server using SSL.

For more information on using basic authentication in HP Business Service
Management, see the HP Business Service Management Hardening Guide PDF,
part of the HP Business Service Management Documentation Library.

For more information on supporting SSL communication, see
"Communication Using SSL" on page 271.

Note:

» To define basic authentication requirements for accessing Business
Process Monitor Admin, see "Enabling User Authentication" on page 261.

» For required parameter settings when configuring NTLM authentication,
see "Parameters in sconn.cfg" on page 247.

User interface elements are described below:

Ul Elements Description

Authentication Settings

Authentication user name | The name of the user (recognized by the Business
Service Management Gateway Server) for
authentication

Authentication password The password for the configured user.

Authentication domain The domain for the configured user.

Authentication type The type of authentication—Basic or NTLM.

Default value: Basic




Chapter 6 * Instance Page

Ul Elements Description
SSL Settings
SSL client certificate file The path and name of the client certificate file.

Syntax exceptions: You cannot use a UNC (Uniform
Naming Convention) path.

SSL private key file The path and name of the private key file.

Syntax exceptions: You cannot use a UNC (Uniform
Naming Convention) path.

SSL private key password The password for the private key file.

SSL authority certificate The path and name of the authority certificate file.

file Syntax exceptions: You cannot use a UNC (Uniform

Naming Convention) path.

SSL host name validation The type of host name validation. Valid types are:
>» Full

» No host name validation

» None

Default value: Full (recommended)
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Instance Actions

When a Business Process Monitor instance is selected, the following action
buttons are enabled in the Browse tab of the Business Process Monitor Tree

pane:

Button

Description

Remove Instance. Click to delete the selected instance.

Browse. Click to open a Shortcut menu and click the Browse
Instance Files option. The instance log files are displayed in a new
window.

For details, see "Browse Instance Files" on page 135.

Request Configuration Update. Click to update changes made in
End User Management Administration (in Business Service
Management) to the Business Process Monitor instance. This
button enables you to manually prompt Business Process Monitor
to poll for changes; Business Process Monitor also automatically
polls for updates, according to the defined job poll interval for the
instance (default = 2 minutes).

Purge Samples. Click to remove all task reports waiting to be
relayed to the Business Service Management Gateway Server from
the queue.

Note: Once you click the Purge Samples button, all waiting data is
purged from the Business Process Monitor memory and cannot be
retrieved.

Note: You can also right-click a selected instance in the tree to display a
Shortcut menu of the applicable actions.
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Browse Instance Files

When you select the Browse Instance Files option, the Browse Instance Files
dialog box opens in a new window, comprising the following areas:

>

>

Left pane. Displays a tree of the files included in the instance’s Site(n)
directory (the root entry in the tree), where (n) is an internal number
assigned by Business Process Monitor Admin to the instance. The files
included are configuration and script files.

Note: The following files are not included in the instance directory:

> log files for retrieving configurations from Business Service
Management

» log files for sending samples to Business Service Management

» log files for Business Service Management business logic

Right pane. Displays the contents of the file you select in the tree in the
left pane. If the selected file is empty, the right pane also remains empty.

Note:

> You cannot edit the files from Business Process Monitor Admin, only
view the file contents.

» Use CTRL+F to find a specific string in a file.
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Application Page

This chapter includes:

» Application Page User Interface on page 137

Application Page User Interface

The Business Process Monitor Admin Application page enables you to view
details of an application configured in Business Service Management End
User Management Administration to which an instance is assigned. To
access the Business Process Monitor Application page, select an application
in the Business Process Monitor tree displayed in the left pane of the
Business Process Monitor Admin console.

Note: When you configure applications in End User Management
Administration, application names, as well as the names of the included
business transaction flows, transactions, and scripts, must be entered in the
same language that is set for the operating system of the Business Process
Monitor on which they are run. For details on configuring applications in
End User Management Administration, see "Business Process Monitor
Application Configuration Wizard" in Using End User Management.

The Application page includes the following areas:

» "General Information Area" on page 138

» "Schedule List Area" on page 139
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> "Monitoring Status Area" on page 139

» "Business Transaction Flows Overriding Application Schedule Area" on

page 144

General Information Area

This area enables you to view general information about the application.

User interface elements are described below:

Ul Elements

Description

Display name

The name of the application as configured in End
User Management Administration in HP Business
Service Management.

Status

The current status of the application in HP Business
Service Management—Active, Inactive, or
Downtime.

Location name

The location defined for the instance.
Note:

» The location name represents the name set by
the Location Manager, and is also used in End
User Management in Business Service
Management.

» The location name may be overridden by the

Location Manager in Business Service
Management.
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This area enables you to view the schedules configured for the application.

User interface elements are described below:

Ul Elements

Description

Schedule Description

The schedule for running the application on this
Business Process Monitor instance, as configured in
End User Management Administration. If the
application has multiple schedules, all schedules are
shown. (For more information, see "Schedules" on
page 202.)

Time Zone

The time zone to use for the Business Process
Monitor instance, as configured in End User
Management Administration.

Start Offset

The start offset, which specifies the delay between
the application schedule time and the actual run
time. (For information on how the start offset is
calculated, see "Start Offset" on page 204.)

Monitoring Status Area

This area enables you to view general information about the application, as
well as the running order and dependencies of the selected application’s

tasks.

User interface elements are described below:

Ul Elements

Description

<General Information>

Number of tasks

The number of tasks included in the application run
unit.
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Ul Elements

Description

Status

The application run unit status. Valid options are:

» Not initialized — The run unit has not yet been
initialized.

» Running — The run unit is currently running on
this Business Process Monitor instance.

» Idle — The run unit is not currently running on
this instance and is waiting for the next
scheduled run.

» Downtime. The run unit is not currently running
on this instance.

Last start time

The time that the run unit was last run.

Last run duration

The duration of the run unit’s last run.

Run mode The run mode configured for the application. For
details on run modes, see "Run Modes" on page 207.

<Tasks>

Task Properties. Click to open a new window

showing the script or WebTrace properties. For
details, see "Script Properties Window" on page 156
and "WebTrace Properties Window" on page 158.

Browse Script. Click to display the script log file (in
case of error during last run then mdrv log file) for
the last run of the task. For details on log files, see
"Workspace Directory and Log Files" on page 277.

Note: This element is disabled for all WebTraces and
for scripts for which there is no Last Run Status
data.
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Ul Elements

Description

>

Run Task. Click to run a selected task. Details of the
run are reported in a new window. For details on
task reports, see "Task Reports" on page 167.

When you run a script, the Run Script dialog box
opens, where you can set the log level for the script
run and add additional command line parameters.
For details on setting log levels, see "Setting the Log
Level" on page 167. Note that these changes are
only applicable to this run of the script.

Note:

» The task run data is not sent to HP Business
Service Management.

» The task run does not affect the run unit’s regular
scheduling in Business Process Monitor, or the
run of any other run unit in Business Process
Monitor.

Change visible columns. Click to open a list of the
available task table columns, in a new window.
Select a check box to display a column, or clear a
check box to hide a column.

Default value: All columns are displayed.

Run Order

The order in which the tasks are run. This is
determined by the run mode configured for the
Business Process Monitor in End User Management
Administration. For details on run modes, see "Run
Modes" on page 207.

Name

The script or WebTrace name.

Type

The type of task—script, WebTrace, or single URL.
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Ul Elements

Description

BTF

The business transaction flow in which the task is
included, as configured in End User Management
Administration.

Note: WebTraces configured directly for the
application are not included in a business
transaction flow and in such cases, this cell displays
n/a.

Note: Click a business transaction flow link to select
the business transaction flow in the Business
Process Monitor tree and display the relevant page.

Status

The current status of the task. Valid options are:

» Not initialized — The task has not yet been
initialized.

» Running — The task is currently running on this
Business Process Monitor instance.

» Idle — The task is not currently running on this
instance.
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Ul Elements Description

Last Run Status The status of the last run. Valid options are:

» Finished properly — The task finished running
with no errors.

» Finished (errors occurred) — The task finished
running; however, there may be some errors in
the task reports (for example, the traceroute
server may report "progress aborted" for a
WebTrace request). Check the network.txt and
webtrace.txt files in the workspace\webtrace
folder. For details of browsing the workspace
folder, see "Browse Workspace" on page 107.

> Failed to start — The task failed to start running.

» Terminated unexpectedly — The task failed
during the run.

» Error: Aborted — The task was aborted.

» Aborted (timeout) — The task was timed-out and
stopped running.

» End status is not set — The task has not run yet,
therefore no end status is available.

» n/a-Run status is not applicable for the task, for
example, if the application is inactive.

Last Run Time The duration of the last run.
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Business Transaction Flows Overriding Application

Schedule Area

This area enables you to view general information about business
transaction flows that are part of the application, but which have their own
schedules, so are considered as separate run units.

User interface elements are described below:

Ul Elements

Description

(I

Change visible columns. Click to open a list of the
available table columns, in a new window. Select a
check box to display a column, or clear a check box
to hide a column.

Default value: All columns are displayed.

BTF Name

The business transaction flow name.

Last Run Start Time

The time that the run unit was last run.

Last Run Duration

The duration of the last run of the run unit.

Status

The current status of the business transaction flow.

Valid options are:

» Not initialized — The run unit has not yet been
initialized.

» Running — The run unit is currently running on
this Business Process Monitor instance.

» Idle — The run unit is not currently running on
this instance.
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Business Transaction Flow Page

This chapter includes:
» Profile Page on page 145
» Business Transaction Flow Page Overview on page 146

» Business Transaction Flow Page User Interface on page 147

Profile Page

When a Business Process Monitor instance connects to an HP Business
Availability Center system earlier than version 9.00, profiles are included in
the Business Process Monitor tree displayed in the left pane of the Business
Process Monitor Admin console, instead of applications and business
transaction flows. To access the Business Process Monitor Profile page, select
a profile in the Business Process Monitor tree. The Profile page user interface
is similar to the Business Transaction Flow page user interface for business
transaction flows that have their own schedule (that is, business transaction
flows that are independent run units). For details, see "Business Transaction
Flow Page User Interface" on page 147.
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A business transaction flow is a logical user flow in an application. For
example, in a human resources application you may have a business
transaction flow for registering a new employee. You assign a script to the
business transaction flow (you can assign more than one script, although it
it is recommended to assign only one) that contains individual transactions.
For example, the script for the business transaction flow for registering a
new employee may include transactions for logging in to the application,
entering the new employee’s personal details, marking a check list to ensure
that all necessary documents have been received from the new employee,
and logging out of the system. For details on configuring business
transaction flows in End User Management Administration, see "Business
Transaction Flow Configuration Wizard" in Using End User Management.

By default, a business transaction flow uses the same schedules and run
modes as its parent application, but you can configure different schedules
and run modes specifically for a business transaction flow. If a business
transaction flow has its own schedule, it is not included in the application
run on the Business Process Monitor instance, but is run as an independent
unit. For details on run units, see "Run Units" on page 200.

The Business Process Monitor Admin Business Transaction Flow page
enables you to view details of a business transaction flow configured in
Business Service Management End User Management Administration to
which an instance is assigned. There are slight differences in the Business
Transaction Flow page depending on whether the business transaction flow
uses its parent application’s schedule or whether it has its own overriding
schedule. To access the Business Process Monitor Business Transaction Flow
page, select a business transaction flow in the Business Process Monitor tree
displayed in the left pane of the Business Process Monitor Admin console.

Note: When you configure business transaction flows in End User
Management Administration, business transaction flow names, as well as
the names of the included transactions and scripts, must be entered in the
same language that is set for the operating system of the Business Process
Monitor on which they are run.
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Business Transaction Flow Page User Interface

The Business Transaction Flow page includes the following areas:

Y Y Y Y Y

"Tasks Area" on page 150

"General Information Area" on page 147
"Schedule List Area" on page 148
"Monitoring Status Area" on page 149

"Tasks Included in the Business Transaction Flow and its Parent

Application’s Run Unit Area" on page 153

General Information Area

This area enables you to view general information about the business

transaction flow.

User interface elements are described below:

Ul Elements

Description

Display name

The name of the business transaction flow as
configured in End User Management
Administration in HP Business Service
Management.

Status

The current status of the business transaction flow
in HP Business Service Management—active or
inactive.

Note: A message is displayed if the business
transaction flow is active, but its parent application
is inactive

147



Chapter 8 ¢ Business Transaction Flow Page

Schedule List Area

This area enables you to view the schedules configured for the business
transaction flow.

User interface elements are described below:

Ul Elements Description

Schedule Description The schedule for running the business transaction
flow on this Business Process Monitor instance, as
configured in End User Management
Administration. If the business transaction flow has
multiple schedules, all schedules are shown. (For
more information, see "Schedules" on page 202.)

Time Zone The time zone to use for the Business Process
Monitor instance, as configured in End User
Management Administration.

Start Offset The start offset, which specifies the delay between
the business transaction flow schedule time and the
actual run time. (For information on how the start
offset is calculated, see "Start Offset" on page 204.)

Source The schedule source. Valid options are:

» Own Schedule. The business transaction flow has
its own schedule and is therefore an independent
run unit (that is, it is not included in its parent
application’s run unit).

» Application Schedule. The business transaction
flow is included in its parent application’s run
unit and uses its parent application’s schedule.
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Monitoring Status Area

This area enables you to view the general status and configuration of the

business transaction flow.

Note: This area is displayed only for business transaction flows that have
their own schedule and therefore, their own run unit.

User interface elements are described below:

Ul Elements

Description

Number of tasks

The number of tasks included in the business
transaction flow run unit.

Status

The current status of the business transaction flow
run unit. Valid options are:

» Not initialized — The run unit has not yet been
initialized.

» Currently running — The run unit is currently
running on this Business Process Monitor
instance.

» Idle — The run unit is not currently running on
this instance.

Last start time

The start time of the last run.

Last run duration

The duration of the last run.

Run mode

The run mode configured for the business
transaction flow. For details on run modes, see "Run
Modes" on page 207.
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Tasks Area

This area enables you to view the tasks configured for the business
transaction flow and to run them.

Note: This area is displayed only for business transaction flows that have
their own schedule and therefore, their own run unit. For details on
business transaction flows that use their parent application’s schedule, see
"Tasks Included in the Business Transaction Flow and its Parent
Application’s Run Unit Area" on page 153.

User interface elements are described below:

Ul Elements Description

o Task Properties. Click to open a new window
showing the script or WebTrace properties. For
details, see "Script Properties Window" on page 156
and "WebTrace Properties Window" on page 158.

= Browse Script. Click to display the BPM script folder
N in a new window. (If an mdrv log file exists, it is
selected automatically.) For details on log files, see
"Workspace Directory and Log Files" on page 277.

Note: This element is disabled for all WebTraces and
for scripts for which there is no Last Run Status
data.
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Ul Elements

Description

B

Run Task. Click to run a selected task. Details of the
run are reported in a new window. For details on the
reports, see "Task Reports" on page 167.

When you run a script, the Run Script dialog box
opens, where you can set the log level (Disabled,
Brief, or Extended) to determine the extent of the
information logged to the output for the script run,
and add additional command line parameters. Note
that these changes are only applicable to this run of
the script.

Note:

» The task run data is not sent to HP Business
Service Management.

» The task run does not affect the run unit’s regular
scheduling in Business Process Monitor, or the
run of any other run unit in Business Process
Monitor.

Run Order

The order in which the tasks are run. This is
determined by the run mode configured for the
business transaction flow in End User Management
Administration. For details on run modes, see "Run
Modes" on page 207.

Name

The task name, as configured in End User
Management Administration.

Type

Script, WebTrace, or Single URL.
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Ul Elements Description

Last Run Status The status of the last run. Valid options are:

» Finished properly — The task finished running
with no errors.

» Finished (errors occurred) — The task finished
running; however, there may be some errors in
the task reports (for example, the traceroute
server may report "progress aborted" for a
WebTrace request). Check the relevant log files
for further information on the errors
encountered. For details on the log files, see
"Workspace Directory and Log Files" on page 277.

> Failed to start — The task failed to start running.

» Terminated unexpectedly — The task failed
during the run.

» Error: Aborted — The task was aborted.

» Aborted (timeout) — The task was timed-out and
stopped running.

» End status is not set — The task has not run yet,
therefore no end status is available.

» n/a-Run status is not applicable for the task, for
example, if the application is inactive

Last Run Time The time of the last run.

Status The current status of the task. Valid options are:

» Not initialized — The task has not yet been
initialized.

» Running — The task is currently running on this
Business Process Monitor instance.

» Idle — The task is not currently running on this
instance.
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Tasks Included in the Business Transaction Flow and its
Parent Application’s Run Unit Area

This area enables you to view the scripts and WebTraces configured for the
business transaction flow, as well as the scripts and WebTraces configured
for the business transaction flow’s parent application. You can also run a

script or WebTrace.

Note: This area is displayed only for business transaction flows that are
included in their parent application’s run unit (that is, business transaction
flows that do not have their own schedule).

User interface elements are described below:

Ul Elements Description
5 Task Properties. Click to open a new window
showing the script or WebTrace properties. For
details, see "Script Properties Window" on page 156
and "WebTrace Properties Window" on page 158.
= Browse Script. Click to display the BPM script folder

in a new window. (If an mdrv log file exists, it is
selected automatically.) For details on log files, see
"Workspace Directory and Log Files" on page 277.

Note: This element is disabled for all WebTraces and
for scripts for which there is no Last Run Status
data.
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Ul Elements

Description

B

Run Task. Click to run a selected task. Details of the
run are reported in a new window. For details on
task reports, see "Task Reports" on page 167.

When you run a script, the Invoke Script dialog box
opens, where you can set the log level for the script
run and add additional command line parameters.
For details on setting log levels, see "Setting the Log
Level" on page 167. Note that these changes are
only applicable to this run of the script.

Note:

» The task run data is not sent to HP Business
Service Management.

» The task run does not affect the run unit’s regular
scheduling in Business Process Monitor, or the
run of any other run unit in Business Process
Monitor.

Included in Selected BTF

A check mark denotes that the script or WebTrace is
included in the selected business transaction flow
and not in its parent application.

Run Order

The order in which the tasks are run. This is
determined by the run mode configured for the
business transaction flow’s parent application in
End User Management Administration. For details
on run modes, see "Run Modes" on page 207.

Name

The task name, as configured in End User
Management Administration.

Type

Script, WebTrace, or Single URL.

BTF

The name of the BTF in which the script or
WebTrace is included.
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Ul Elements Description

Status The current status of the task. Valid options are:

» Not initialized — The task has not yet been
initialized.

» Running — The task is currently running on this
Business Process Monitor instance.

» Idle — The task is not currently running on this
instance.

Last Run Status The status of the last run. Valid options are:

» Finished properly — The task finished running
with no errors.

» Finished (errors occurred) — The task finished
running; however, there may be some errors in
the task reports (for example, the traceroute
server may report "progress aborted" for a
WebTrace request). Check the relevant log files
for further information on the errors
encountered. For details on the log files, see
"Workspace Directory and Log Files" on page 277.

> Failed to start — The task failed to start running.

» Terminated unexpectedly — The task failed
during the run.

» Error: Aborted - The task was aborted.

» Aborted (timeout) — The task was timed-out and
stopped running.

» End status is not set — The task has not run yet,
therefore no end status is available.

» n/a- Run status is not applicable for the task, for
example, if the application is inactive

Last Run Time The time of the last run.
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Script Properties Window

This window displays general details about a script and its included
transactions.

To access the Script Properties window for a selected script, click the Task
Properties button in the Tasks area.

User interface elements are described below:

Ul Elements Description

General Information

Name The script name, as configured in End User
Management Administration.

Script Repository Version The version of the script used.

Last Run Status The status of the last run. Valid options are:

» Finished properly — The task finished running
with no errors.

» Finished (errors occurred) — The task finished
running; however, there may be some errors in
the task reports. Check the MDRYV log file for
further information on the errors encountered.

» Failed to start — The task failed to start running.

» Terminated unexpectedly — The task failed
during the run.

» Error: Aborted — The task was aborted.

» Aborted (timeout) — The task was timed-out and
stopped running.

» End status is not set — The task has not run yet,
therefore no end status is available.

» n/a- Run status is not applicable for the task, for
example, if the application is inactive.

Last Run Time The time of the last run.

Last Run Duration The duration of the last run.
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Ul Elements Description

Transactions - lists the transactions included in the script and displays the
following data for them:

Name The transaction name as used in the script.

Original Name The original transaction name.

Note: If you change the name of a Business
Transaction CI in End User Management
Administration, the transaction name in existing
scripts is not changed. Elsewhere, however, (for
example, in Service Health, reports, and End User
Management Administration) the transaction name
is changed and persistent data for the CI is
preserved.

OK The response time threshold below which the
transaction’s status is OK, as configured in End User
Management Administration.

Minor The response time thresholds between which the
transaction’s status is Minor, as configured in End
User Management Administration.

Critical The response time threshold above which the
transaction’s status is Critical, as configured in End
User Management Administration.

Outlier The response time threshold above which the
transaction is considered to be an Outlier, as
configured in End User Management
Administration. Outliers are transactions whose
response time exceeds a defined time range.

Availability The availability threshold configured for the
transaction in End User Management
Administration in Business Service Management.

Parameters - lists the parameters used in the script and displays the following
data for them:

Name The parameter name.

Value The parameter value.
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WebTrace Properties Window

This window displays general details about a WebTrace.

To access the WebTrace Properties window for a selected WebTrace, click the
Task Properties button in the Tasks area.

User interface elements are described below:

Ul Elements Description

URL The URL accessed by the WebTrace

Port The port for the URL accessed by the WebTrace
Last Run Status The status of the last run. Valid options are:

» Finished properly — The task finished running
with no errors.

» Finished (errors occurred) — The task finished
running; however, there may be some errors in
the task reports (for example, the traceroute
server may report "progress aborted" for a
WebTrace request). Check the relevant WebTrace
log files for further information on the errors
encountered. For details on log files, see
"Workspace Directory and Log Files" on page 277.

> Failed to start — The task failed to start running.

» Terminated unexpectedly — The task failed
during the run.

» Error: Aborted — The task was aborted.

» Aborted (timeout) — The task was timed-out and
stopped running.

» End status is not set — The task has not run yet,
therefore no end status is available.

» n/a-Run status is not applicable for the task, for
example, if the application is inactive.

Last Run Time The time of the last run.

Last Run Duration The duration of the last run.
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Business Transaction Page

This chapter includes:

» Business Transaction Page User Interface on page 159

Business Transaction Page User Interface

The Business Process Monitor Admin Business Transaction page enables you
to view details of a transaction included in business transaction flow’s script,
as configured in Business Service Management End User Management
Administration, to which an instance is assigned. To access the Business
Process Monitor Business Transaction page, select a transaction in the
Business Process Monitor tree displayed in the left pane of the Business
Process Monitor Admin console.

Note: When you configure transaction in a script or in End User
Management Administration, the names of transactions must be entered in
the same language that is set for the operating system of the Business
Process Monitor on which they are run. For details on configuring
applications in End User Management Administration, see "Business Process
Monitor Application Configuration Wizard" in Using End User Management.

The Business Transaction page includes the following areas:

» "General Information Area" on page 160
» "Thresholds Area" on page 160
» "Script Area" on page 161
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General Information Area

This area enables you to view general information about the transaction.

User interface elements are described below:

Ul Elements Description

Display name The name of the transaction as configured in End
User Management Administration in HP Business
Service Management.

Thresholds Area

This area enables you to view the thresholds configured for the transaction.
For details on configuring transaction thresholds in End User Management
Administration, see "Business Transaction Business Process Monitor
Configuration Page" in Using End User Management.

User interface elements are described below:

Ul Elements Description

OK The response time threshold below which the
transaction’s status is OK, as configured in End User
Management Administration.

Minor The response time thresholds between which the
transaction’s status is Minor, as configured in End
User Management Administration.

Critical The response time threshold above which the
transaction’s status is Critical, as configured in End
User Management Administration.
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Ul Elements

Description

Outlier

The response time threshold above which the
transaction is considered to be an Outlier, as
configured in End User Management
Administration. Outliers are transactions whose
response time exceeds a defined time range.

Availability

The availability threshold configured for the
transaction in End User Management
Administration in Business Service Management.

Script Area

This area enables you to view the transaction name used in the script, as
well as the scripts in which the transaction is included.

User interface elements are described below:

Ul Elements

Description

Name in script

The name of the transaction as used in the script.

Note: If you change the name of a Business
Transaction CI in End User Management
Administration, the transaction name in existing
scripts is not changed. Elsewhere, however, (for
example, in Service Health, reports, and End User
Management Administration) the transaction name
is changed and persistent data for the CI is
preserved.

Included in scripts

The scripts in which the transaction is included,
within the same business transaction flow.
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Top Bar

This chapter includes:
» Top Bar Overview on page 163
» Tools Menu on page 164

» Help Menu on page 166

Top Bar Overview

The top bar includes drop-down menus with additional options for working
with, and getting help in, Business Process Monitor Admin. Click a menu to
display the menu options and click an option to select it. The following
menus are included in the top bar:

» Tools. Includes an option for adding additional agents to the Business
Process Monitor tree. For details see, "Tools Menu" on page 164.

> Help. Includes help options for Business Process Monitor Admin. For
details see, "Help Menu" on page 166.
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Tools Menu

164

The Tools menu contains the Agent Manager option, which you use to add
additional Business Process Monitor agents to the Business Process Monitor
tree. Adding additional agents to the tree enables you to view and
administer multiple Business Process Monitor agents from the same Business
Process Monitor Admin console. When you add a Business Process Monitor
host in the Agent Manager, the host is displayed in the Business Process
Monitor tree and the configuration is persistent (that is, if you close the
browser and then reopen Business Process Monitor Admin, the Business
Process Monitor hosts that were added in the Agent Manager are still
displayed). When you select the Agent Manager option (Tools > Agent
Manager), the Agent Manager dialog box opens.

Agent Manager Dialog Box

User interface elements are described below:

Ul Elements Description

Content Pane

J Add Agent. Click to open the Add Agent dialog
- box, where you configure an agent to add to the
Business Process Monitor tree. For user interface
details, see "Add Agent Dialog Box" on page 165.

Note: You should configure hosts using their fully
qualified domain name (FQDN) or their IP address.
If you add the same host twice, once with the FQDN
and once without, these are considered as separate
hosts and multiple entries are created in the
hierarchical Business Process Monitor tree. The
same behavior occurs if you configure the same host
twice, once with an IP address and once with
FQDN.

Ig' Delete Agent. Click to remove a selected agent from
the Business Process Monitor tree.

Refresh. Click to refresh the list of agents that have
been added to the Business Process Monitor tree.
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Ul Elements Description

<Agents> A list of the Business Process Monitor agents that
have been added to the Business Process Monitor
tree.

Agent Details Pane

Protocol The communications protocol used to
communicate with the selected Business Process
Monitor agent—http or https.

Host The host name of the selected Business Process
Monitor agent.

Port The port number used to communicate with the
selected Business Process Monitor agent.

Basic authentication user The user name for the agent machine’s Tomcat basic
name authentication, if used.

Server status The current connection status of the selected
Business Process Monitor agent’s host machine.

Add Agent Dialog Box

User interface elements are described below:

Ul Elements Description

Protocol The communications protocol used to
communicate with the Business Process Monitor
agent you are adding—http or https.

Default value: http

Host name The host name of the selected Business Process
Monitor agent you are adding.

Note: Use a fully qualified domain name (FQDN).

Port The port number used to communicate with the
Business Process Monitor agent you are adding.

Default value: 2696
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Ul Elements Description

Basic authentication user The user name for the agent machine’s Tomcat basic

name authentication, if used.
Basic authentication The password for the agent machine’s Tomcat basic
password authentication, if used.

Help Menu

166

The Help menu contains the following options for displaying the Business
Process Monitor Admin guide and other useful help information:

> Business Process Monitor Administrator’s Guide. Opens the guide in a
new browser window.

» What's New? Displays information on what’s new for this Business
Process Monitor version.

> About Business Process Monitor. Displays information on the Business
Process Monitor version.
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Task Reports

This chapter includes:

» Setting the Log Level on page 167

» Page Component Breakdown Report Overview on page 168

» Page Component Breakdown User Interface on page 169

» Understanding Response Time Breakdown Reports on page 178

» WebTrace Report on page 195

Setting the Log Level

Many scripts (for example, HP LoadRunner scripts and HP Virtual User
Generator scripts for Web-based protocols) include runtime settings that
determine the extent of the information logged to the output when the
script is run. There are three settings for logging: Disabled, Brief, and
Extended. By default, Business Process Monitor runs the scripts using the
Disabled log level; this means that only minimum information is logged to
the MDRV log for each run of the script.

You can change the log level for a specific script run when you invoke a
single run of the script in the Application or Business Transaction Flow page.
Changing the log level to Brief or Extended introduces extra overhead in the
MDRYV log files, and may slow down the run of the script (so affecting the
measured run times). An Extended log is helpful for debugging a script, but
is otherwise not recommended. For details of invoking a single run of a
script in the Application page, see "Monitoring Status Area" on page 139. For
details of invoking a single run of a script in the Business Transaction Flow
page, see "Tasks Included in the Business Transaction Flow and its Parent
Application’s Run Unit Area" on page 153.
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Page Component Breakdown Report Overview

168

The Page Component Breakdown (PCBD) report displays a breakdown of
transaction response times (in milliseconds), for each component of a Web
page. You use the report to analyze network, server, and client health in real
time. It helps you identify problematic elements of a Web page (for example,
images that download slowly, or broken links) for Web based transactions,
and problematic TCP activity (for example, failed connections to the server)
for non-Web based (TCP) transactions. The report can also help you identify
where along the network problems are occurring (for example, during DNS
Resolution, or during Time to First Buffer). Web based transactions comprise
Web components and TCP based transactions comprise TCP requests.

For scripts set to collect component breakdown data, Business Process
Monitor measures response time for each specific transaction in the script,
and collects breakdown data—information about client, network, and server
activity during the transaction—for each component of every Web page
accessed in Web based transactions, and for each component (request) in
non-Web based (TCP) transactions. This information enables you to assess
whether transaction response times were affected. For example, in Web
based transactions, a page content may affect response times and in
non-Web based transactions, request size or the number of requests may
affect response times.

For more information on the response time breakdown, see "Understanding
Response Time Breakdown Reports" on page 178.

Note:

» Component breakdown is supported only for certain HP Virtual User
Generator protocols. See "Understanding Response Time Breakdown
Reports" on page 178.

» For non-Web (TCP) based protocols, the page name has no relevance in
breakdown reports.
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You can run a Page Component Breakdown report by:

» invoking scripts from the Tasks area of the Business Transaction Flow
page. For details, see "Tasks Included in the Business Transaction Flow and
its Parent Application’s Run Unit Area" on page 153.

Note: When invoking scripts, page component breakdown data is shown
only if:

» in HP Business Service Management End User Management
Administration, the transaction monitor for the script was set to
perform component breakdown.

> the script was recorded using one of the configured protocols.

» performing an on-demand page component breakdown of any Web page
using the Run Page Component Breakdown action on the Host page. For
details, see "Run Page Component Breakdown" on page 109.

Page Component Breakdown User Interface

The Page Component Breakdown report is displayed in the Invoke Script
dialog box, which is divided into the following two panes:

» The Context (left) pane. Displays the different reports that comprise the
Page Component Breakdown report. These include a summary report for
the entire script and individual reports for each transaction included in
the script.

Note: When you run an on-demand page component breakdown for a
Web page, a default transaction called PDBD transaction is created for the
report.
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» The main (right) pane. Displays the content for the report selected in the
Context pane—the summary, or a specific transaction.

This section includes the following topics:

> "Summary Report" on page 170

» "Transaction Report" on page 173

Summary Report

Note: This section is applicable for Web based transactions. For the
differences in breakdown reports for non-Web based (TCP) transactions, see
"Understanding Breakdown Report Data for Non-Web Based (TCP)
Transactions" on page 190.

The summary of the Page Component Breakdown report includes general
information about the script run, the run status of the transactions included
in the script, and aggregated component data for each of the transactions
included in the script.

Run Page Component Breakdown on VM 145
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General Information Area

User interface elements are described below:

Ul Elements Description

Name The name of the invoked script, or for on-demand
page component breakdown, the name of the
accessed Web page.

Version The script version number.

Note: This is not relevant for on-demand page
component breakdown.

Status The status of the script run. Valid statuses are:

» Running
» Finished
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Run Status Area

This area contains a line for each transaction included in the script, or for
on-demand component breakdown, one line for the default transaction.

User interface elements are described below:

Ul Elements Description
Stage The transaction name.
Run Status The run status of the transaction. Valid options are:

> & Pending. The transaction is waiting to run.

» [ Passed. The transaction ran successfully.

» €3 Failed. The transaction did not run
successfully.

> E' No data arrived. The transaction ran
successfully, but no data was received.

> ; Timeout. Business Process Monitor was
unable to retrieve page component data within
the configured timeout period.
Note: The default timeout is 15 minutes. When
you run an on-demand page component
breakdown you can configure the timeout value.

Transaction Breakdown Data Area

This area contains a line for each transaction included in the script, showing
aggregated transaction breakdown data for all the components in the
transaction.

User interface elements are described below:

Ul Elements Description
<Legend> A legend describing the color coding used in the
report.
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Ul Elements Description
Name The transaction name.
Breakdown A bar that shows the total transaction time in

milliseconds. The color-coded segments enable you
to differentiate between the various breakdown
categories for the transaction, with each colored
segment representing the total time for its
corresponding measurement. For example, you can
view the overall DNS time for the transaction. (For
explanations of the breakdown categories, see
"Understanding Transaction Breakdown Categories"
on page 179.)

Tooltip: Hold the cursor over a colored segment to
view the breakdown category name and the total
time for that category.

Tip: You can correlate the breakdown summary data
with transaction response time information to
assess whether poor transaction response times are
being caused by DNS resolution or connection
problems, network latency or server delay, or client
delay.

Transaction Report

Note: This section is applicable for Web based transactions. For the
differences in breakdown reports for non-Web based (TCP) transactions, see
"Understanding Breakdown Report Data for Non-Web Based (TCP)
Transactions" on page 190.

The Transaction reports included in the Page Component Breakdown report
enable you to assess whether transaction response times and service
availability are being affected by page content. There is a separate report for
each transaction included in the script and you display the report for a
specific transaction by selecting the transaction in the Context pane.
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The report displays general data about the transaction run, summary
response time breakdown data for all of the components in the transaction,
transaction response time breakdown data for each component in the
transaction, and error data. For details of the breakdown categories, see
"Understanding Transaction Breakdown Categories" on page 179.
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General Information Area

User interface elements are described below:

Ul Elements Description
Name The transaction name.
Note: For on-demand component breakdown, there
is one default transaction called PCBD transaction.
Status The status of the transaction run. Valid statuses are:

» Pending. The transaction is waiting to run.

» Passed. The transaction ran successfully.

» Failed. The transaction did not run successfully.

» No data arrived. The transaction ran successfully,
but no data was received.

» Timeout. Business Process Monitor was unable to
retrieve page component data within the
configured timeout period.

Transaction Breakdown Data Area

User interface elements are described below:

Ul Elements

Description

Breakdown Parameter

The transaction breakdown category name. For
details of the breakdown categories, see
"Understanding Transaction Breakdown Categories'
on page 179

Summary

The weighted time, in milliseconds, of all the
components included in the transaction, for the
breakdown category. For details on weighting, see
"Understanding How HP Business Service
Management Breaks Down Transaction Response
Times" on page 185.
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Transaction Response Time Breakdown Area

User interface elements are described below:

Ul Elements

Description

<Legend>

Describes the color coding used in the report.

Page

The URLs of the Web pages accessed in the
transaction.

Tooltip: Hold the cursor over the name of a page to
show the full name.

Note: Click the plus (+) sign to expand a page and
display its components.

Component

The URLs of the components included in an
accessed Web page.

Tooltip: Hold the cursor over the name of a
component to show the full name.

Note: If the parent Web page is not expanded to
display its components, this column displays the
total number of components included in the page.

Size (KB)

The total size, in kilobytes, of the page or
component.

Total Time (ms)

The total time of the component, in milliseconds.
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Ul Elements Description

Error Message If applicable, an error message related to the specific
component.

Breakdown A bar that shows the total component time in

milliseconds. The color-coded segments enable you
to differentiate between the various breakdown
categories for the component, with each colored
segment representing the total time for its
corresponding measurement. For example, you can
view the overall DNS time for the component. (For
explanations of the breakdown categories, see
"Understanding Transaction Breakdown Categories"
on page 179.)

Tooltip:

» Hold the cursor over a colored segment to view
the breakdown category name and the total time
for that category.

» Hold the cursor over the white space to the left of
a component's colored bar to show a tooltip with
the offset time for that component. The offset
time for a specific component is the time that
passes from the start time of the first component
on the page until the start time of the specific
component.

Note: Gaps in time between components (time

between one component finishing and the next one

starting) represent processing time—client-side
delays caused by browser think time, CPU think
time, HTML page processing time, time needed to
open sockets or threads, and so forth.
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Errors Area

User interface elements are described below:

Ul Elements Description

Error ID The error Id number

File Name The name of the file in which the error occurred.

Error Line The line number in the file on which the error
occurred.

Error Message The error message.

Understanding Response Time Breakdown Reports

There are differences between breakdown categories and response times for
Web based transactions and non-Web based transactions.

This section contains:

» "Understanding Web Based Transaction Breakdown Reports" on page 179,
describing what each breakdown category is measuring in Web based
transactions.

» "Understanding Non-Web Based TCP Transaction Breakdown Reports" on
page 184, describing what each breakdown category is measuring in
non-Web based (TCP) transactions.

» "Calculating Transaction Breakdown from Component Breakdown" on
page 194, describing how component breakdown is used to calculate the
transaction breakdown.
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Understanding Web Based Transaction Breakdown
Reports

The Web based protocols for which Business Process Monitor can perform
transaction breakdown are configured in the BdSupportedProtocols setting
in the agent1.cfg file on the Business Process Monitor machine. For details
on the agentl.cfg file, see "Parameters in agentl.cfg" on page 226. If a script
for which Business Process Monitor is configured to collect transaction
breakdown data contains multiple protocols, and one of the protocols is a
Web based protocol configured in the BdSupportedProtocols configuration
setting, Web based breakdown is used.

Note:

» Transaction breakdown is not supported by Business Process Monitors
running scripts recorded in wininet mode in HP Virtual User Generator.

» Page component breakdown does not function for streaming objects,
such as Java Applets, sounds, and movies. This is because the engine that
runs the page component breakdown uses technology that only handles
components that can be parsed directly from the HTML code (for
example, images).

This section includes the following topics:

» "Understanding Transaction Breakdown Categories" on page 179

» "Understanding Download Time" on page 183

Understanding Transaction Breakdown Categories

The transaction breakdown component in reports displays a breakdown of
average transaction response times (in milliseconds) over time, for the
selected time frame. Response times are broken down by retry time, DNS
resolution time, connection time, network time to first buffer, server time to
first buffer, download time, and client time. If your site uses SSL
authentication, SSL handshaking time is also displayed.

179



Chapter 11 e Task Reports

180

The diagram below illustrates the relationship between the component’s
main breakdown categories (shown along the bottom of the diagram) and

client/server activity during transaction execution.

Note that retry time, SSL handshaking time, and client time are not shown
in this diagram. They are described in the breakdown category table. For

details, see "DNS Resolution" on page 181.

*Business Service Management combines: Network Time to First Buffer and Server Time to First Buffer

Server Establizh Send At Send Last
Activity: Connecion  Send ACK Buffer Byte
/\/ A \d Data
Cilient DNS Initial Initial HTTP Recawe ACK Receive Frst Receive La:tl
Activity: Lookup Commection  Request Buffer Byte
DNS Connection Metwork Server Dowrload
Resolution Time Time to Time to Time
Time First Buffer First Bufer
Time to First
Buffer*
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The following table describes the component’s breakdown categories. Times
are calculated by taking the average of all transaction runs within the

specified time period.

Name

Description

Retry Time

Displays the overall amount of time that passes
from the moment an http request is started until
the moment an http or TCP error message is
returned. Retry time only relates to http or TCP
errors that execute a retry after the error.

DNS Resolution

Displays the average amount of time needed to
resolve the DNS name to an IP address, using the
closest DNS server. The DNS Lookup measurement
is a good indicator of slow DNS resolution or other
problems with the DNS server.

Connect Time

Displays the average amount of time needed to
establish an initial connection with the Web server
performing the transaction. The connection
measurement is a good indicator of problems along
the network or whether the server is responsive to
requests.

SSL Handshake Time

Displays the average amount of time taken to
establish an SSL connection (includes the client
hello, server hello, client public key transfer, server
certificate transfer, and other—partially optional—
stages). After this point, all the communication
between the client and server is encrypted.

Note: The SSL handshaking measurement is only
applicable for https communications.

Network Time to First
Buffer

Displays the average amount of time that passes
from the moment the first http request is sent until
receipt of ACK. The network measurement is a good
indicator of network quality (look at the time/size
ratio to calculate download rate).

181



Chapter 11 e Task Reports

Name Description

Server Time to First Buffer | Displays the average amount of time that passes
from the receipt of ACK of the initial http request
(usually GET) until the first buffer is successfully
received back from the Web server. The server time
to first buffer measurement is a good indicator of
Web server delay.

Note: Because server time to first buffer is being
measured from the client, network time may
influence this measurement if there is a change in
network performance from the time the initial http
request is sent until the time the first buffer is sent.

Download Time Displays the time from the receipt of the first buffer
until the last byte arrives.

Download time is a combination of server and
network time, since the server typically sends data
over multiple connections, and therefore is usually
working while data is being transmitted over the
network. For more details, see "Understanding
Download Time" on page 183.

Client Time Displays the average amount of time that passes
while a request is delayed on the client machine.
Client-related delays can include browser think
time, CPU think time, HTML page processing time,
time needed to open sockets, application delays
caused by heavy applets, and so on.

Note: Client time is calculated by subtracting all
other measured times from the total transaction
time.

Note: In certain circumstances, for example, when the Business Process
Monitor is using a proxy server, the transaction breakdown mechanism
cannot differentiate between server time to first buffer and network time to
first buffer. In these cases, the report displays the time between initial http
request and receipt of first buffer as Time to First Buffer.
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Understanding Download Time

When a Business Process Monitor running a script communicates with a
Web server (specified by the URLs in the script), communication is carried
out, by default, over four connections simultaneously.

As the Web page is retrieved, its various components (images, applets, and
so on) travel in data packets from server to client across these multiple
connections.

As a result, at any point along the time line after the server sends the first
buffer until the client receives the last byte for the page, data packets may be
traveling over the network through some of the connections while others
are being processed by the server through the remaining connections. The
download time in the report represents the sum total of the time when
network resources and server resources are in use at the same time, between
the time the client receives the first buffer and the last byte.
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Understanding Non-Web Based TCP Transaction
Breakdown Reports

The non-Web based (TCP) protocols for which Business Process Monitor can
perform transaction breakdown are configured in the
AdvancedTcpBdSupportedProtocols setting in the agent1.cfg file on the
Business Process Monitor machine. For details on the agentl.cfg file, see
"Parameters in agent1.cfg" on page 226. If a script for which Business Process
Monitor is configured to collect transaction breakdown data contains
multiple protocols, and none of the Web protocols are configured in the
BdSupportedProtocols configuration setting, and at least one of the TCP
protocols is defined in the AdvancedTcpBdSupportedProtocols configuration
setting, TCP breakdown is used.

Note:

» Non-Web based (TCP) transaction breakdown is supported on Windows
only.

» Supported protocols must be TCP request/response based protocols.

» Non-Web based (TCP) transaction breakdown cannot be used with
VuGen Speed Simulation.

This section includes the following topics:

» "Understanding How HP Business Service Management Breaks Down
Transaction Response Times" on page 185

» "Understanding Transaction Breakdown Categories for Non-Web Based
(TCP) Transactions" on page 185

» "Understanding Time to First Buffer and Download Time for Non-Web
Based (TCP) Transactions" on page 190

» "Understanding Breakdown Report Data for Non-Web Based (TCP)
Transactions" on page 190

> "Notes and Limitation for Non-Web Based (TCP) Protocols" on page 191
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Understanding How HP Business Service Management Breaks
Down Transaction Response Times

When HP Business Service Management runs a Business Process Monitor
script and measures response time for a specific transaction, HP Business
Service Management collects breakdown data—information about TCP
activities during the transaction—for each request (component) of the
transaction. A TCP request (component) represents a sequence of
measurements starting with a DNS resolution, TCP Connect operation, or a
Send operation on an open connection and ending with the last Receive
operation for the relevant starting operation.

Because some TCP based protocols can use multiple connections, at any
given moment in time there can be an overlap in the various breakdown
categories.

Understanding Transaction Breakdown Categories for
Non-Web Based (TCP) Transactions

The transaction breakdown reports display a breakdown of average
transaction response times (in milliseconds) over time, for the selected time
frame. Response times are broken down by DNS resolution time, connection
time, time to first buffer, download time, and client time.

The diagram below illustrates the relationship between the report’s main
breakdown categories (shown along the bottom of the diagram) and TCP
client/server activity during transaction execution. In the diagram, there are
two sequential TCP requests included in the same connection.
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Note that client time is not shown in this diagram and is described in the
breakdown category table. For details, see "Client Time" on page 189.

Request Request
Server s - " T
Activity:
Client
Activity:
DNS Connect Send Receive Receive Receive Send Receive Receive
Lookup
- A — A
DNS Connection  Tima to Download Timeto  Download
Resolution Time first buffer Time first buffer Time
Time
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The following table describes the report’s breakdown categories, which
comprise a TCP request. Times are calculated by taking the average of all
transaction runs within the specified time period.

Name Description

DNS Resolution Displays the average amount of time needed to
resolve the DNS name to an IP address, using the
closest DNS server. The DNS Lookup measurement
is a good indicator of slow DNS resolution or other
problems with the DNS server.

Note: If the DNS resolution is adjacent to a Connect
for the same IP address, it is considered part of the
request (component) and its time is displayed in the
breakdown reports. Otherwise, the DNS resolutions
of one or more hosts without an adjacent Connect
are considered as a separate request (component). In
such cases, only the DNS Resolution time is
displayed for that request and for all other
measurements, a minus sign (-) is displayed.

Connect Time Displays the average amount of time needed to
establish an initial connection with the TCP server
performing the transaction. The connection
measurement is a good indicator of problems along
the network or whether the server is responsive to
requests.

Note: If a connection did not occur within a
request’s (component’s) context, a minus sign (-) is
displayed for the connection time in the breakdown
reports.
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Name

Description

Time to First Buffer

Displays the average amount of time that passes
from the first TCP Send up to and including the first
Receive of a component.

This measurement includes both network time and
server time that are required for handling the first
TCP buffer and therefore, it is a good indicator of
both network quality and server delay.

Note:

» This measurement is only shown if both Sends
and Receives are included in the request
(component).

» If there are no Sends or Receives within a request
(component), a minus sign (-) is displayed in the
breakdown reports.

Network Time to First
Buffer

Displays the time from the first Send up to and
including the last Send. This measurement is a good
indicator of network quality.

Note: This measurement is only shown if there are
Sends included in the request (component), but no
Receives.

Server Time to First Buffer

This measurement is only shown if there are Sends
included in the request (component), but no
Receives. A minus sign (-) is displayed in the
breakdown reports.
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Name Description

Download Time Displays the time from the receipt of the second
TCP buffer up to and including receipt of the last
byte.

Download time usually only includes network time
and is influenced by both network quality and
component size.

For more details, see "Understanding Time to First
Buffer and Download Time for Non-Web Based
(TCP) Transactions" on page 190.

Note: If a download did not occur within a request’s
(component’s) context, a minus sign (-) is displayed
for the download time in the breakdown reports.

Client Time Displays the average amount of time that passes
while a request is delayed on the client machine.
Client-related delays can include CPU think time,
processing time, time needed to open sockets, time
between the last Receive of a request and the first
Send of the next request in the same connection,
and so on.

Note: Client time is calculated by subtracting all
other measured times from the total transaction
time.

Note: Either Time to First Buffer or Network Time to First Buffer and Server
Time to First Buffer are displayed.
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Understanding Time to First Buffer and Download Time for
Non-Web Based (TCP) Transactions

Time to First Buffer includes both network time (for sending the packet) and
server time (for processing the packet), whereas Download time usually
includes only network time (for downloading the rest of the reply packets).
This means that if both Time to First Buffer and Download times increase, it
is a good indicator of network quality problems and if only Time to First
Buffer increases, it is usually a good indicator of server delay problems.

Understanding Breakdown Report Data for Non-Web Based
(TCP) Transactions

The same breakdown reports are used to display Web based breakdown data
and non-Web based (TCP) breakdown data, but the following differences
apply when viewing non-Web based (TCP) breakdown data:

» The Page column (which displays page names for Web based
transactions) is not applicable for non-Web based transactions and a
minus sign (-) is displayed in this column for all non-Web based
components.

» The Retry Time and SSL Handshake Time columns are not applicable for
non-Web based transactions and a minus sign (-) is displayed in these
columns for all non-Web based components.

» In the Component/Request column (which displays URLs for Web based
breakdown data), the name of the TCP request (component) is displayed.
The name can be one of the following:

» TCP_BdwnDns<nnn>. For DNS only components (for example, a DNS
component that does not have an adjacent Connect component
correlated to the same IP address). The number in the display is
sequentially incremented for each component entry. For such entries,
only the DNS Resolution time is displayed and for all other
measurements, a minus sign (-) is displayed.

» TCP_BdwnReqg<nnn>. For TCP request components. The number in
the display is sequentially incremented for each component entry.

» For non-Web based (TCP) components, there is no tooltip available for
the Page column.
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» You cannot click a non-Web based (TCP) component to drill down to
further information about it.

Notes and Limitation for Non-Web Based (TCP) Protocols

The following table lists the TCP protocols for which breakdown data can be
displayed, together with special notes and limitations where applicable:

Protocol Notes and Limitations

SAP GUI Multi-threaded protocol.

SMTP N/A

POP3 The communication in a POP3 script usually starts with a

server’s greeting message. Consequently, the first TCP
breakdown component (request) in the script is usually
reported with valid DNS and Connect times, whereas the
Download time is reported as O and all other time
measurements are not applicable and are shown with a minus
(-) sign in the reports.

IMAP The communication in an IMAP script usually starts with a
server’s greeting message. Consequently, the first TCP
breakdown component (request) in the script is usually
reported with valid DNS and Connect times, whereas the
Download time is reported as O and all other measurements
are not applicable and are shown with a minus (-) sign in the
reports.

Oracle 2-Tier Some of the steps in an Oracle 2-Tier script end with data
being sent by the client, without receiving any response.
Consequently, there are TCP breakdown components reported
with a Network Time to First Buffer value >= 0 and with all
other measurements not applicable and shown with a minus
(-) sign in the reports.

ODBC N/A

FTP Both FTP passive and FTP active modes are supported.
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Protocol

Notes and Limitations

LDAP

The last step in an LDAP script (which terminates the
connection to the server) usually ends with data being sent by
the client, without receiving any response. Consequently,
there is a corresponding TCP breakdown component reported
with a Network Time to First Buffer value >= 0 and with all
other measurements not applicable and shown with a minus
(-) sign in the reports.

EJB

Multi-threaded protocol.

RMI Java

» Multi-threaded protocol.
» Both RMI over I[IOP and RMI over JRMP are supported.

» Some Java applications which use the RMI protocol send
many ping requests between application-driven RMI calls.
Consequently, the TCP breakdown reports many
components with a small Time to First Buffer value and
with a Download size of approximately 1 byte.

» The last step in an RMI script (which terminates the
connection to the server) sometimes ends with data being
sent by the client, without receiving any response.
Consequently, there is a corresponding TCP breakdown
component reported with a Network Time to First Buffer
value >= 0 and with all other measurements not applicable
and shown with a minus (-) sign in the reports.
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Protocol

Notes and Limitations

Java
Record/Replay

» A protocol which supports and combines the following Java
protocols—RMI, CORBA, JMS, JACADA, and Custom Hooks.

TCP breakdown is supported only when the script is
recorded using RMI protocol calls. If the script includes
other protocol calls, TCP breakdown results are not defined.

» Multi-threaded protocol.
Both RMI over IIOP and RMI over JRMP are supported.

» Some Java applications which use the RMI protocol send
many ping requests between application-driven RMI calls.
Consequently, the TCP breakdown reports many
components with a small Time to First Buffer value and
with a Download size of approximately 1 byte.

\

» The last step in a Java Record/Replay script (which
terminates the connection to the server) sometimes ends
with data being sent by the client, without receiving any
response. Consequently, there is a corresponding TCP
breakdown component reported with a Network Time to
First Buffer value >= 0 and with all other measurements not
applicable and shown with a minus (-) sign in the reports.

Oracle NCA

If the script works over http communications, you can run it
using Web breakdown (which is the default).

If the protocol is run using TCP socket communications
instead of http, Web breakdown is not applicable and you can
run it using TCP breakdown instead, providing that:

» the script is recorded in such a way so that the Active Types
with which the script is recorded are Oracle NCA only (that
is, the script does not include WEB (http/html)).

» you move the Oracle NCA protocol from the
BdSupportedProtocols list to the
AdvancedTcpBdSupportedProtocols list in the agent1.cfg
file on the Business Process Monitor machine.
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Calculating Transaction Breakdown from Component
Breakdown

HP Business Service Management uses a weighted algorithm to display the
breakdown data that it collects. Every breakdown category for every element
of the connection requests is taken into consideration, and weight is given
to the element according to its value relative to the other elements in the
concurrent time period. For example, the Connect time for each request in
the connection is collected, weighted, and then displayed under the
Connect time category.
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WebTrace is a network diagnostics tool that provides traceroute information
to a specified destination. WebTrace records the route through the Internet
from your host machine to the destination Web server.

The WebTrace report provides information on network performance, which
helps you analyze application performance issues. For each destination, the
WebTrace report breaks down route time from the host machine to the

destination machine.

Run Web Trace

End time: 28M0/200917:19:43

Reachable: ‘Yes

Destination name:  www hp.com

Destination IP: 152174974

Source |P: 16.59.89.29

Found trip time: 218
Retries: 2

Mumber of hops: 25

—— A e e

Are amoars ane

wall

-

Hop Name Hop IP Hep Reachable Hop Retries Found Trip Time
- 1921184474 Yes 0 0
212199249 77 static.... | 212199.249.77 Yes 0 0
core-1 ptsusita-vi22.... 212199.26.39 Yes 0 0
- - Mo 2 0
EDGE.LOM-D2-RE1-s... BOA79.1685.21 Yes 0 78
- 6218914833 Yes 0 78
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To access

Use one of the following:

> Select Application page > Monitoring Status area.

Select a WebTrace and click the Run Task >3
button.

» Select Business Transaction Flow page > Tasks

area (or Tasks Included... area). Select a WebTrace
and click the Run Task I button.

Select a host in the Business Process Monitor tree,
click the Run button, and then click the Run

WebTrace & button. In the Run WebTrace
dialog box, enter the destination address, port
number, and timeout and then click Run.

Important information

» Business Process Monitor supports WebTrace over
TCP, UDP, and ICMP. By default, it is set to use
TCP. For details on changing the protocol, see
"Changing the Communication Protocol Used by
WebTrace" on page 264.

> Business Process Monitor is set to access a
maximum of 30 hops when using WebTrace to
reach a site. If 30 hops are not enough to reach
the site, it is reported as unreachable. For details
on changing the maximum number of hops, see
"Changing the Maximum Number of Hops for
WebTrace" on page 264.

General WebTrace Information Area

User interface elements are described below:

Ul Elements Description
End time The time that the WebTrace finished.
Reachable Whether it was possible to reach the destination

address.

Destination name

The destination Web address.

Destination IP

The IP address of the destination machine.
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Ul Elements

Description

Source IP

The IP address of the Business Process Monitor host
machine.

Round trip time

The time it takes, in milliseconds, for a packet of
data to be sent from the host machine to the
destination Web site.

Retries

The number of times a data packet tries, but fails, to
reach its destination due to timeout, network
difficulty, and so forth.

Number of hops

The number of intermediate servers the data packet
encounters before it reaches its destination.

Hop Information Table

User interface elements are described below:

Ul Elements Description
Hop Name The name of the intermediate server.
Hop IP The IP address of the intermediate server.

Hop Reachable

Whether it was possible to reach the specific hop.

Hop Retries

The number of times a data packet tries, but fails, to
reach an intermediate server due to timeout,
network difficulty, an so forth.

Round Trip Time

The time, in milliseconds, from the source to the
specific hop and back.
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Run Schedules and Orders

This chapter includes:

» Run Schedules and Orders Overview on page 200
» Run Units on page 200

» Schedules on page 202

» Start Offset on page 204

» Run Modes on page 207
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Run Schedules and Orders Overview

Run Units

200

You can configure how often and when a run unit (an application or
business transaction flow) is run on a Business Process Monitor instance by
setting schedules and start offsets. You can also determine the order in
which the tasks (scripts and WebTraces) included in a run unit are run by
setting run modes.

A run unit is an application, or a business transaction flow with its own
schedule, and all the entities contained within it. By default, business
transaction flows are included in their parent application’s run unit (using
the same schedule and run mode), but you can configure different schedules
and run modes for individual business transaction flows. If a business
transaction flow has its own schedule, it is not included in the application
run on the Business Process Monitor instance, but is run as an independent
unit.

The following diagram shows the run units for a Business Process Monitor
instance that includes two applications. The first application (Application 1)
includes one application level WebTrace and three business transaction
tlows (BTF1, BTF2, BTF3). BTF1 includes one script and one WebTrace, BTF2
includes one script and has its own schedule, and BTF3 contains one script
and one WebTrace. Since BTF2 has its own schedule, it is considered as a
separate run unit from the application.

The second application (Application 2) includes two business transaction
flows (BTF4 and BTFS5). BTF4 and BTFS each include one script, and BTFS5
has its own schedule. Since BTF5 has its own schedule, it is considered as a
separate run unit from the application.
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Since each application is a separate run unit, there are a total of four run
units in the Business Process Monitor instance—Application 1, BTF2, BTES,
and Application 2.

BPM Data
Collector
Instance

————ft———————— }
| 27
| | Application 2 4""‘ :
|
| |
| |
| [
| |
| |BTF 4 |
| |
| — |
| | Script 4 |
| |
[__ﬁ ______ i
I |BTES |Schedule |
| 3 |
I i
fm=——==- == : Script 5 |
|

Legend

____________ Run unit 1 - Application 1 [
Run unit 2 - BTF2 [l
Run unit 3 -BTF 5 D

Run unit 4 — Application 2 |:|
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Schedules

202

Each run unit (an application or business transaction flow) running on a
Business Process Monitor instance runs according to a schedule defined in
End User Management Administration (for details, see Using End User
Management, part of the HP Business Service Management Documentation
Library). Each application or business transaction flow can also have
multiple schedules defined for it, as described in "Multiple Schedules" on
page 203.

The schedule defines the frequency of iterations of the run unit after its first
run. The actual run time of the run unit is determined by the start offset
value configured for it, which specifies the delay between the run unit
schedule time and the run time, as described in "Start Offset" on page 204.

Note that if a run unit run overruns the scheduled time for the next run
iteration, then Business Process Monitor skips the missed iteration and
continues with the next scheduled iteration. For example, if an application
schedule is set to run every 5 minutes, and the application run actually takes
6 minutes, then Business Process Monitor runs iteration 1, skips iteration 2,
and continues with iteration 3 (10 minutes after the first iteration).

Information on skipped runs is logged in the agent.txt log for the Business
Process Monitor instance.
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Multiple Schedules

In End User Management Administration, you can define multiple
schedules for an application or business transaction flow running on a
specific Business Process Monitor instance. This enables you to have the
application or business transaction flow run on Business Process Monitor
using different schedules at different times. For example, you can have an
application run every 15 minutes during the working week and every hour
during weekends.

When a run unit has multiple schedules defined for it, each schedule (and
its start offset value) is shown in the Schedule List area on the corresponding
Application or Business Transaction Flow page.

Note: If the multiple schedules for a run unit overlap, then Business Process
Monitor runs the run unit according to both schedules. If a run unit run
(initiated according to one of the schedules) overruns the scheduled time of
a run iteration according to the second schedule, then Business Process
Monitor skips the second iteration, and continues with the next scheduled
iteration. Information on skipped runs is logged in the agent.txt log for the
Business Process Monitor instance.
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Start Offset
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HP Business Service Management enables you to apply an offset to the start
time of each run of a run unit (application or business transaction flow).
This enables the optimal distribution of script runs over time, and
minimizes the parallel running of many scripts (when there are different
Business Process Monitor hosts running the same run unit). Staggering the
runs provides a more even distribution of the workload, avoiding overload
on the monitored server and excessive bandwidth demand, and enabling
better utilization of machine CPU and memory.

Note: It is recommended not to change the default start offset as this may
reduce Business Process Monitor performance and adversely affect the
optimal distribution of tasks.

The start offset value, displayed in the Schedule List area on the Application
or Business Transaction Flow page, specifies the delay between the run unit
schedule time and the actual run time, for each run of the run unit. The
start offset for each application can be calculated automatically by Business
Process Monitor, or can be user-defined; you determine the method and
value when defining the application or business transaction flow schedule.
When the start offset is configured manually, you can avoid the possibility
that run units running on more than one Business Process Monitor run at
the same time.

After the initial run, Business Process Monitor continues to run the run unit
according to the original schedule defined for the application or business
transaction flow (in End User Management Administration), and reapplies
the start offset for every run of the run unit.

For example, an application has a start offset value of 120 seconds, and a
schedule of every 15 minutes, every day from 10:00 to 16:00. Each day, the
first run of the application begins after the start offset, at 10:02 AM. The
next run is 15 minutes later, at 10:17 AM, and repeats every 15 minutes after
that till the end of the day’s schedule.
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Note:

» For schedules that run all day, all week, the start offset is applied from
00:00 AM, so that for a schedule of 15 minutes and start offset of 120
seconds, the run unit (application or business transaction flow) runs at
15 minute intervals from 00:02 AM.

» If you define multiple schedules to run an application or business
transaction flow on a single Business Process Monitor, a different start
offset value may be used for each schedule. For more information, see
"Multiple Schedules" on page 203.

» When you configure offsets for running applications or business
transaction flow on Business Process Monitors in different locations, you
must take into consideration the time zone setting for each location.

There are two methods for staggering the run start time:

» "User-Defined Start Offset" on page 205

» "Start Offset Determined by Business Process Monitor" on page 206

User-Defined Start Offset

When defining an application or business transaction flow schedule (in End
User Management Administration), you have the option to select User
defined for the start offset, and enter a start offset value.

The start offset value is saved as part of the application or business
transaction flow schedule data, and applied by each Business Process
Monitor that handles the run unit. If a Business Process Monitor is restarted,
the same offset value is applied again for the run unit.

If you define the start offset value as O, then no offset is applied for the run
unit in Business Process Monitor; the run unit run starts at the time
specified in the application or business transaction flow schedule.
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Note: It is recommended not to override the default setting in general, and
specifically not to set an offset of 0, as this can impact Business Process
Monitor performance and adversely affect the distribution of script runs.

Start Offset Determined by Business Process Monitor

Business Process Monitor is able to generate start offset values for run units,
so enabling staggered run times for the run units. Start offset values are
allocated to all applications and business transaction flows that have BPM
default defined for their schedule start offset in End User Management
Administration.

The start offset is calculated when the run unit is initialized. The calculation
takes into account all existing start offset values for the run units on the
machine; this includes start offset values that were defined in End User
Management Administration, and the start offset values of active
applications or business transaction flows. Business Process Monitor
analyses where there is the lowest concentration of offsets over the
distribution period, and allocates a start offset value in that area. The start
offset value is always smaller than the schedule interval defined for the
application or business transaction flow.

Business Process Monitor uses an algorithm to calculate the dispersal rate,
and to allocate start offset values to the run units in a balanced and
semi-random manner. The random factor means that when there are two or
more Business Process Monitor instances running the same application or
business transaction flow with the same schedule, each instance runs the
run unit at a different time. (If there was no random factor, each Business
Process Monitor instance would run the run unit at exactly the same time.)
The random factor does not change the order that the applications or
business transaction flows run, and the interval between each run of the run
unit on each Business Process Monitor instance remains constant. For
example, on Business Process Monitor A an application may run at 10:03,
10:20, 10:35, and on Business Process Monitor B it may run at 10:10, 10:25,
10:40.
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The algorithm calculation includes a distribution period value. This value is
set by default to one hour, which is an optimum value if the most common
schedule used for your applications or business transaction flows is every 15
minutes (the default schedule option when defining applications or
business transaction flows in End User Management Administration), and
all schedule intervals are less than an hour.

The default distribution period also functions if you are commonly using
other schedule intervals for your applications or business transaction flows;
however, if you would like to optimize the dispersion of the start offset
values for your application or business transaction flow schedules, or if you
experience load problems on the machine, you can change the default
distribution value in order gain maximum efficiency. For information on
changing the distribution value (OffsetDistPeriodSec), see "Parameters in
agentl.cfg" on page 226.

Note that if Business Process Monitor is restarted, it calculates new start
offset values for the run units (except for applications or business
transaction flows that have user-defined values from their schedule).

Run Modes

The Monitoring Status area of the Application or business transaction flow
page shows the running dependencies for the scripts and WebTraces in the
application or business transaction flow. This identifies the order that
Business Process Monitor uses when executing each script and WebTrace in
the run unit, during each run on the Business Process Monitor instance.

The order and timing for running the tasks (scripts and WebTraces) within
the run unit are determined by the application or business transaction flow
run mode. The application or business transaction flow run mode
determines how Business Process Monitor runs the tasks in a run unit when
it begins an iteration. Some of the run modes run the tasks in a specific
order according to predefined criteria; in this case, the scripts run in the
order defined in the application or business transaction flow.
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Both the run mode and the script order are defined for the application or
business transaction flow in End User Management Administration (see
Using End User Management, part of the HP Business Service Management
Documentation Library).

Note: It is recommended only to change the default run modes when
specifically needed. Some non default run mode configurations may
adversely affect Business Process Monitor performance.

The following run modes are supported and the examples shown are based
on the following run unit configuration:

Application 1
Application Level Business Transaction Flows
WebTraces
WT1 BTF1 BTF2 BTF3
WT2 WT3 WTS WT6
WT4 Script 4 Script §
Script 1 Script 6
Script 2
Script 3

208



Chapter 12 ¢ Run Schedules and Orders

Classic

All scripts in the run unit run sequentially, according to the order defined in
End User Management Administration. All WebTrace schemes in a business
transaction flow start running concurrently with the first script of the
business transaction flow. Application level WebTraces start running
concurrently with the first script of the first business transaction flow.

Run Order Example

Each column (from left to right) represents the next stage in the running
order.

1 2 3 4 5 6

BTF1 and Application Level WebTraces | BTF2 BTF3

Script 1 Script 2 Script 3 Script 4 Script 5 Script 6
WT1 WTS WT6

WT2

WT3

WT4

The tasks included in a business transaction flow start running, regardless of
whether or not previously run WebTraces have finished running. For
example, BTF2 (Script 4 and WTS) starts running after Script 3 finishes
running, regardless of whether or not the WebTraces (WT1-WT4) have
finished running.
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Dialup

If a run unit has two or more scripts, the first script begins running when
the run unit begins an iteration. When the first script completes its run, all
WebTrace schemes and scripts, excluding the first and last scripts, run in
Classic mode. When all tasks stop running, the last script runs. If a run unit
has fewer than two scripts, it runs in Classic mode.

Note:

» If the first script in the run unit (the connect script) does not complete its
run successfully, the rest of the scripts in the unit will not run.

» If the first script completes its run, the last script always runs.

» An application running in dialup mode must contain a business
transaction flow that includes only a hang up script (that is, it must not
include any other scripts or WebTraces). This business transaction flow
must be the last one in the application.

Run Order Example

Each column (from left to right) represents the next stage in the running
order.

1 2 3 4 5 6
BTF1 BTF2 BTF3
First Last
Application Application
Script Script
Script 1 Script 2 Script 3 Script 4 Script 5 Script 6
WT1 WTS WT6
WT2
WT3
WT4
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Sequential

All run unit tasks run sequentially (with only one task running at a time).
The script tasks run according to the order defined in End User Management
Administration. WebTrace tasks run after the last script is completed, with
an undefined (though consistent) order.

Run Order Example

Each column (from left to right) represents the next stage in the running
order.

1 2 3 4 5 6 7 8 9 10 | 11 | 12

BTF1 BTF2 BTF3 All WebTraces (application and
business transaction flow
levels)

Script Script Script Script Script Script WT | WT | WT | WT | WT | WT

1 2 3 4 5 6 1 2 3 4 5 6
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Concurrent

All tasks begin running simultaneously when the run unit begins an
iteration. (This is the same as selecting Stepped run mode and setting the
Step value as 0.)

Run Order Example

Each column (from left to right) represents the next stage in the running
order.

1

BTF1

BTF2

BTF3

All WebTraces (application and
business transaction flows)

Script 1

Script 2

Script 3

Script 4

Script 5

Script 6

WT1

WT2

WT3

WT4

WTS

WT6
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Stepped

Each task begins running after a defined time period (step) has passed from
the time the previous task started. In this case, the Running Dependencies
column in the Business Process Monitor Admin Application or Business
Transaction Flow page displays, for example: 5 seconds after the beginning of
the following task: X_transaction, meaning that the task runs only after a step
of 5 seconds has elapsed since X_transaction task started running. The scripts
run according to the order defined in End User Management
Administration. All WebTrace tasks (on both application and business
transaction flow levels) also run in stepped mode after the last script has
started, in an undefined (though consistent) order.

Run Order Example

BTF1

BTF2

BTF3

All WebTraces

Script 1

[step] Script 2

[step] Script 3

[step] Script 4

[step] Script 5

[step] Script 6

[step] WT1

[step] WT2

[step] WT3

[step] WT4

[step] WTS

[step] WT6H
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13

Business Process Monitor Configuration
Files

This chapter includes:

» About Business Process Monitor Configurable Options on page 216
» Parameters in topaz_agent_ctrl.cfg on page 218

» Parameters in agentl.cfg on page 226

» Parameters in topaz_data_server.cfg on page 236

» Parameters in sconn.cfg on page 247
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About Business Process Monitor Configurable Options

216

The Business Process Monitor configuration files define default parameter
values that are used for Business Process Monitor functioning. Some of these
values can be changed within the configuration files, while other parameter
values should only be changed using Business Process Monitor Admin, or
should not be changed at all. Not all of the parameters automatically appear
in the configuration files, but can be added manually if you want to override
the default value used by Business Process Monitor.

To change parameter values within a configuration file:

1

QA AW

Stop Business Process Monitor.

For Windows Vista, Windows 2008, and Windows 7, copy the
configuration file to a user temp folder (Yotemp%).

Open the configuration file in a text editor.
Modify the value of the parameter as required.
Save the file and restart Business Process Monitor.

For Windows Vista, Windows 2008, and Windows 7, copy the file back to
its original location.

Note: When working on a Windows platform in languages other than
English, do not edit and save configuration files in Notepad. Saving
configuration files in UTF-8 format in Notepad may cause severe
functionality problems in Business Process Monitor.
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The Business Process Monitor configuration files are located in the <Business
Process Monitor application directory>\config directory. The default Business
Process Monitor application directory is:

» Windows 2003 and Windows XP
C:\Documents and Settings\All Users\Application Data\HP\BPM
» Windows Vista, Windows 2008, and Windows 7
C:\ProgramData\HP\BPM
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Parameters in topaz_agent_ctrl.cfg

The <Business Process Monitor application directory>\config\

topaz_agent_ctrl.cfg file, which controls communication between the
Gateway Server and Business Process Monitor, contains the following

<Business Process Monitor
Workspace directory>\
commcenter\ commcenter.txt
log file size (in kilobytes).

parameters:
Section Parameter Description Default Value (P11 40
Value

commcenter |DisableSubLogs |Instructs Business Process 0 The value can
Monitor on whether to create be changed in
the commcenter_Site#.txt logs the
for the instance. topaz_agent_
The following two options are ctrl.cfg file.
available:
» 0 - the logs are created
» 1 - the logs are not created

commcenter |LogMaxSize Determines the maximum 5120 kilobytes The value can

be changed in
the
topaz_agent_
ctrl.cfg file.
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Changing the

Section Parameter Description Default Value vV
alue
commcenter |LogLevel Instructs Business Process Flow The value can
Monitor to log only entries of be changed in
the specified level or higher to the
the commcenter.txt file. The topaz_agent_
following levels exist: ctrl.cfg file.
» fatal
» error
> warning
> flow
» debug
If this parameter is set to debug,
all entries are logged; if the
parameter is set to flow, all
entries aside from debug are
logged; if the parameter is set to
warning, both the flow and
debug entries are not logged,
and so forth.
commcenter | LogNumOf Determines the number of log |5 The value can
Backups history files to keep. be changed in
the
topaz_agent_
ctrl.cfg file.
commcenter |LogBackupOn Instructs Business Process True The value can
Open Monitor to back up the existing be changed in
commcenter.txt log file when the
opening a new log file. topaz_agent_
ctrl.cfg file.
commcenter |LogBackupOn Instructs Business Process True The value can
MaxSize Monitor to back up the be changed in

commcenter.txt log file when it
reaches its defined maximum
size.

the
topaz_agent_
ctrl.cfg file.
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Changing the

with HP Business Service
Management to re-register
itself.

Section Parameter Description Default Value V
alue
commcenter |LogBackup Determines the duration (in 168 hours The value can
Duration hours) for which the backups of be changed in
the commcenter.txt log file are the
kept. topaz_agent_
ctrl.cfg file.

HTTPSender |HTTPSender The timeout, in seconds, for 600 seconds Do not change

TimeoutSec http requests to HP Business this value.
Service Management.

General HostVersion The version of Business Process | <Business Do not change
Monitor installed on the Process this value.
machine. Monitor

version>

General UserDomain The domain of the user thatis |"" The value can
to run all the Business Process be changed in
Monitor processes, if they are to Business
be run by a specific user. Process

Monitor
Admin.

General UserPasswd The encrypted password of the | " The value can
user that is to run all the be changed in
Business Process Monitor Business
processes, if they are to be run Process
by a specific user. Monitor

Admin.

General UserName The name of the user thatisto |"" The value can
run all the Business Process be changed in
Monitor processes, if they are to Business
be run by a specific user. Process

Monitor
Admin.
General RegistrationHour | The interval at which Business |12 hours Do not change
Interval Process Monitor communicates this value.
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Changing the

Section Parameter Description Default Value vV
alue
General Workspace The directory in which the For Windows: If you want to
Business Process Monitor work |<Business Process | change the
files are stored. Monitor location of all
Note that if you change this application logs under the
value, only some of the log files | directory>\ Workspace
under the Workspace directory | Workspace directory, see
are moved to the new path (logs "Moving the
in commcenter and agent1 Workspace
directories), not all. Logs" on
page 256.
Site# SiteURL The HP Business Service <HP Business The value can
Management URL. Service be changed in
Management Business
URL> Process
Monitor
Admin.
Site# JobPoll The interval, in minutes, 2 minutes The value can
between requests to be changed in
HP Business Service Business
Management for job updates. Process
Monitor
Admin.
Site# TimePoll The interval, in minutes, 60 minutes The value can
between requests to the be changed in
Gateway Server to retrieve Business
Business Service Management’s Process
time. Monitor
Admin.
Site# SiteVersion The HP Business Service <HP Business Do not change

Management version.

Service
Management
version>

this value.
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Changing the

instance displayed in the
Business Process Monitor
Admin table and tree.

Section Parameter Description Default Value V

alue

Site# UserName The name of the user thatisto |"" The value can
run the instance’s transactions, be changed in
if these are to be run by a Business
specific user. Process

Monitor
Admin.

Site# UserPasswd The encrypted password of the |"" The value can
user that is to run the instance’s be changed in
transactions, if these are to be Business
run by a specific user. Process

Monitor
Admin.

Site# UserDomain The domain of the user thatis |" The value can
to run the instance’s be changed in
transactions, if these are to be Business
run by a specific user. Process

Monitor
Admin.

Site# HostLocation The location defined for the <Business Process | You can
host machine. This is a logical | Monitor override the
location that is used by Business | machine location using
Process Monitor for registration |location> the Location
to HP Business Service Manager in
Management. Business
The default value is the name of Service
the Business Process Monitor Management.
host machine. Once

overridden,
this value is
redundant.

Site# DisplayName The name of the default <display name> |The value can

be changed in
Business
Process
Monitor
Admin.
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Changing the

Section Parameter Description Default Value
Value

Site# Hostld The ID allocated by Business <Business Process | Do not change
Service Management for this Monitor this value.
specific Business Process machine ID>
Monitor instance.

Site# Pause Instructs Business Process 0

Communication | Monitor to stop (no pause)
communication to HP Business
Service Management. When the
value of this parameter is O,
communication with
HP Business Service
Management is enabled; when
the value is 1, communication
is stopped.

Site# Locationld The ID allocation by the <Business Process | Do not change
Location Manager in Business Monitor this value.
Service Management for this machine
specific Business Process location ID>
Monitor instance.

Site# HostName The name defined for the host |<BusinessProcess | The value can
machine. This is a logical name | Monitor be changed in
that is used by Business Process | machine name> |Business
Monitor for registration to Process
HP Business Service Monitor
Management. Admin.

The default value is the actual
name of the Business Process
Monitor host machine.
Site# Pause Instructs Business Process 0 Do not change
Measurements Monitor to stop running (no pause) this value.

transactions and WebTrace
schemes. The following two
options are available:

» 0 - no pause

» 1 - pause
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Section

Parameter

Description

Default Value

Changing the
Value

Site#

TimeDelta

The difference, in seconds,
between Gateway Server site
time and Business Process
Monitor time.

<time
difference>

Do not change
this value.

Site#

ForceVersion

Instructs the Business Process
Monitor instance to behave as
though it is connected to the
HP Business Service
Management version set in the
SiteVersion parameter, and
ignore the version returned by
HP Business Service
Management itself.

The following two options are
available:

» 0 - do not force (use version
returned by HP Business
Service Management)

» 1 - force (use the version
defined in SiteVersion)

Note that ForcelLegacy can

still be set, as it only affects

communication, and not the
rest of the behavior.

0 (do not force)

Consult HP
Software
Support if you
want to
change this
value.

Site#

HostIPFor
Registration

Sets a specific IP address to be
used when the Business Process
Monitor instance is registered
to HP Business Service
Management. For example, if
the Business Process Monitor
machine has more than one
network card, you can specify
which card to use when
registering the Business Process
Monitor instance.

<Business Process
Monitor
machine default
IP address>

The value can
be changed in
the
topaz_agent_
ctrl.cfg file.
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Changing the

Section Parameter Description Default Value
Value
Agentl DisplayName The name of the Business <Business Process | Do not change
Process Monitor machine. Monitor this value.
machine name>
Agents Agentl The list of Business Process <sitel, site2,...> |Donotchange

Monitor instances.

this value.
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Parameters in agent1.cfg

The <Business Process Monitor application directory>\config\agent1.cfg
tile, which controls Business Process Monitor behavior, contains the following

profiles can run concurrently.
» A value other than 0 - The
number specified is the
maximum number of profiles
that can run concurrently.

parameters:
Section Parameter Description Default Value (G i) Ui
Value
general TaskTimeout Determines the amount of time |15 minutes The value can
Minutes after which Business Process be changed in
Monitor times out all scripts the agentl.cfg
and WebTrace schemes that are file.
still running.
general Concurrent Determines the number of 0 The value can
Profiles profiles that can be run (an unlimited be changed in
con'currently. Tbe following number of tbe agentl.cfg
options are available: profiles can run file.
» 0 - An unlimited number of |concurrently.)
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Section

Parameter

Description

Default Value

Changing the
Value

general

GlobalRun
Handler

The run mode Business Process
Monitor allocates when the run
mode is not previously defined
for the profile. The run mode
determines how Business
Process Monitor runs the tasks
in a profile when the profile
begins an iteration.

For an explanation of the run
modes, see "Run Modes".

The following options are
available:

» Classic

» Dialup

» Sequential

» Concurrent

Classic

The value can
be changed in
the agentl.cfg
file.

general

Webreplay
Concurrent
Connection
Backward
Compatible

Determines the WebReplay
behavior for the VuGen scripts.
The following options are
available:

» Auto - Scripts created in
VuGen 7.5 and below use old
WebReplay behavior and
scripts created in VuGen 7.6
and higher use new
WebReplay behavior.

» Always — scripts always use
old WebReplay behavior.

» Never - scripts always use
new WebReplay behavior.

Auto

The value can
be changed in
the agentl.cfg
file.
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Changing the

Section Parameter Description Default Value
Value
general AdjustSchedule |Determines whether time true The value can
ToDST settings in Business Process be changed in
Monitor are adjusted for the agentl.cfg
Daylight Savings Time (DST). file.
The following options are
available:
» 1 or true - times are adjusted
for DST.
> 0 or false — times are not
adjusted for DST.
general SaveHistoricLRW | If a script is configured to 0 The value can

Files

generate a logfilewrite log, this
parameter determines whether
to save only the current
logfilewrite log file for the
script, or to save previous
logfilewrite log files as well.

The following options are
available:

» 1 - historical files are saved.

» 0 - historical files are not
saved.

Historical logfilewrite log files
must be deleted manually. To
avoid unnecessary use of disk
space, delete old files and reset
the parameter to O when not
needed.

be changed in
the agent1.cfg
file.
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Section

Parameter

Description

Default Value

Changing the
Value

general

SendSOEToBAC

Determines whether to send
Snapshot on Error data to

HP Business Service
Management, or to store it
locally on the Business Process
Monitor machine.

The following options are
available:

» 1 - never send snapshots to
HP Business Service
Management.

» 2 - always send snapshots to
HP Business Service
Management.

» 3 —use the script
configuration to determine
whether or not to send
snapshots to HP Business
Service Management.

The value can
be changed in
the agentl.cfg
file.

general

SendRumBeacon

Adds a special header to
network requests created by
scripts with protocols from the
ColoringSupportedProtocols
parameter. The header enables
the Real User Monitor probe to
distinguish between synthetic
user data and real user data.

false

The value can
be changed in
the agentl.cfg
file.
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Changing the

Monitor on whether to create
the agent_Site#.txt logs for the
instance.

The following two options are
available:

» 0 - the logs are created.
» 1 - the logs are not created.

Section Parameter Description Default Value
Value
Offset OffsetDistPeriod | Determines the offset 3600 seconds The value can
Distributer Sec distribution period (in seconds) be changed in
used by the algorithm that the agentl.cfg
calculates the start offset for the file.
run of each profile.
The value can be from 4 to
86400 seconds.
For more information, see
"Optimizing Run Unit
Scheduling" on page 259.
agent DisableSubLogs | Instructs Business Process 0 The value can

be changed in
the agent1.cfg
file.
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Changing the

Section Parameter Description Default Value V
alue
agent LogLevel Instructs Business Process Flow The value can
Monitor to log only entries of be changed in
the specified level or higher in the agentl.cfg
the <Business Process Monitor file.
application directory>\
Workspace\ agent1\agent.txt
file. The following levels exist:
> fatal
» error
> warning
> flow
» debug
If this parameter is set to debug,
all entries are logged; if the
parameter is set to flow, all
entries aside from debug are
logged; if the parameter is set to
warning, both the flow and
debug entries are not logged,
and so forth.
agent LogBackupOn Instructs Business Process True The value can
Open Monitor to back up the existing be changed in
agent.txt log file when opening the agentl.cfg
a new log file. file.
agent LogBackupOn Instructs Business Process True The value can
MaxSize Monitor to back up the be changed in
agent.txt log file when it the agent1.cfg
reaches its defined maximum file.
size.
agent LogMaxSize Determines the maximum 5120 kilobytes The value can

agent.txt log file size (in
kilobytes).

be changed in
the agentl.cfg
file.

231




Chapter 13 e Business Process Monitor Configuration Files

Changing the

agent_Site#.txt log file when
opening a new log file.

Section Parameter Description Default Value vV
alue
agent LogBackup Determines the duration (in 168 hours The value can
Duration hours) for which the backups of be changed in
the agent.txt log file are kept. the agent1.cfg
file.
agent LogNumOf Determines the number of log |5 The value can
Backups history files to keep. be changed in
the agentl.cfg
file.
Agent_Site# |LogLevel Instructs Business Process Flow The value can
(This section Monitor to log only entries of be changed in
can be the specified level or higher in the agentl.cfg
manually the <Business Process Monitor file.
added to set application directory>\
the log Workspace\ . .
parameters agent1\agent_Site#.txt file.
for each The following levels exist:
instance.) » fatal
> error
> warning
> flow
» debug
If this parameter is set to debug,
all entries are logged; if the
parameter is set to flow, all
entries aside from debug are
logged; if the parameter is set to
warning, both the flow and
debug entries are not logged,
and so forth.
Agent_Site# |LogBackupOn Instructs Business Process True The value can
Open Monitor to back up the existing be changed in

the agentl.cfg
file.
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Changing the

Section Parameter Description Default Value
Value
Agent_Site# |LogBackupOn Instructs Business Process True The value can
MaxSize Monitor to back up the be changed in
agent_Site#.txt log file when it the agentl.cfg
reaches its defined maximum file.
size.

Agent_Site# |LogMaxSize Determines the maximum 5120 kilobytes The value can
agent_Site#.txt log file size (in be changed in
kilobytes). the agentl.cfg

file.

Agent_Site# |LogBackup Determines the duration (in 168 hours The value can

Duration hours) for which the backups of be changed in
the agent_Site#.txt log file are the agentl.cfg
kept. file.

Script ScriptLauncher | Determines the protocol 0 Do not change

Launcher UseTCP through which Business Process (shared memory) this value.
Monitor communicates with
the scripts. The following
options are available:

» 1 -TCP protocol
» 0 - shared memory

Script ScriptLauncher | Determines whether the end of |0 Do not change

Launcher SyncEnd a script run is synchronized (no this value.
with the end of a Business synchronization)

Process Monitor process. The
following options are available:
» 1 - there is synchronization.

» 0 - there is no
synchronization.
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Changing the

requests sent to an application
monitored by HP Diagnostics or
TransactionVision.

If the protocol replay run by the
Business Process Monitor is
changed, and contains an http-
based protocol that is not
included in this parameter, the
protocol can be added to the
list, separated by a comma.

There should be no reason to
remove protocols from the list.

(that is, those
using http)

Section Parameter Description Default Value
Value
Protocols BdSupported List of Web based protocols that | A list of Do not change
Protocols Business Process Monitor can applicable this value
run with the breakdown option. | protocols
Business Process Monitor runs a
script with the breakdown
option provided the script type
is included in this setting.
If a script contains multiple
protocols, it runs with the
breakdown option provided
that one of the protocols is
included in this setting.
Protocols Snapshot Determines for which protocols | A list of the Do not change
Supported HP Business Service applicable this value
Protocols Management supports Snapshot | VuGen protocols
on Error.
Protocols Coloring Determines for which protocols | A list of all the | The value can
Supported Business Process Monitor Web-based be changed in
Protocols transactions are colored for Vugen protocols |the agent1.cfg

file.
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Changing the

Section Parameter Description Default Value
Value
Protocols AdvancedTcpBd | List of non-Web based protocols | A list of Do not change
Supported that Business Process Monitor |applicable this value
Protocols can run with the TCP advanced | protocols

breakdown option.

Business Process Monitor runs a
script with the TCP advanced
breakdown option provided the
script type is included in this
setting.

If a script contains multiple
protocols, it runs with the TCP
advanced breakdown option
provided that one of the
protocols is included in this
setting and none of the
protocols is included in the
BdSupportedProtocols setting
(in which case, the regular
breakdown option is used).

Note: For notes and limitations
about the non-Web based
protocols, see "Notes and
Limitation for Non-Web Based
(TCP) Protocols" on page 191.
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Parameters in topaz_data_server.cfg

The <Business Process Monitor application directory>\config\

topaz_data_server.cfg file, which controls the transmission of data from
Business Process Monitor to the Gateway Server, contains the following

parameters:
Section Parameter Description Default Value irtiing) 4
Value

data_depot |DisableSubLogs |Instructs Business Process 0 The value can
Monitor on whether to create be changed in
the data_depot_Site#.txt logs for the topaz_
the instance. data_server.cf
The following two options are g file.
available:
» 0 - the logs are created
» 1 - the logs are not created

data_depot |LogLevel Instructs Business Process Flow The value can

Monitor to log only entries of
the specified level or higher in
the <Business Process Monitor
application directory>\
Workspace\ agent1\data\
data_depot.txt file. The
following levels exist:

» fatal

> error

>» warning
> flow

» debug

If this parameter is set to debug,
all entries are logged; if the
parameter is set to flow, all
entries aside from debug are
logged; if the parameter is set to
warning, both the flow and
debug entries are not logged,
and so forth.

be changed in
the topaz_
data_server.
cfg file.
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Changing the

Section Parameter Description Default Value V
alue
data_depot |LogBackupOn Instructs Business Process True The value can
Open Monitor to back up the existing be changed in
data_depot.txt log file when the topaz_
opening a new log file. data_server.
cfq file.
data_depot |LogBackupOn Instructs Business Process True The value can
MaxSize Monitor to back up the be changed in
data_depot.txt log file when it the topaz_
reaches its defined maximum data_server.
size. cfg file.
data_depot |LogMaxSize Determines the maximum 5120 kilobytes The value can
data_depot.txt log file size (in be changed in
kilobytes). the topaz_
data_server.
cfg file.
data_depot |LogBackup Determines the duration (in 168 hours The value can
Duration hours) for which the backups of be changed in
the data_depot.txt log file are the topaz_
kept. data_server.
cfg file.
data_depot | LogNumOf Determines the number of log |5 The value can
Backups history files to keep. be changed in

the topaz_
data_server.
cfg file.
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Section

Parameter

Description

Default Value

Changing the
Value

data_depot

ReportAndForget

Determines whether failed
reports are resent to HP Business
Service Management. The
following two options are
available:

» True - Failed reports are
ignored and not resent to
HP Business Service
Management.

» False — Business Process
Monitor tries to resend failed
reports to HP Business
Service Management.

False

Do not change
this value.

soadata

LogLevel

Instructs Business Process
Monitor to log only entries of
the specified level or higher in
the <Business Process Monitor
application directory>\
Workspace\ agent1\data\
clients\soadata.txt file. The
following levels exist:

» fatal

» error

> warning
> flow

» debug

If this parameter is set to debug,
all entries are logged; if the
parameter is set to flow, all
entries aside from debug are
logged; if the parameter is set to
warning, both the flow and
debug entries are not logged,
and so forth.

Flow

The value can
be changed in
the topaz_
data_server.
cfg file.
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Changing the

Section Parameter Description Default Value V
alue
soadata LogBackupOn Instructs Business Process True The value can
Open Monitor to back up the existing be changed in
soadata.txt log file when the topaz_
opening a new log file. data_server.
cfq file.
soadata LogBackupOn Instructs Business Process True The value can
MaxSize Monitor to back up the be changed in
soadata.txt log file when it the topaz_
reaches its defined maximum data_server.
size. cfg file.
soadata LogMaxSize Determines the maximum 5120 kilobytes The value can
soadata.txt log file size (in be changed in
kilobytes). the topaz_
data_server.
cfg file.
soadata LogBackup Determines the duration (in 168 hours The value can
Duration hours) for which the backups of be changed in
the soadata.txt log file are kept. the topaz_
data_server.
cfg file.
soadata LogNumOf Determines the number of log |5 The value can
Backups history files to keep. be changed in

the topaz_
data_server.
cfg file.
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Changing the

Section Parameter Description Default Value vV
alue
transdata LogLevel Instructs Business Process Flow The value can
Monitor to log only entries of be changed in
the specified level or higher in the topaz_
the <Business Process Monitor data_server.
Workspace directory>\agent1\ cfg file.
data\ clients\transdata.txt file.
The following levels exist:
> fatal
» error
> warning
> flow
» debug
If this parameter is set to debug,
all entries are logged; if the
parameter is set to flow, all
entries aside from debug are
logged; if the parameter is set to
warning, both the flow and
debug entries are not logged,
and so forth.
transdata LogBackupOn Instructs Business Process True The value can
Open Monitor to back up the existing be changed in
transdata.txt log file when the topaz_
opening a new log file. data_server.
cfg file.
transdata LogBackupOn Instructs Business Process True The value can
MaxSize Monitor to back up the be changed in
transdata.txt log file when it the topaz_
reaches its defined maximum data_server.
size. cfg file.
transdata LogMaxSize Determines the maximum 5120 kilobytes The value can

transdata.txt log file size (in
kilobytes).

be changed in
the topaz_
data_server.
cfg file.
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Changing the

Section Parameter Description Default Value V
alue
transdata LogBackup Determines the duration (in 168 hours The value can
Duration hours) for which the backups of be changed in
the transdata.txt log file are the topaz_
kept. data_server.
cfg file.
transdata LogNumOf Determines the number of log |5 The value can
Backups history files to keep. be changed in
the topaz_
data_server.
cfg file.
transdata MaxSnapshot Determines the maximum size | 60 kilobytes Do not change
Size of the snapshot HTML file this value.
reported to Business Availability
Center 4.5.2 and earlier.
transdata NumberOfSaved | Determines the number of days |5 The value can
SnapshotDays to keep old snapshot data that is be changed in
stored locally on the Business the topaz_
Process Monitor machine. data_server.
cfg file.
transdata MaxSnapshot Determines the maximum size | 256 Kilobytes The value can
SizeAMS of the snapshot HTML file be changed in

reported to Business Availability
Center 5.0 and later.

the topaz_
data_server.
cfg file.
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Changing the

Section Parameter Description Default Value vV
alue
wtdata LogLevel Instructs Business Process Flow The value can
Monitor to log only entries of be changed in
the specified level or higher in the topaz_
the <Business Process Monitor data_server.
Workspace directory>\ agent1\ cfg file.
data\ clients\wtdata.txt file.
The following levels exist:
> fatal
» error
> warning
> flow
» debug
If this parameter is set to debug,
all entries are logged; if the
parameter is set to flow, all
entries aside from debug are
logged; if the parameter is set to
warning, both the flow and
debug entries are not logged,
and so forth.
wtdata LogBackupOn Instructs Business Process True The value can
Open Monitor to back up the existing be changed in
wtdata.txt log file when the topaz_
opening a new log file. data_server.
cfg file.
wtdata LogBackupOn Instructs Business Process True The value can
MaxSize Monitor to back up the be changed in
wtdata.txt log file when it the topaz_
reaches its defined maximum data_server.
size. cfg file.
wtdata LogMaxSize Determines the maximum 5120 kilobytes The value can

wtdata.txt log file size (in
kilobytes).

be changed in
the topaz_
data_server.
cfg file.
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Changing the

Section Parameter Description Default Value V
alue
wtdata LogBackup Determines the duration (in 168 hours The value can
Duration hours) for which the backups of be changed in
the wtdata.txt log file are kept. the topaz_
data_server.
cfg file.
wtdata LogNumOf Determines the number of log |5 The value can
Backups history files to keep. be changed in
the topaz_
data_server.
cfg file.

PCBD Policy Determines the page Runnum The value can
component breakdown Note: The be changed in
reporting policy. The following | 4ofault policy the topaz_
two options are available: value for data_server.
» Runnum - Data is HP Software-as-a- cfg file.

automatically reported after |Service is
the specified number of runs. | Threshold.

» Threshold - Data is only
reported if during the
transaction run, the
threshold status changes to
the Poor (red) status
(because the previous run
was less than the higher
threshold, and the current
run is over that threshold)

and not when it changes from

red status.

The transaction thresholds
are defined as part of the
business process profile
properties within End User
Management
Administration.
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Changing the

Section Parameter Description Default Value vV
alue
PCBD Runnum Determines the number of runs |4 runs The value can
after which Business Process be changed in
Monitor reports page the topaz_
component breakdown data data_server.
(applicable when the value of cfg file.
the Policy parameter is
Runnum).
soahttp WakeupMinutes | Determines the amount of time, | 1 minute Do not change
Time in minutes, after which all the this value
SOA transaction samples in the without
queue are reported. After this consulting HP
amount of time has elapsed, the Software
SOA transaction samples in the Support.
queue are reported, regardless of
the number of samples in
queue.
soahttp WakeupCount Determines the number of SOA |40 samples Do not change
transaction samples that must this value
be collected before all the SOA without
transaction samples in the consulting HP
queue are reported. After this Software
number of SOA transaction Support.
samples are collected, all the
SOA transaction samples in the
queue are reported, regardless of
the amount of time that has
elapsed since the last report.
soahttp MaxChunk Determines the maximum 100 samples Do not change
number of SOA transaction this value
samples that can be sent in one without
http request. consulting HP
Software
Support.
soahttp Priority This parameter is not currently

implemented.
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Changing the

Section Parameter Description Default Value V
alue
txhttp WakeupMinutes | Determines the amount of time, |1 minute Do not change
Time in minutes, after which all the this value
transaction samples in the without
queue are reported. After this consulting HP
amount of time has elapsed, the Software
transaction samples in the Support.
queue are reported, regardless of
the number of samples in
queue.
txhttp WakeupCount | Determines the number of 40 samples Do not change
transaction samples that must this value
be collected before all the without
transaction samples in the consulting HP
queue are reported. After this Software
number of transaction samples Support.
are collected, all the transaction
samples in the queue are
reported, regardless of the
amount of time that has elapsed
since the last report.
txhttp MaxChunk Determines the maximum 100 samples Do not change
number of transaction samples this value
that can be sent in one http without
request. consulting HP
Software
Support.
txhttp Priority This parameter is not currently
implemented.
wthttp WakeupMinutes | Determines the amount of time, | 1 minute Do not change
Time in minutes, after which all the this value
WebTrace samples in the queue without
are reported. After this amount consulting HP
of time has elapsed, the Software
WebTrace samples in the queue Support.

are reported, regardless of the
number of samples in queue.
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Changing the

Section Parameter Description Default Value vV
alue
wthttp WakeupCount | Determines the number of 1 sample Do not change
WebTrace samples that must be this value
collected before all the without
WebTrace samples in the queue consulting HP
are reported. After this number Software
of WebTrace samples are Support.
collected, all the transaction
samples in the queue are
reported, regardless of the
amount of time that has elapsed
since the last report.
wthttp MaxChunk Determines the maximum 1sample Do not change
number of WebTrace samples this value
that can be sent in one http without
request. consulting HP
Software
Support.
wthttp Priority This parameter is not currently
implemented.
HTTPSender |HTTPSender The timeout, in seconds, for 300 seconds Do not change
TimeoutSec sending Business Process this value
Monitor samples to HP Business without
Service Management. consulting HP
Software
Support.
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Parameters in sconn.cfg

The <Business Process Monitor application directory>\config\sconn.cfg file,
which controls the configuration options pertaining to the communication
between Business Process Monitor and the Gateway Server, contains the
following parameters:

Changing the

Section Parameter Description Default Value
Value
Site# AuthUser Determines the user name to be |"" (not defined) |The value can
used for basic authentication, if be changed in
required by HP Business Service Business
Management. Process
Monitor
Admin.
Site# AuthDelay If you defined authentication |0 Do not change
parameters for Business Process this value
Monitor, this parameter without
determines whether consulting HP
authentication is set only after Software
http code 401 is returned, or Support.
from the first request to the
Web server.
The following options are
available:
» 0 (default behavior) — Set
authentication parameters
from the first request.
» 1 - Set authentication
parameters only after http
code 401 is returned.
Site# AuthDomain Determines the domain name |"" (not defined) |The value can

to be used for basic
authentication, if required by
HP Business Service
Management.

be changed in
Business
Process
Monitor
Admin.
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Changing the

header which should be added
or changed, in order to add or
override headers to the http
request sent by Business Process
Monitor to HP Business Service
Management. For more
information, see "Adding or
Overriding HTTP Request
Headers" on page 253.

If this parameter is empty (or
does not exist), it is ignored and
no addition or change is made
to the header.

Section Parameter Description Default Value V
alue

Site# AuthPasswd Determines the encrypted "" (not defined) |The value can
password to be used for basic be changed in
authentication, if required by Business
HP Business Service Process
Management. Monitor

Admin.
Site# HandleBinary Determines whether to change |0 (do not Do not change
ContentType the content type in the http change) this value
header of requests sent by the without
Business Process Monitor, when consulting HP
the post buffer is binary. The Software
content type in such a case is Support.
application/octet-stream (and
not application/x-www-form-
urlencoded).
The following two options are
available:
» 0 - do not change content
type

» 1 - change content type

Site# HeaderName Determines the name of the "" (not defined) |The value can

be added/
changed in the
sconn.cfg file.
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Changing the

Section Parameter Description Default Value V

alue

Site# HeaderValue Determines the value of the "" (not defined) |The value can
header (as defined by parameter be added/
HeaderName, above) which changed in the
should be added or changed. sconn.cfg file.

Site# ProxyName Determines the user name to be |"" (not defined) |The value can
used to connect to the proxy be changed in
server, if you are connecting to Business
HP Business Service Process
Management using a proxy Monitor
server. Admin.

Site# ProxyDomain Determines the domain name |"" (not defined) |The value can
to be used to connect to the be changed in
proxy server, if you are Business
connecting to HP Business Process
Service Management using a Monitor
proxy server. Admin.

Site# ProxyPasswd Determines the encrypted user |"" (not defined) |The value can
password to be used to connect be changed in
to the proxy server, if you are Business
connecting to HP Business Process
Service Management using a Monitor
proxy server. Admin.

Site# ProxyUrl Determines the proxy server "" (not defined) |The value can

URL to be used if you are
connecting to HP Business
Service Management using a
PIOXY Server.

be changed in
Business
Process
Monitor
Admin.
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Section

Parameter

Description

Default Value

Changing the
Value

Site#

ResetConnection
OnFailure

Reset the caching data saved for
the Business Process Monitor
connection to HP Business
Service Management in case of a
communication failure.

Determines whether to re-open
a new communication session
to HP Business Service
Management in case of an http,
TCP or SSL connectivity failure.
This enables communication
caching data (such as SSL or
DNS cached data) to be saved.

The following options are
available:

» 0 - Do not open a new
communication session
when there is a connectivity
failure.

» 1 (default behavior) - Open a
new communication session
when there is a connectivity
failure.

» No value — The default
option is used and a new
communication session is
opened when there is a
connectivity failure.

The value can
be added/

changed in the
sconn.cfg file.

Site#

SSLClientCert

Determines the SSL client
certificate file to be used if SSL
client authentication is required
by HP Business Service
Management. Note that this file
must be in PEM format.

"" (not defined)

The value can
be changed in
Business
Process
Monitor
Admin.
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Changing the

Section Parameter Description Default Value V

alue

Site# SSLServerCert Determines the SSL authority "" (not defined) |The value can
certificate file to be used if the be changed in
SSL protocol is required for Business
Business Process Monitor to Process
communicate with HP Business Monitor
Service Management. Note that Admin.
this file must be in PEM format.

Site# SSLPVK Determines the SSL private key |"" (not defined) |The value can
file used as the pair key of the be changed in
public key in the SSL client Business
certificate file. This file is Process
required if SSL client Monitor
authentication is required by Admin.

HP Business Service
Management. Note that this file
must be in PEM format.

Site# SSLPVKPasswd | Determines the encrypted SSL | "' (not defined) |The value can
private key password to be used be changed in
if SSL client authentication is Business
required by HP Business Service Process
Management. Monitor

Admin.
Site# SSLServer If you defined an SSL authority |1 (validate) Do not change
Validate certificate file, this parameter this value
determines whether to validate without
the certificate received in the consulting HP
SSL handshake. By default, the Software
certificate is validated. If you do Support.

not want the certificate to be
validated, set this parameter to
2.
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Changing the

authentication parameters are
defined for proxy and this
parameter is set to 1, NTLM
authentication is used. If this
parameter is missing, or set to
any value other than 1, basic
authentication is used.

Section Parameter Description Default Value V
alue
Site# SSLHostName This parameter determines how |1 (full validation) | Do not change
Validate the host name in the server this value
certificate is validated. The without
following options are available: consulting HP
» 1 - Full validation. Software
» 2 - Validates the existence of Support.
the host name only.
» 3 - Skips host name
validation.

Site# UseNTLMAuth |Determines whether to use 0 The value can
NTLM authentication when be added/
communicating with changed in the
HP Business Service sconn.cfg file.
Management. If authentication
parameters are defined and this
parameter is set to 1, NTLM
authentication is used. If this
parameter is missing, or set to
any value other than 1, basic
authentication is used.

Site# UseNTLMProxy |Determines whether to use 0 The value can

Auth NTLM authentication when be added/
communicating with proxy. If changed in the

sconn.cfg file.
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Note: To force the Business Process Monitor to use NTLM authentication for
communication with HP Business Service Management or via a proxy server,
you must make sure that under each Site# section (where NTLM
authentication is required) one or both of the UseNTLMAuth and
UseNTLMProxyAuth parameters are set to 1, as required.

Adding or Overriding HTTP Request Headers

To add or override headers to the http request sent by Business Process
Monitor to HP Business Service Management, you define the parameters
HeaderName and HeaderValue in the sconn.cfg file, as described in the
above table.

Note the following guidelines:

» To add/change more than one header, use HeaderName2 for the second
name, HeaderName3 for the third, and so forth. Follow the same principle
for the HeaderValue parameter.

» The number of header names must match the number of header values.
Otherwise all header names and values are ignored.

» The first header should be configured with the original parameter names
(no index). Business Process Monitor only reads additional headers if they
are sequentially numbered. For example, if the following information is
added to the sconn.cfg file, only the first two headers are handled.
HeaderName4 and HeaderValue4 are ignored:

[Site1]

AuthDomain=
ProxyPasswd=
ProxyName=""
SSLClientCert=""
SSLHostNameValidate="1"
AuthDelay="0"

ProxyUrl=""
SSLServerCert=""
SSLPVK=""
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ProxyDomain=
SSLServerValidate="1"

SSLPVKPasswd=""

HeaderValue="Mozilla/4.0 (compatible; MSIE 5.5; Windows NT 5.0)"
HeaderName="User-Agent"

HeaderName2="Content-Type"
HeaderValue2="application/x-www-form-urlencoded;charset=UTF-8"
HeaderName4="Content-length"

HeaderValue4="100"
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Advanced Configuration Options

This chapter includes:

» Moving the Workspace Logs on page 256

» Changing the Default Port on page 257

» Optimizing Run Unit Scheduling on page 259

» Viewing the Catalina DOS Window on page 260

» Enabling User Authentication on page 261

» Running Tomcat as a Specific User on page 262

» Changing the Maximum Number of Hops for WebTrace on page 264
» Changing the Communication Protocol Used by WebTrace on page 264
» Disabling the Close Application Mechanism on page 265

» Configuring Snapshot on Error on page 266

» Adjusting Business Process Monitor Time to Daylight Savings Time
on page 269

» Registering a Specific IP Address for a Business Process Monitor Host
Machine on page 271

» Communication Using SSL on page 271
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Moving the Workspace Logs

256

If required, you can change the path for the Workspace directory in the
topaz_agent_ctrl.cfg file, to store the log files in a new location. However,
this only moves some of the log files under the Workspace directory (logs in
commcenter and agent1 directories), not all.

If you want to change the location of all logs under the Workspace directory,
use the following procedure. All file paths are under the <Business Process
Monitor root directory>. Edit all files in a text editor.

To move all Workspace logs:

1
2

Stop Business Process Monitor.

In the ..<Business Process Monitor application directory>\config\
topaz_agent_ctrl.cfg file, change the path for the Workspace parameter
to the required path.

In the ..<Business Process Monitor root directory>\ServletContainer\
conf\agentview.props file, change the path for the mdrvfile parameter to
the new Workspace path.

In the ..<Business Process Monitor root directory>\launch_service\
dat\nanny\topaz_agent_ctrl.nanny file, find the section that relates to
your platform, and within the section change the path after -out to the
new Workspace path.

In the ..<Business Process Monitor root directory>\launch_service\dat\
nanny\webtrace.nanny file, find the section that relates to your platform,
and within the section change the path after -out to the new Workspace
path.

In the ..<Business Process Monitor root directory>\launch_service\dat\
nanny.ini file, change the path for the log_output_dir parameter to the
new Workspace path.

In the ..<Business Process Monitor root
directory>\servletcontainer\bin\catalina.bat file, search for -
Dbpm.workspace, and change the path for the parameter to the new
Workspace path.

Restart Business Process Monitor.
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Changing the Default Port

By default, Business Process Monitor Admin uses port 2696 on the host
machine. If required, you can change the port. Use the new port value in the
URL when accessing Business Process Monitor Admin from a browser
window.

To change the default port:

1

Stop Business Process Monitor and make sure that all processes are
stopped.

Open <Business Process Monitor root
directory>\ServletContainer\conf\server.xml in a text editor.

Look for the XML element Connector with an attribute scheme set to http
or https. Change the attribute port to the required port value, and save
the file.

(For Windows platforms only) Select Start > Programs > HP Business
Process Monitor, then right-click the Business Process Monitor Admin
link. Select Properties from the displayed menu to open the Business
Process Monitor Admin Properties dialog box.

If the Business Process Monitor Admin Properties dialog box contains a
Web Document tab, open the tab and change the port in the URL box to
the new port value, then click Apply. Skip to step 13 on page 258.

If the Business Process Monitor Admin Properties dialog box does not
contain a Web Document tab, continue with the next step.

Open the General tab and find the Location field. Open a Windows
Explorer window and browse to the path that appears in the Location
field (for example, C:\Documents and Settings\All Users\Start
Menu\Programs\HP Business Process Monitor).

Delete the Business Process Monitor Admin shortcut from the folder.

8 Select File > New > Shortcut. The first page of the Create Shortcut Wizard

is displayed.
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258

9

10

1
12

13

In the Type the location of the item box, enter the Business Process
Monitor Admin URL using the new port number: http://localhost:<new port
value>/

Click Next.

In the Type a name for this shortcut box, enter Business Process Monitor
Admin.

Click Finish.
Check that a new Internet shortcut has been created in the folder.

Select Start > Programs > HP Business Process Monitor, right-click the
Business Process Monitor Admin link, and select Properties. In the
displayed Business Process Monitor Admin Properties dialog box, access
the Web Document tab and check that the new port value is now
displayed in the URL box.

Restart Business Process Monitor.
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Optimizing Run Unit Scheduling

Business Process Monitor uses an algorithm to calculate the start offset for
Business Process Monitor run unit (applications or business transaction
tlows overriding the parent schedule) scheduling, as described in "Start
Offset" on page 204. The distribution period for the algorithm is defined by
the parameter OffsetDistPeriodSec in the <Business Process Monitor
application directory>\config\agent1.cfg file. The default value for this
parameter is one hour (3600 seconds), which is an optimum value when the
majority of your run unit schedules use the default schedule option of every
15 minutes, or a multiple of 15, for example, 30 minutes or 7.5 minutes.

If you are commonly using other schedule intervals for your run units
(meaning that the majority of your run unit schedule intervals are not
multiples of 15 minutes), you can change the default distribution period to
fine tune the offset balancing, enabling unit runs to be more evenly
dispersed. The value you use for OffsetDistPeriodSec is calculated using the
formula common_unit_interval * (2¥), where the common unit interval
represents the schedule interval most commonly used for your run units (o,
if there is no predominant schedule interval, the highest schedule interval).

For example, if the majority of your run units are set to run every 20
minutes (schedule interval 20), then the parameter OffsetDistPeriodSec
should be set to one of the following:

20 * 20 = 20 minutes = 1200 seconds
20 * 21 = 40 minutes = 2400 seconds
20 * 22 = 80 minutes = 4800 seconds

and so forth.

It is recommended that the distribution period value be equal or greater to
the highest schedule interval used in your run units. For example, if the
majority of your run units have a schedule interval of 20 minutes, but one
has a schedule of 45 minutes, then you could set the distribution period to
80 minutes. The minimum value for the period is 4 seconds, the maximum
is 24 hours.

If you need assistance in determining the distribution period value that
gives you maximum efficiency, contact HP Software Support.
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Note: If you do not configure the distribution period to fit the schedule
intervals used in your run units, Business Process Monitor uses the default
value to schedule start offset values for the run units. In most cases, this
value is adequate; however, there may be cases where the scheduling process
is not optimum (run units do not run with equal distribution in the period).

Viewing the Catalina DOS Window
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By default, the Catalina DOS window is hidden when running Business
Process Monitor. You can use the following procedure to keep it visible.

To view the Catalina DOS window:

1 Open the <Business Process Monitor root
directory>\launch_service\dat\nanny\catalina.nanny file in a text editor.

2 Change the line:
show_window= 0
to
show_window=1

3 Save the file.

4 Restart Business Process Monitor.



Chapter 14 ¢ Advanced Configuration Options

Enabling User Authentication

The following procedure enables you to define the Web users permitted to
access the Business Process Monitor Admin tool using basic authentication.

Note: If you configure basic authentication for the Business Process Monitor
Admin console, you are unable to use the following utilities in the End User
Management application in Business Service Management:

» BPM Page Component Breakdown on Demand

» BPM WebTrace on Demand

» BPM Transaction Invocation

To define users for basic authentication:

1

Stop Business Process Monitor and make sure that all processes are
stopped.

Open the <Business Process Monitor root directory>\ServletContainer\
conf\web.xml in a text editor.

Uncomment the section called Security Constraint and Login
Configuration and save the file.

Open the <Business Process Monitor root directory>\ServletContainer\
conf\tomcat-users.xml in a text editor and add the list of allowed users
for Business Process Monitor. All users must be assigned
roles="bpm_admin".

For example, the line:
<user username="user1" password="abc" roles="bpm_admin" />

adds a user called "user1" with a password of "abc" to the users who are
allowed to access Business Process Monitor Admin.

5 Save the file.

6 Restart Business Process Monitor.

261



Chapter 14 ¢ Advanced Configuration Options

Running Tomcat as a Specific User

262

Business Process Monitor Admin uses Tomcat (Catalina) as its Web server. In
general Tomcat is not considered a secure Web server. To improve security, it
is recommended not to run Tomcat:

> as a system user

» on a Windows platform, as a user with administrator permissions

By default, Tomcat runs under the same user to which Business Process
Monitor is configured—the system user (default setting).

To configure Tomcat to run as a specific user, follow the instructions in the
appropriate section:

Configuring Tomcat to Run as a Specific User on a
Windows Platform

On a Windows platform, you can configure Tomcat to run as a specific user
using one of the methods described:

» Run the Business Process Monitor service as a specific user (currently,
Tomcat and the Business Process Monitor processes run under the same
Business Process Monitor Service). This solution is not recommended,
unless specifically advised by HP Software Support.

You configure the Business Process Monitor service as a specific user from
the Log On tab in the HP Business Process Monitor Properties dialog box
(Control Panel > Administrative Tools > Services, then right-click Business
Process Monitor and select Properties).

This solution is suitable only for running all instances under the same
user and is not suitable for any configuration that includes a WebTrace.
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Note: Starting Business Process Monitor from the Start menu recreates the
Business Process Monitor Service as a system user. As such, after
configuring the service to run as a specific user using the method
described above, make sure to start the service itself—do not use the Start
menu. (To start the service, select Start > Settings > Control Panel >
Administrative Tools > Services, and then select Start from the HP
Business Process Monitor right-click menu.)

Configure the user to run Tomcat alone. This involves disabling nanny
monitoring of Tomcat and then running Tomcat from a command line.

Note: Tomcat will not be monitored by Business Process Monitor nanny
so it will shut down each time the user logs oft.

To configure the user to run Tomcat alone:

1 Stop Business Process Monitor.

2 Open the file <Business Process Monitor root

directory>\launch_service\dat\nanny\catalina.nanny in a text editor.

3 Change enable="1" to enable="0".

4 Save the file and restart Business Process Monitor.

5 In a Command Prompt window, move to <Business Process Monitor root

directory>\ServletContainer\bin and execute catalina run.
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Changing the Maximum Number of Hops for WebTrace

Business Process Monitor is set to access a maximum of 30 hops when using
WebTrace to reach a site. If 30 hops are not enough to reach the site, it is
reported as unreachable.

If required, you can increase or decrease the maximum number of hops by
editing the default value in the webtrace.ini file.

To modify the maximum number of hops value:

1 On the Business Process Monitor machine, open the <Business Process
Monitor root directory>\dat\webtrace.ini file in a text editor.

Note: For Windows Vista, Windows 2008, and Windows 7, you must copy
the file to the user temp directory (%temp%), edit it there, and then copy
it back to the original directory.

2 Look for:

[Request]
DefaultMaxTTL=30

3 Change the value for DefaultMaxTTL to the required number of hops.
4 Save your changes.

5 Restart Business Process Monitor for the change to take effect.

Changing the Communication Protocol Used by WebTrace
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By default, Business Process Monitor is set to use TCP when running
WebTrace. If required, you can change the default communication protocol
by editing the default value in the webtrace.ini file.

To modify the default communication protocol value:

1 On the Business Process Monitor machine, open the <Business Process
Monitor root directory>\dat\webtrace.ini file in a text editor.
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Note: For Windows Vista, Windows 2008, and Windows 7, you must copy
the file to the user temp directory (%temp%), edit it there, and then copy
it back to the original directory.

2 Look for:

[Request]
DefaultProtocol=<current protocol setting>

3 Change the value for DefaultProtocol to the required protocol.
4 Save your changes.

5 Restart Business Process Monitor for the change to take effect.

Disabling the Close Application Mechanism

The mechanism to automatically close the application being tested when
running QuickTest Professional scripts (described in "QuickTest Professional
Scripts" on page 82) is enabled by default for scripts run on Business Process
Monitor.

If required, you can disable the mechanism for a specific script.

To disable the mechanism:

1 Browse to the <QuickTest Professional>\Tests\<script name> folder and
open the default.cfg file in a text editor.

2 In the General section, add the following:

DisableEndProcessesOnFail=1

Note: To re-enable the mechanism, delete the statement.
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3 Save the file. The mechanism no longer closes an application being tested
if the QuickTest Professional script fails before it runs the last step (which
closes the application).

Configuring Snapshot on Error
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When recording scripts with HP Virtual User Generator or QuickTest
Professional (QTP), you can enable the Snapshot on Error option.

For details on enabling Snapshot on Error in HP Virtual User Generator, see
the HP HP Virtual User Generator documentation. For details on enabling
Snapshot on Error in QuickTest Professional see the HP QuickTest Professional
User Guide.

Once enabled, during a script run HP Business Service Management saves a
snapshot of a page as it appears when an error occurs during the script run.
The snapshots can be viewed in the Error Summary Report and in the Triage
Raw Data report. For details, see Using End User Management.

The list of HP Virtual User Generator protocols for which HP Business
Service Management supports Snapshot on Error is configured in the
SnapshotSupportedProtocols parameter in the agent1.cfg file. For details,
see "Parameters in agentl.cfg" on page 226.

Note: When HP Business Service Management records a snapshot for scripts
recorded using one of the Web protocols, it saves only HTML code.
Resources such as images and JavaScript are not saved. Thus, errors that
occur due to missing resources may be difficult to trace later on from the
snapshot, especially in cases where the missing resource problem has been
fixed. For example, if an image resource is missing during a script run,
causing an error to be recorded, but the missing image problem is later fixed,
the image is present when you open the snapshot of the page.

For details on how snapshots are stored, see "Storing Snapshots" on
page 267.
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Storing Snapshots

You can configure Business Process Monitor to send snapshots to

HP Business Service Management or to store them locally on the Business
Process Monitor machine, and you can also configure how long to keep the
locally saved snapshots.

Snapshots that are stored locally on the Business Process Monitor machine
are stored under the <Business Process Monitor Workspace directory>\
agent1\data\clients\saved_snapshots directory. A subdirectory is created
for each day on which snapshots are taken, in the format of day_month (for
example, for snapshots taken on April 20 a subdirectory called 20_4 is
created). A further subdirectory is created for each snapshot in the format of
run unit name_transaction name_hour.minute. For example, for a snapshot
generated at 11:25 PM in transaction trans1 in run unit unit1, the
subdirectory unit1_trans1_23.25 is created. The actual snapshot is stored in
the directory as a zip file called snapshot.zip. For the example above, the full
pathname and file is:

<Business Process Monitor workspace directory>\agent1\data\clients\
saved_snapshots\20_4\unit1_trans1_23.25\snapshot.zip

Note: If more than one snapshot file is generated for the same transaction in
the same run unit within a single minute, the additional snapshot files are
sequentially numbered in the format of snapshot.number.zip - for example,
snapshot.2.zip.

To configure where snapshots are stored:

1 Edit the SendSOEToBAC parameter in the [general] section of the
<Business Process Monitor application directory>\config\agent1.cfg file.
The possible values for the parameter are:

» 1=Never send Snapshot on Error data to HP Business Service
Management.

> 2=Always send Snapshot on Error data to HP Business Service
Management.
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» 3=Use the script configuration to determine where to send Snapshot
on Error data (see point 2 on page 268 below). This is the default
option that is used if the SendSOEToBAC parameter has not been set.

2 If the Business Process Monitor has been configured to use the script
configuration to determine where to send Snapshot on Error data (that is,
the SendSOEToBAC parameter has a value of 3), then once a script has
been saved, edit the SendSnapshotDataToBAC parameter in the [WEB]
section of the default.cfg file of the script. The possible values for the
parameter are:

» 0=Do not send Snapshot on Error data to HP Business Service
Management (that is, store it locally on the Business Process Monitor
machine).

» 1=Send Snapshot on Error data to HP Business Service Management.
To configure how long to keep locally stored snapshots:

Edit the NumberOfSavedSnapshotDays parameter in the [transdata] section
of the <Business Process Monitor application directory>\config\
topaz_data_server.cfg file and enter the number of required days to keep
old snapshot data. The default setting is 5.

Since snapshot data may not be generated every day, the setting in this
parameter actually refers to the number of old snapshot directories to keep
(that is, the subdirectories whose name comprises the day and month they
were created).
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Adjusting Business Process Monitor Time to Daylight
Savings Time

You can configure Business Process Monitor to take into account Daylight
Savings Time (DST) in its own time zone. When so configured, Business
Process Monitor uses DST when calculating the start and stop times for
applications and business transaction flows that are configured with GMT
offset schedules.

To configure Business Process Monitor to take DST into account:

Edit the AdjustScheduleToDST parameter in the [general] section of the
<Business Process Monitor application directory>\config\agent1.cfg file.
The possible values for the parameter are:

» 1. True - take DST into account.

» 0. False - do not take DST into account.

The following table shows the various options for an application with an
offset from GMT of +2 hours, with a running time of 08:00 - 16:00, and
running on a Business Process Monitor with a time zone offset from GMT of
-2 hours:

DST in Effect in

Process Monitor
bias is 4 hours,
but since DST is
in effect it is
one hour ahead,
so the real bias
is 3 hours (4-1).

R . Business
LICLTRULES GOJIBEECLTE Process Monitor | Start Time of
Process ToDST Flag .
I . Bias From Run
Monitor’s Time Setting .
Application

Zone

No 1 4 hours 04:00 Business
Process Monitor
local time

Yes 1 The Business 05:00 Business

Process Monitor
local time
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DST in Effect in

. . Business
the Business AdjustSchedule Process Monitor | Start Time of
Process ToDST Flag "
I . Bias From Run
Monitor’s Time Setting s ..
Application

Zone

No 0 4 hours 04:00 Business
Process Monitor
local time

Yes 0 The Business 04:00 Business

Process Monitor
bias is 4 hours
and although
the Business
Process Monitor
time zone is in
daylight savings
time, since the
AdjustSchedule
TODST flag is set
to 0, DST is
ignored and the
bias stays at 4
hours.

Process Monitor
local time

Note: The AdjustScheduleToDST configuration is only relevant for

applications and business transaction flows which are schedule to run

according to offset from GMT. If the scheduling is done according to

Business Process Monitor local time, the Business Process Monitor starts
running the application or business transaction flow at the hour configured

in the schedule, regardless of DST or GMT bias.
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Registering a Specific IP Address for a Business Process
Monitor Host Machine

Business Service Management communicates with Business Process Monitor
according to the IP address of the Business Process Monitor host machine
that is registered in Business Service Management. If you have multiple
network cards on your Business Process Monitor host machine, you may
want to specify a specific one to be used by Business Service Management
when communicating with Business Process Monitor.

To register a specific IP address for a Business Process Monitor host
machine:

1 Edit the <Business Process Monitor application
directory>\config\topaz_agent_ctrl.cfg file on the Business Process
Monitor host machine.

2 Locate the relevant SiteX section in the file (you can search for it using
the SiteURL key).

3 In the located SiteX section, add a new key called HostIPForRegistration
with the IP address you want to use. For example:

HostIPForRegistration="16.16.16.16"
4 Save the file.

5 Restart Business Process Monitor.

Communication Using SSL

You can configure Business Process Monitor to support https
communication with the Gateway Server over the SSL channel and can also
configure SSL support for Business Process Monitor Admin. For details on
configuring https communication with the Gateway Server, see the

HP Business Service Management Hardening Guide PDF.
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Configuring SSL Support for Business Process Monitor
Admin

When you connect to Business Process Monitor Admin from a remote
machine using a browser, information is sent using http. This means that
the data that you configure in Business Process Monitor Admin, including
passwords (for example, when adding/configuring a Business Process
Monitor instance), is sent "as is", in plain text. The passwords are encrypted
only after arriving at the Business Process Monitor Admin machine.

If you want this data to be sent encrypted, it is possible to configure
Business Process Monitor Admin to work with SSL. This enables all
communication between the remote browser and Business Process Monitor
Admin to be encrypted. The following procedure describes how to set
Business Process Monitor Admin to run using SSL configuration.

Note: If you configure your Business Process Monitor Web server (Tomcat
Web server) to support SSL communication, make sure you issue the
certificate to the Business Process Monitor IP number (and not to the DNS
name). This enables SSL communication with HP Business Service
Management for Web services support, for example, for page component
breakdown.

To configure Business Process Monitor Admin to run using SSL:

1 Stop the Business Process Monitor and make sure that all processes are
stopped.

2 Open the <Business Process Monitor root directory>\ServletContainer\
conf\server.xml file in a text editor.

3 Locate the XML Connector element that is not commented out and
comment it out. For example, change:

<Connector port="2696" maxHttpHeaderSize="8192" maxThreads="150"
minSpareThreads="25" maxSpareThreads="75" enableLookups="false"
redirectPort="8443" acceptCount="100" connectionTimeout="20000"
disableUploadTimeout="true" />

to:
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<!l-- <Connector port="2696" maxHttpHeaderSize="8192" maxThreads="150"
minSpareThreads="25" maxSpareThreads="75" enableLookups="false"
redirectPort="8443" acceptCount="100" connectionTimeout="20000"
disableUploadTimeout="true" /> -->

Locate the XML Connector element with an attribute scheme set to https
and uncomment it. For example, change:

<!l--<Connector port="8443" maxHttpHeaderSize="8192" maxThreads="150"
minSpareThreads="25" maxSpareThreads="75" enableLookups="false"
disableUploadTimeout="true" acceptCount="100" scheme="https"
secure="true" clientAuth="false" ssIProtocol="TLS" />-->

to:

<Connector port="8443" maxHttpHeaderSize="8192" maxThreads="150"
minSpareThreads="25" maxSpareThreads="75" enableLookups="false"
disableUploadTimeout="true" acceptCount="100" scheme="https"
secure="true" clientAuth="false" ssIProtocol="TLS" />

Save the <Business Process Monitor root directory>\ServletContainer\
conf\server.xml file.

Create a keystore certificate by running the following command:

<Business Process Monitor root directory>\JRE\bin\keytool -genkey -alias
tomcat -keyalg RSA

When prompted for the keystore password, enter changeit (all lower case).
To choose a different password, see the Tomcat documentation
(http://jakarta.apache.org/tomcat/tomcat-4.0-doc/ssl-howto.html).

Enter general information about the certificate when prompted for this
information.

When prompted for the key password for the certificate, use the same
password you used previously for the keystore.

Execute the following command:
keytool -list
and enter the password: changeit

The following is an example of the message that appears after when the
command is completed:
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11

12

13

Keystore type: jks

Keystore provider: SUN

Your keystore contains 1 entry
tomcat, 27.11.2009, keyEntry,

Certificate fingerprint (MD5):
1C:6E:99:0C:69:B4:B0:F5:92:62:9B:55:87:B1:F8:14

For Windows only, ensure that the .keystore file was added to:

» Windows Vista, Windows 2008, and
Windows 7—-C:\Users\Administrator\

» Windows 2003 and Windows XP-C:\Documents and
Settings\ Administrator\

For Windows Vista, Windows 2008, and Windows 7, copy the .keystore
file to C:\Windows\ System32\ config\systemprofile\ so that the
.keystore file is located in both the administrator and system profile
directories.

If you are working on a Windows platform:

a Select Start > Programs > HP Business Process Monitor, then
right-click the Business Process Monitor Admin link. Select Properties
from the displayed menu to open the Business Process Monitor Admin
Properties dialog box. In the General tab, note the path specified in
the Location field.

In a new window:
Browse to the folder path noted in the previous step.

Delete the Business Process Monitor Admin shortcut.

Yy v v T

Right-click the content area to open a menu and select New >
Shortcut. The Create Shortcut dialog window opens.

> In Type the location of the item: box, enter https://localhost:8443/.

> In Type a name for this shortcut: box, enter Business Process
Monitor Admin.
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» Click Finish. The Create Shortcut dialog window closes and the new
shortcut to Business Process Monitor Admin is listed in the
directory.

¢ Start Business Process Monitor.

d Access the Business Process Monitor Admin console using the new
shortcut you created.

Troubleshooting

If it is still impossible to access the Business Process Monitor Admin console
via SSL, check the latest catalina.<current date>.log file located in:

» Windows 2003 and Windows XP-C:\Documents and Settings\All
Users\Application Data\HP\BPM \Tomcat\logs

» Windows Vista, Windows 2008, and
Windows 7-C:\ProgramData\HP\BPM \ Tomcat\logs

Locate the following string (the directory in the string changes according to
the relevant operating system) and copy the .keystore file to the directory
included in the string:

SEVERE: Error initializing endpoint java.io.FileNotFoundException:
C:\Windows\System32\config\systemprofile\.keystore (The system cannot find
the file specified).
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Workspace Directory and Log Files

This chapter includes:

» About Business Process Monitor Logs on page 278
» Log Archives on page 279

» Log Entry Format on page 279

» Workspace Directory Architecture on page 280

» Agentl Directory on page 282

» Data Directory on page 283

» Sitel Directory on page 284
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About Business Process Monitor Logs

278

The Business Process Monitor processes can be divided into three main
categories:

» Controller
> Agent
» Data server

Each category has one or more log files, all stored under the Workspace
directory. There are different types of log files:

» logs that record flow and logics information for events.

> logs that contain resource-related issues, such as memory,
communication, threads, and so forth (MDRYV logs). These logs only
report errors, so an entry indicates a problem in the process.

Each log file has a default memory limit of 5 MB. A new log file is started
automatically for a log when the log file reaches its memory limit, or when
Business Process Monitor is stopped and restarted.

Note that the default values for each log can be edited in the Business
Process Monitor configuration files. For more information, see Chapter 13,
"Business Process Monitor Configuration Files."
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Log Archives

Most logs have a corresponding archive. Each archive holds the most recent
files for the relevant log (prior to the currently active log file), up to a default
maximum of five log files. When a new log file is started, the previous log
file is added to the archive and, if the archive already contains the
maximum number of files, the oldest file is dropped. The following example
shows the archive file structure for the commcenter_archive directory,
containing two older files for the commcenter.txt log.

H commcenter archive J

copuncerter 2003 5 4 1t

conuncerter 2003 5 4 2t

Log Entry Format
The following are examples of log entries:

01/12/2003 20:57:04 FLOW task 'war_http' (id=52) of application 'AA_Sanity'
(id=27) is running

26/11/2003 16:08:03 ERROR AgentCtrl: "send configuration" could not be
passed to the agent: Failed to post a message to agent 'Agent1’ (error -1).

Each line starts with the date and time, then the level of the message.
Business Process Monitor uses the following log levels for events:

» Fatal
» Error
>» Warning
> Flow

> Debug
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By default, Business Process Monitor is set to log only entries of level Flow
and higher (meaning that Debug events are not included). You can change
the default setting (to show a different level and higher) in the Business
Process Monitor configuration files, as described in "Parameters in
topaz_agent_ctrl.cfg" on page 218.

As one Business Process Monitor can serve more than one Business Process
Monitor instance, some of the messages targeted to a general log (for
example, agent.txt) are also duplicated to the log for a specific instance (for
example, agent_Site#.txt). The instance logs for a component are located in
the same directory as the component general log (the source log). In the
general/source log, each duplicated message ends with [owner: 'Site#']. For
example:

02/12/2003 06:14:01 FLOW running task 'testik' (id=56) of application
'bpm_Sanity' (id=57) with timeout of 900 seconds [owner: 'Site3']

Workspace Directory Architecture
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The Workspace directory contains the following logs and files for Business
Process Monitor:

» agentl. The directory for all the logs and files relevant for the agent
category. For details, see Agent1 Directory.

» bpm_admin_audit.log (and archive). The log for each API call performed
through Business Process Monitor Admin or the Business Process Monitor
SOAP APL. This includes tasks such as adding an instance, removing an
instance, invoking a task, and so forth.

» bpm_admin_out.log (and archive). The log of the Catalina output. (This
file contains the same information printed to the Catalina DOS window,
that is hidden by default. If you prefer to view the output in the window,
see "Viewing the Catalina DOS Window" on page 260.)



Chapter 15 ¢ Workspace Directory and Log Files

» commcenter. The directory for controller logs. The directory contains the
following files (and corresponding archives):

» commcenter.txt (and archive). The commcenter (controller) log,
logging events such as registration, and job and time poll intervals.

» commcenter_sitel.txt (and archive). The commcenter (controller) log
for a specific Business Process Monitor instance. Each instance log
contains all the entries in the commcenter.txt log that are relevant for
the instance.

» manager_task_invoker. The directory for all output files and logs created
for a run of a script, when the script run is invoked using the Invoke Task
option in Business Process Monitor Admin.

» mercwebtrace.log (and archive). A log for the mercwebtrace component
used with WebTrace in Business Process Monitor.

» nanny.log. The log of the nanny component (responsible for launching
the following processes and making sure they are up: tp_bpm_admin,
tp_bpm_ctrl, and mercwebtrace).

> supervisor.txt (and archive). This log contains data regarding the
launch/failure of the following processes: tp_bpm_admin, tp_bpm_ctrl,
and mercwebtrace.

> topaz_agent_ctrl.log (and archive). The MDRV log for the controller
category.

> topaz_agent_manager.log (and archive). The log for the TAM’s jmdrv.
Logs low-level Business Process Monitor Admin events.

» webtrace. The directory for logs relating to the mercwebtrace component,
used to handle WebTrace. The directory contains the following files (with
corresponding archives, as required):

> webtrace.txt. The log of the management level for WebTrace, logging
events such as request handling.

> network.txt. The log of the networking layer in WebTrace.
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Agent1 Directory

282

The agent1 directory contains logs and files that relate to the operation of
the agent category.

Note: Sitel, Site2, and so forth, are internal names for the Business Process
Monitor instances. You can check which internal name is assigned to each
instance in the <Business Process Monitor application directory>\config\

topaz_agent_ctrl.cfg file.

The agent1 directory contains the following files:

> agent_Sitel.txt (and archive). Logs the flow of the agent for a specific
Business Process Monitor instance. Each instance log contains all the
entries in the agent.txt log that are relevant for the instance.

> agent.txt (and archive). Logs the flow of the agent. Logs events such as
processing scripts, running run units (applications or business transaction
flows that override their parent application’s schedule), downloads,
processing errors (for all Business Process Monitor instances).

> agent_task_invoker.txt (and archive). Logs information regarding
invoked tasks (invoked using the Invoke Now option in Business Process
Monitor Admin).

» agent1_drvlog.txt (and archive). The MDRYV log for the whole agent
category.

» agent1_drvlog_launcher.txt (and archive). A log for internal HP use.

» data. This directory contains all logs and files relevant for the data server.
For details, see Data Directory.

» downloads. A temporary directory for downloads of scripts, without
connection to the logs.

» Sitel. Each "SiteX" directory contains information relating to a specific
Business Process Monitor instance. For details, see Sitel Directory.
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» task_invoker. This directory contains files regarding the runs of tasks
invoked using the Invoke Now option in Business Process Monitor
Admin.

» traceroute. A directory for traceroute server logs. The directory contains
the following file (and corresponding archive):

tracert_drvlog.txt (and archive). The MDRYV log for the traceroute
server component.

Data Directory

The data directory contains the following logs and files relating to the
Business Process Monitor data server:

» clients. This directory contains information about the transaction and
WebTrace data that is reported to the HP Business Service Management
site. The information for each finished transaction/WebTrace appears in
the client logs at the moment the data is ready to be sent, while the data
depot log records what data is actually sent.

The directory contains the following files (and corresponding archives):

> saved_snapshots. The directory used to store Snapshot on Error data
that is not sent to HP Business Service Management. For more
information on configuring Snapshot on Error, see "Configuring
Snapshot on Error" on page 266.

> soadata.txt (and archive). The log for finished SOA transaction data,
including details on the SOA performance and event samples. This log
also contains entries for failed SOA calls on which no SOA samples
were sent to HP Business Service Management due to missing data.

» transdata.txt (and archive). The log for finished transaction data. This
log also contains entries for transactions that were not run due to
problematic scripts, but for which special samples were sent to
HP Business Service Management.

> wtdata.txt (and archive). The log for finished WebTrace data.
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» data_depot.txt (and archive). The log for all information relating to

reported data, for all Business Process Monitor instances. For example,
this file logs if data reporting was successful or failed, and the number of
samples (in a queue) that were included in a report.

data_depot_Sitel.txt (and archive). The log of all information relating to
reported data, for a specific Business Process Monitor instance. Each
instance log contains all the entries in the data_depot.txt log that are
relevant for the instance.

» datasrv_drvlog.log. The MDRV log for the whole data server category.

» queues. This directory contains the persistency queues for transaction,

SOA transaction, and WebTrace reports that have not yet been sent to the
HP Business Service Management site, or that have not yet been
acknowledged by HP Business Service Management. (If Business Process
Monitor is stopped, the reports are stored in the persistency queues until
they can be sent.)

snapshots. This is a temporary directory holding the snapshots (when the
Snapshot on Error option is enabled for a script) that are reported by
Business Process Monitor to HP Business Service Management. For more
information on configuring Snapshot on Error, see "Configuring Snapshot
on Error" on page 266.

Site1 Directory
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The Sitel (or Site2, Site3, and so forth) directory contains the following logs
and files regarding the specific instance’s job (when running a script):

> input_job.xml. This is the last received .xml file, describing the last job

with which the instance dealt (the file may contain only the difference
between the last job and the previous one).

> persistency_job.xml (and archive). This .xml file stores persistency

information for all jobs currently assigned to the instance.



Chapter 15 ¢ Workspace Directory and Log Files

» <run unit_id#>. This directory contains information concerning the run
of an application or business transaction flow (run unit), for a specific run
unit that the instance is assigned to run. It contains:

» <script_id#>. This directory contains files relating to a script in the run
unit:

» <script1>. This directory contains files concerning the run of the
script. These files include the script itself, additional files for the
script, and the res directory where the output files for the script’s
run are stored.

» <script>.crc. The .crc file for the script, containing information
needed by Business Process Monitor to run the script, as defined in
the database.

» <WebTrace_id#>. This directory is identified by an ID value between
100-199, and is generally empty.
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Planning Business Process Monitor
Capacity

This chapter includes:
» Script Loads on page 288
» Sizing on page 290

» Business Process Monitor Configuration Tips on page 291
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Script Loads

288

The main factors that influence the load you can assign a Business Process
Monitor are:

» The hardware of the Business Process Monitor machine (in terms of the
processor, memory speed, processor L2 cache memory, and so forth).

» The operating system. Since Business Process Monitor uses services
provided by the operating system, differences between operating systems
may impact Business Process Monitor performance.

» The total number of concurrently running scripts on the Business Process
Monitor machine.

For details on hardware and operating system requirements, see "System
Requirements" on page 22.

Example of a Simple Configuration with No Concurrent
Script Runs

An example of a simple configuration where all the scripts included in the
configuration run sequentially is a Business Process Monitor running a
single application that uses the default application schedule of 15 minutes
and that includes 15 scripts that each take one minute to complete. In this
configuration there will always be a single script running, but no script will
run concurrently with another.

Changes to the configuration or its environment may cause scripts to run
concurrently. For example, if a script run time lasts longer than one minute
due to slow performance.

Automatic Distribution of Concurrent Script Runs

When a Business Process Monitor has more than one application or business
transaction flow configured on it, a special mechanism ensures that the
distribution of concurrent running scripts is kept as low as possible.
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To allow an even distribution of the Business Process Monitor’s use of
resources (such as CPU, memory, and network), the Business Process
Monitor assigns each application or business transaction flow (that has its
own schedule) an offset. By using this offset, Business Process Monitor tries
to reduce the number of concurrent script runs by staggering their start
time. The offset mechanism is applied whenever a new configuration is
assigned to the Business Process Monitor.

Factors Causing Concurrent Script Runs

Some of the main factors that may cause scripts to run concurrently are:

» The work load assigned to the Business Process Monitor. This includes:
» The number of instances configured for the Business Process Monitor.

» The number of applications and business transaction flows (run units)
per instance.

» The number of scripts per run unit.
» The number of transactions per script.
» The scheduled interval configured for run units.
» The average time it takes for a script or run unit to finish a single run.

» The availability and performance of monitored applications. Unavailable
or slow applications result in slower script runs.

» The type of the scripts. Some protocols may take a longer time to finish
than others (for example, if there is a need to work with FAT client that
needs to be initialized).

» The unit run modes (classic, sequential, and so forth). Some modes (such
as the stepped mode with a step value of zero) enable you to run scripts
concurrently. For details on run modes, see "Run Modes" on page 207.
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Note: Changing the default unit run mode overrides the automatic
mechanism that distributes script runs. This reduces the load that can be
assigned to a Business Process Monitor. It is strongly recommend that you
do not change the default offset in high volume environments.

Sizing

Since there are a number of factors that affect the load on a Business Process
Monitor, and therefore the required configuration, there are a large number
of different possible configuration combinations. The following table lists

some of the configurations that have been used:

Entity 1 Instance 2 Instances 16 Instances
Run units per instance | 250 250 30

Scripts per run unit 5 5 S
Transaction per script | 4 4 4
WebTraces per run 2 2 2

unit

Total run units 250 500 480

Total scripts 1,250 2,500 2,400

Total transactions 5,000 10,000 9,600

Total WebTraces 500 1,000 960

Changing any one of the parameters may impact the load you can run on a
Business Process Monitor.

290




Chapter 16 ¢ Planning Business Process Monitor Capacity

Note the following in conjunction with the listed configurations:

» All specifications are related to http Web protocols only. Using scripts
from other protocols may impact the load that a Business Process Monitor
can run.

» The average script run time is 30 seconds.

» Scheduling is set to 15 minutes for all run units (this is the default
schedule).

» All other run unit attributes are assigned default values.

Business Process Monitor Configuration Tips

This section describes tips and recommendations for configuring Business
Process Monitor:

» Business Process Monitor must run on a dedicated machine.
» Use the default run unit mode

» If you do not use one of the tried configuration sizes, use the following
method to check your Business Process Monitor capacity.

To check Business Process Monitor capacity for a new configuration:

1 Load the Business Process Monitor with the new configuration using a
rump up method (cycles). In each cycle, assign only a part of the
configuration and check that the Business Process Monitor’s capacity is
not breached (that is, a very high usage of system resources).

2 Once a Business Process Monitor is assigned a new configuration, it needs
to readjust its scheduling mechanism to the new work load. This
readjustment phase (during which the Business Process Monitor still runs
the existing configuration) may take a few minutes, depending on the
work load of the existing configuration and the amount of new work
required by the new configuration. During the readjustment phase, the
Business Process Monitor’s CPU consumption may increase, but should
return to normal once the readjustment is complete.
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Note: When changing a configuration, there may be a delay in
transaction reports and in some cases, transaction runs may be skipped.
This applies to currently running scripts.

3 Wait until the readjustment phase stabilizes before applying additional
parts of the new configuration.
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